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Introduction –  

MAGic User’s Guide 

About This Book  

The MAGic® User’s Guide teaches you to use and customize MAGic’s 
magnification and speech capabilities to fit your personal needs.  

The following briefly highlights the sections of this book:  

Chapter 1 – Welcome to MAGic introduces MAGic and provides system 
requirements.  

Chapter 2 – MAGic at a Glance provides details about buttons and other 
options available in the MAGic user interface. 

Chapter 3 – Installing and Activating MAGic walks through the steps to install, 
create initial visual and speech, and activate MAGic. 

Chapter 4 – Customizing MAGic serves as a guide for first time users when 
setting their visual and speech preferences.  

Chapter 5 – Magnification and Visual Enhancements describes how to 
customize MAGic’s magnification features, including mouse, cursor, color 
enhancements, and multi-monitor operation.  

Chapter 6 – Speech with MAGic explains how customize and save speech 
settings for full speech and Speech On Demand operation.  

Chapter 7 – Reading with MAGic describes how to use Text Viewer, mouse 
echo, typing echo, and hot keys to read Web pages, documents, and more. 

Chapter 8 – Saving MAGic Settings describes how to save both default and 
application-specific settings  

Chapter 9 – Changing Preferences allows you to manage how MAGic starts, 
receive notification of product updates, and set the state on the NUM LOCK 
key.  

Chapter 10 – Updating MAGic describes how to configure MAGic to 
automatically check for updates.  
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Chapter 11 – Business and Classroom Features describes various items 
available in the Tools ribbon that are useful for searching the Web, or reading 
documents and Web pages. One of the most helpful features is Keyboard 
Manager, which is used to manage and assign MAGic hot keys  

Chapter 12 – MAGic Hot Keys provides a list of hot keys available magnifying, 
reading, speech, and more. 

Chapter 13 – Layered Keystrokes provides a list of keystrokes useful for 
navigating tables.  

Chapter 14 – Navigation Quick Keys describes keystrokes useful for navigating 
Web pages, PDF files, application help files, and so on. 

Chapter 15 – MAGic Large Print Keyboard describes functions assigned to the 
keyboard’s keys.  

Chapter 16 – Mouse and Keyboard Control briefly highlights actions that can be 
performed with both the keyboard and mouse.  

Chapter 17 – Utilities describes several utilities available to quickly access 
license information, configuration files, and visual and speech settings. 

Chapter 17 – Using MAGic with Other Applications and Advanced MAGic 
Features briefly highlights features available for MAGic scripting, network 
installation, remote access. For more information, refer to MAGic’s help file.  

Items Checklist 

The following items are included in your MAGic package. If you discover 
damaged or missing items, please contact your retailer. 

 MAGic® Screen Magnification and JAWS® for Windows® program DVD 
with Vocalizer Expressive speech synthesizer, FSReader (Freedom 
Scientific’s DAISY book reader), and basic training files in DAISY book 
format 

 Authorization CD 

 MAGic User’s Guide  
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Chapter 1 
Welcome to MAGic 

MAGic is a software solution ideally suited for computer users with low vision, 
or anyone who spends extended periods of time in front of a computer screen.  

MAGic lets you magnify your computer screen from 1 to 60 times its usual size. 
You can choose from a number of different adjustable views that let you see 
both a magnified and unmagnified portion of the screen at the same time. 

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic moves 
the magnified area of the screen so you always see the text being read and 
spotlighted as it is spoken.  

If you want to limit the amount of speaking performed by MAGic as you 
navigate windows and documents, use the Speech On Demand™ feature. It 
allows MAGic to only announce actions that are associated with a limited set of 
hot keys. Mouse echo is still available when using Speech On Demand.  

Mouse and cursor enhancements help you track the location of the mouse 
pointer and cursor on the screen. You can choose from a wide variety of 
enhancement styles. MAGic lets you change the color of these enhancements, 
apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. You 
can create rules that replace one color with another or switch two colors. You 
can also apply color tinting; make your screen black-and-white (monochrome), 
and invert the brightness and colors of your display. 

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a way 
to quickly find and move to different areas of the screen. The MAGic multi-
directional panning system gives you complete control with adjustable speed, 
direction, stop and start, and screen navigation controls. 
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System Requirements 

The recommended minimum system requirements for MAGic are listed below.  

MAGic and MAGic with Speech 

 64-bit Version: Windows® 10, Windows 8.1, Windows 7 and Windows 
Server® 2008 Release 2  

 32-bit Version: Windows 10, Windows 8.1, and Windows 7   

Processor speed  
Minimum 1.5 GHz processor  

RAM  

 4 GB recommended (64-bit) 

 2 GB recommended (32-bit) 

Required hard disk space  
1.6 GB required during installation 
20 MB to 690 MB required per voice for installing Vocalizer Expressive, 
Vocalizer Direct, or RealSpeak Solo Direct voices (file sizes will vary depending 
on the voice installed) 

Video  
DirectX 10 or later recommended  

Multi-monitor support  
Computer and video card that supports dual monitors; 32-bit color 
recommended; two computer monitors 

Sound  
Windows compatible sound card (speech option) 

Note: The Remote Access option is included when purchasing MAGic 
with scripting functionality. 
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Chapter 2 
MAGic at a Glance 

Read this topic to learn more about the MAGic user interface, its tabs and 
buttons, and basic navigation. 

MAGic User Interface 

 

(1) Main menu button   (2) Visual tab, Speech tab, and Tools tab    
(3) Title bar   (4) Focus Indicator  (5) Minimize, Close, and Help buttons    
(6) Status bar  (7) Button/Control group, for example, Visual Enhancements 

Split Buttons 

Each tab contains split buttons that allow you to quickly turn on or turn off 
MAGic functionality and quickly select basic settings. This offers the 
convenience of not having to open MAGic menus to achieve the same results. 
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Use the top half of the button to turn on or off specific features.  

 

Use the lower half of the button to select preconfigured schemes, or select the 
Settings option to fine-tune or create a new scheme.  

 

Focus Indicator 

The Focus Indicator consists of four corner brackets that show which item in 
the user interface has focus. When you press TAB or SHIFT+TAB to move 
through the user interface, you will see the Focus Indicator move from one item 
to the next.  
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Keyboard Navigation of the User Interface 

Use the following keystrokes to navigate the MAGic user interface and buttons. 

User Interface Keystrokes 

To perform this action … Press …  

Move from left to right through the 
entire user interface.  
 
(for example, focus moves from the 
Main menu button, to the current 
tab, through all tab items, the Help 
button, and back to the Main menu 
button) 

TAB 

Move from right to left through the 
entire user interface 

SHIFT+TAB 

Move from one tab page to the next.  
 
(for example, from Visual to Speech, 
to Tools, and back to Visual) 

CTRL+TAB (moves right)  or  
SHIFT+CTRL+TAB (moves 
left) 
 
RIGHT ARROW or 
LEFT ARROW (only 
(switches among tab pages 
when focus is on a tab) 
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Buttons and Other Controls 

Description Keystroke 

Switch the current button function on or off. Use 
this keystroke for the top half of a split button. 

SPACEBAR 

Open the list of items available for the current 
button 

ALT+DOWN 
ARROW 

Close the list of items for the current button ESC 

Increase for decrease values in a spin box, for 
example, the Magnification Level box. 

UP ARROW or  
DOWN ARROW 

Increase or decrease slider values, for example, 
the Speech Rate slider. 

RIGHT ARROW 
or  
LEFT ARROW 

MAGic Tabs 

The user interface contains the Visual tab, Speech tab, Tools tab, and Main 
Menu button. Each tab contains buttons that allow you to turn features on or 
off, select preconfigured schemes, or create your own customized schemes. 
Additional MAGic functionality is available through the Main menu as described 
later in this topic.  

Visual Tab Buttons 

With MAGic’s extensive magnification features, you can customize your display 
to fit your low vision needs. Use the items in the Visual tab to change 
magnification settings.  
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Visual Tab 
Button 

Description 

 

Turn magnification and all visual enhancements 
(mouse, color, focus, and cursor) on or off. When off, 
all enhancements in the Visual tab are unavailable. 

 

 

Switches between the current magnification level and 
1x magnification. 

 

Change the current magnification level using the 
Magnification Level box. The number in the box 
shows the current magnification level. 

 

Select your preferred view from the Magnified Views 
list. 

 

Use Mouse Enhancements to turn on or off 
enhancements and modify your mouse pointer. 
These enhancements make the mouse pointer easier 
to track and maneuver on your screen. 

 

Use Cursor Enhancements to turn on or off 
enhancements for your cursor. These enhancements 
make the cursor easier to follow when editing or 
writing text. 

 

Use Color Enhancements to turn on or off color 
enhancements. This feature allows you to replace 
colors, adjust the brightness and contrast, apply 
tinting, and invert the brightness and colors of your 
display. 
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Visual Tab 
Button 

Description 

 

Use Focus Enhancements to turn on or off the Focus 
Enhancements function. This function lets you define 
a rectangular border that makes it easier to identify 
the item that is currently selected on your screen. 

Speech Tab Buttons 

Not only does MAGic magnify your computer’s screen, but it also has screen 
reading capabilities. Use the items in the Speech tab to customize MAGic’s 
speech components to fit your needs.  

Speech Tab  Description 

 

Toggle between speech on all the time (full speech) 
or to have limited speech (Speech On Demand™). 
Refer to Choosing Speech and Speech Rate for 
more information. 

 

Move the slider left or right to adjust how fast or slow 
MAGic speaks.  

 

Use Voice Profiles to select voice settings, 
synthesizers, and languages that best fit your 
auditory preferences.  

 

Use Mouse Echo to switch the mouse echo feature 
on and off. Mouse echo enables MAGic to read text 
that you point at with the mouse.  

 

Use Typing Echo to enable or disable the typing 
echo. If typing echo is enabled, MAGic announces 
the words or characters you type 
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Tools Tab Buttons 

Use the Tools tab to access additional MAGic functionality, such as enabling 
Text Viewer, creating new keystrokes, adding items to MAGic's dictionary so 
that words, phrases, and abbreviations are pronounced correctly, and 
launching Research It, a handy tool for finding information on the Web.  

Use the items in this tab to quickly access various MAGic links and managers. 
Each item is described below.  

Tools Tab Description 

 

Use to enable or disable Text Viewer. When 
enabled, the Text Viewer window displays across the 
screen and simultaneously shows the same text that 
appears on the magnified screen. 

 

Use Links to open a list of links in the current 
document. 

 

Use Headings to open a list of headings in the 
current document. 

 

Use Skim Read to set preferences for browsing a 
document by the first sentence or line of a 
paragraph. You can also create rules to search for 
and read text containing specific words. 

 

Use Research It to easily search the Web for words, 
local weather forecast, news stories, local 
businesses, and more. 

 

Use Keyboard to assign, remove, or change hot 
keys for MAGic functions. You can also create 
shortcuts to quickly launch applications, documents, 
and Web pages.  
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Tools Tab Description 

 

Use Dictionary to change the way MAGic speaks 
words, phrases, abbreviations, or symbols.  

 

Use Script to customize MAGic for use with 
proprietary applications. This feature requires the 
scripting option.  

MAGic Menus 

The MAGic Main menu (ALT+F) is located in the upper left corner of the user 
interface. Use it to access other menus to customize and save speech, 
magnification, and keyboard settings, restore factory default settings, or access 
numerous resources on the Freedom Scientific Web site.  

You can also quickly access many of the tab and menu items using the Context 
Menu by pressing MAGic Key+MOUSE RIGHT BUTTON or MAGic 
Key+APPLICATION Key.  
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Main Menu Description 

 

The File menu allows you to save your settings 
and restore the original Freedom Scientific 
settings. You can also use this menu to change 
your MAGic preferences. 

The Visual menu allows you to customize how 
you view your screen with MAGic. You can also 
change mouse enhancements, cursor 
enhancements, color preferences, panning 
settings, view properties, and more. 

You can customize MAGic’s speech 
components to fit your particular needs. The 
Speech menu allows you to customize how you 
read text with MAGic. 

The Tools menu allows you to customize how 
you use your computer's keyboard with MAGic. 
You can re-assign the MAGic Key to a different 
key or manage shortcut keys. You can also 
access the Freedom Scientific Script Manager 
application. 

The Help menu provides you with detailed help 
information for the various MAGic functions and 
options. You can also view information on the 
newest features for this release and see your 
current MAGic version. 

 The Web Resources menu provides helpful 
links to Freedom Scientific products and 
resources such as the Freedom Scientific Web 
site, MAGic Headquarters, Technical Support 
contact page, FS Activate Web page, and other 
helpful links.  
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Getting Help 

With focus in the MAGic user interface, press F1 to open the MAGic help file. 
Use the Contents tab to navigate the help system. You can press CTRL+TAB 
to move among the tabs.  

The left side of the help window displays a list of items in the selected 
Contents, Index, or Search tab. The right side of the help window is the topic 
area. Press F6 to jump between the left pane and right pane. 

Use the Index or the Search tabs to search for specific topics within the help 
system. If you want MAGic to read the help topics to you, position the mouse 
pointer toward the beginning of the help page, and press MAGic Key+A. You 
can move to the next topic by clicking the "Next" link at the bottom of the page. 
To return to the previous topic, click the "Back" link. 

What’s This? Help 

MAGic’s What’s This? help is context-sensitive help that you can use as a 
reference when working with MAGic’s user interface or dialog boxes. Press 
SHIFT+F1 on any button on the user interface, or control in a dialog box to see 
a brief description of the purpose of the control and how to use it. 

For mouse users, most dialog boxes contain a  button in the top, right corner. 

Click the  button to change your mouse pointer into the What's This? Help 
pointer (see below). Move your pointer to the control you need more 
information about, and click the mouse on the control to see the What’s This? 
help. If you do not find enough information in the What’s This? help, try 
referring to the full help system. 
 

 

What’s This? Help button 

 

What’s This? Help pointer 

Keyboard Help Mode - INSERT+1 

Turn on this feature by pressing INSERT+1 to explore MAGic commands. As 
you press key combinations, MAGic tells you what the keyboard command 
does, safely - without actually performing the command. Press INSERT+1 
again to exit keyboard help. Keyboard help is only available when speech is 
enabled. 
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MAGic User’s Guide 

We provide you with the content of the MAGic help system in the MAGic User’s 
Guide, which is printed in large text for easier reading.  

MAGic DAISY Book Training Material and FSReader 

When installing MAGic from the DVD, you have the option of installing the 
MAGic Basic Training and the MAGic What's New DAISY books. You can listen 
to and read these training modules using FSReader, Freedom Scientific's 
DAISY book reader that is included with MAGic.  

FSReader is automatically installed during MAGic installation. You can start 
FSReader later using its Desktop icon or Start Screen tile. Once open, you can 
download additional DAISY training books. For more information, see Basic 
Training Using FSReader. 

Technical Support 

If you do not find the answers to questions or problems that you have, contact 
Freedom Scientific Technical Support. 

About MAGic  

From the Main menu, choose Help and then About MAGic to view the version 
number of MAGic you are currently running. 

 Basic Training Using FSReader 

There are several MAGic training files available for you to listen to and read 
using FSReader, Freedom Scientific's DAISY (Digital Accessible Information 
System) book reader. This tool is automatically installed when you install 
MAGic. The text area of a DAISY book is in HTML format, which means you 
can navigate using the same techniques that you use for the Web. For 
example, you can use Navigation Quick Keys such as H to move by heading or 
P to move by paragraph. 

You can start FSReader using its Desktop icon or Start Screen tile. Once open, 
you can download additional DAISY training books directly through FSReader. 
To learn more about FSReader, refer to the “FSReader Getting Started” book, 
which can be accessed by pressing F1 while in FSReader. 



16 

To open or download other Freedom Scientific DAISY books, do the following: 

1. Start FSReader.  

2. Press ALT+F to open the File menu and choose "Open MAGic Training 
Table of Contents" to open the table of contents book.  

3. Each available DAISY book is identified as a link. Navigate to the book 
you want to open and press ENTER. If the selected book has not yet 
been installed on your computer, FSReader will automatically download 
and install the book and then open it. Otherwise, the selected book is 
opened.  
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Chapter 3 

Installing and Activating MAGic 

Installing MAGic 
1. Insert the MAGic disk into your computer's disk drive.  

2. When the MAGic Setup dialog box appears, choose the MAGic Setup 
button. If you are installing Network MAGic, choose the MAGic Network 
Setup button instead.  

3. The MAGic setup program starts. You will hear the installation speak the 
instructions as they appear on your screen. Follow these instructions to 
complete the MAGic installation.  

4. Once installation is complete, you must restart your computer before 
using MAGic.  

5. Run MAGic after your computer restarts.  

The first time you run MAGic, the MAGic Startup Wizard appears. It allows you 
to configure MAGic's most commonly customized options. For example, you 
can create a hot key assignment for MAGic, configure MAGic to automatically 
run when Windows starts, play speech and sounds when Windows controls are 
selected, or install MAGic training material. 

Uninstalling MAGic 

To uninstall MAGic, open the Windows Control Panel and select Programs and 
Features. Select MAGic in the list and then choose Uninstall.  

During the uninstall process, you can choose to remove shared components or 
user settings files. 

Shared Components 

Shared components refer to training materials, video drivers, and other 
components that are shared between different versions of MAGic, as well as 
among several other Freedom Scientific products, such as JAWS. 
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If you have another version of MAGic, or other Freedom Scientific products, 
installed on your computer, it is recommended that you choose not to remove 
shared components. If you remove them, your other Freedom Scientific 
products will no longer have all the necessary files. If you have no other 
Freedom Scientific products or versions of MAGic on your system, it is 
recommended that you choose to remove the shared components. 

User Settings 

User settings files are configuration files, scripts, and other settings that you 
have customized or created. When asked, choose Yes to delete the files, or No 
to keep the files on your computer. You can quickly access these files by 
choosing "Explore My Settings" in the MAGic program group. For more 
information, see MAGic Utilities and Program Group. 

Startup Wizard 

The Startup Wizard is a helpful tool containing magnification, speech, and other 
useful parameters that let you quickly configure MAGic for operation. The 
wizard is a time-saver since you do not have to search multiple menus and 
managers to customize your copy of MAGic. The Startup Wizard automatically 
runs the first time you install a new version of MAGic. The following describes 
the dialogs in the Startup Wizard. 

Note: You must choose the Finish button in the wizard's last dialog box 
to save and activate any changes. If you cancel or escape at any 
point in the wizard, your changes will not be saved.  

Visual Settings 

Use the options in this dialog box to set magnification and display settings that 
best fit your low vision needs. 

Default Magnification Level 

Use this edit box to set the default magnification level for MAGic. This is the 
magnification that will be used each time your start MAGic. Use the UP and 
DOWN ARROW keys to increase or decrease the magnification level. The 
default is 2x magnification. You can also choose among the following 
magnification levels: 

 1x to 2x in nine magnification increments (1.1x to 1.9x)  

 2x to 3x in three magnification increments (2.25x, 2.5x, and 2.75x)  
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 3x to 4x in three magnification increments (3.25x, 3.5x, and 3.75x)  

 4x to 60x in whole number increments  

Preferred View 

Use this combo box to configure the magnified screen layout used by MAGic. 
For example: 

 Full view means that the entire screen is magnified using the 
magnification set by the Default Magnification Level option. Full view is 
the default.  

 Split view divides the screen into two halves, one magnified, one 
unmagnified.  

 Overlay view opens a magnified rectangular window positioned in the 
screen corner. As you move the mouse, that area of the screen appears 
in the magnified window.  

 Lens view opens a magnified rectangular window that follows mouse 
movement.  

 Dynamic Lens view functions like Lens View except it follows keyboard 
commands instead of mouse movement.  

See Changing the Current Magnified View for more information.  

Mouse Enhancement 

Select this check box to turn on mouse enhancements. These enhancements 
make it easier to track the mouse pointer and maneuver on the screen. See 
Changing the Mouse Pointer for more information.  

Cursor Enhancement 

Select this check box to turn on cursor enhancements. These enhancements 
make it easier to follow the cursor when editing or writing text. See Changing 
the Cursor for more information.  

Focus Enhancement 

Select this check box to place a rectangular border around the item that is 
currently selected on the screen. This is especially helpful when trying to 
distinguish between similar screen colors. The border moves around the screen 
as you type keyboard commands or move the mouse. See Focus 
Enhancements for more information.  
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Color Enhancements 

Select this check box to use color settings and schemes, which are defined by 
the Changing Screen Colors feature, for the magnified and unmagnified areas 
of the screen. This feature lets you configure MAGic to invert colors, set 
brightness, and adjust screen contrast. 

Transition Animation 

Select this check box to turn on Transition Animation. It is selected by default.  

Transition Animation creates a continuous smooth motion on the screen when 
changing magnification levels, moving focus between objects, or when moving 
to the beginning of a new line or column while reading with Say All. Transition 
Animation settings can be changed using the Display dialog box. This feature is 
only available in Windows 8.1 or later. 

MAGic Hotkey Assignment 

Use this edit box to create your own keystroke command that will automatically 
start MAGic. You can use this shortcut instead of choosing the Desktop icon or 
the MAGic submenu. CTRL+ALT+M is the default hot key assignment.  

Startup Settings  

Use the options in this dialog box to define if and how MAGic loads when you 
start Windows. If you use the default settings, MAGic will always load and run 
before and after you launch Windows. This dialog box contains the following 
items:  

 Select the Start MAGic at the Log On screen check box so that MAGic 
loads and starts when the Windows log on screen appears. The check 
box is selected by default. If you have Standard user rights, you cannot 
change the value of this check box, and MAGic will ignore and not 
announce the check box.  

 If the Start MAGic after log on for all users check box is selected, 
MAGic loads and starts after you log on to Windows. It is cleared by 
default. If you have Standard user rights, you cannot change the value of 
this check box, and MAGic will ignore and not announce the check box.  
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 The Start MAGic after log on for this user combo box lets an individual 
control if MAGic starts after he or she logs on to Windows. If Always is 
selected, MAGic starts every time the current user logs on. Always is the 
default setting. If Never is selected, MAGic will not start after the user 
logs on. If Using the All Users Setting is selected, then the following can 
happen: MAGic starts after the user logs on if the Start MAGic after log 
on for all users check box is selected, or MAGic does not start if the 
same check box is cleared.  

 Select the Run MAGic from System Tray check box to prevent the 
MAGic button from appearing in the Windows taskbar, which is located at 
the bottom of the screen, with other programs that are currently running. 
Instead, the MAGic icon appears in the Windows system tray, which is 
located in the bottom right corner of the screen, to indicate that MAGic is 
running. Finally, when this check box is selected, the MAGic icon does 
not appear in the list of active windows when you press ALT+TAB. This 
check box is cleared by default.  

 If the Minimize on Startup check box is selected, the MAGic user 
interface is minimized when MAGic starts. To open the user interface, 
choose the MAGic button in the taskbar, or press MAGic Key+U. This 
check box is cleared by default.  

Training Material 

This dialog box only displays when you install MAGic from the program DVD. 
The MAGic program DVD contains basic training audio files in DAISY (Digital 
Accessible Information System) format. You can use FSReader, a DAISY book 
reader from Freedom Scientific, to listen to and read the training files. To install 
the MAGic Basic Training and the What’s New DAISY books, choose Next and 
continue. The training materials are installed when you finish the wizard. 
Additional DAISY books are available for download through the FSReader 
application.  

Speech Settings 

Use the items in the Speech Settings dialog box to customize how fast MAGic 
speaks, how much punctuation is used, and whether or not typing or mouse 
echo is heard as you type or move the mouse.  
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Speech Level 

Use this combo box to select full speech or Speech On Demand, which limits 
the amount of speaking by MAGic. When MAGic starts, it will use this speech 
setting.  

Rate 

Move the slider to increase or decrease how fast MAGic speaks. The 
percentage value announced via speech is relative to the current position of the 
slider bar. The value displayed in the dialog box is based on a setting within the 
synthesizer, for example, words per minute. See Voice Profile Adjustment 
Settings for more information. 

Punctuation 

Use this combo box to determine how much punctuation MAGic speaks, for 
example, some, most, all, or none.  

Enable Typing Echo  

Select this check box to turn on typing echo. Clear this check box to turn off 
typing echo.  

Typing Echo 

When typing echo is on, select one of the radio buttons to determine if MAGic 
announces characters as you type, words that you type, or both. See Reading 
with Typing Echo for more information.  

Mouse Echo 

Mouse echo means that as you point at text with the mouse, MAGic will 
announce either the individual word or the entire line of text. Select one of the 
radio buttons to determine the type of mouse echo used. See Reading with 
Mouse Echo for more information. 

Lower the Volume of Other Programs While MAGic is Speaking 

When this check box is selected, the volume for all programs will be reduced 
while MAGic is speaking. This check box is cleared by default and is only 
available if MAGic is running in Windows 8.1 or later. 
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Verbosity Settings 

Use the options in this dialog box to determine if MAGic speaks, plays a sound, 
or both when it encounters specific controls such as radio buttons, check 
boxes, buttons, help menus and so on. You can also configure MAGic to 
announce the state of certain controls, for example, if a check box is selected 
or not, if a button is clicked, if a dialog box closes, and so on.  

Verbosity Scheme 

Verbosity schemes give you additional control over which items MAGic 
announces, as well as how they are announced. You can also define custom 
text that MAGic speaks when you move to a control or other element on the 
screen. On the other hand, you can assign a sound that you want MAGic to 
play instead of speaking. You can also choose to combine both speech and 
sounds, or configure MAGic to ignore certain items entirely. See Verbosity or 
Verbosity Scheme for more information. 

Access Key 

An underlined letter within a menu, command, or button is known as an access 
key. You can activate these items by pressing the access key in conjunction 
with the ALT key. Use the radio buttons in the Access Key group to customize 
MAGic to announce all access keys in menus and dialogs, to only announce 
access keys in menus, to only announce access keys in dialogs, or to not 
announce any access keys. See Access Key Verbosity for more information.  

Announce Tool Tips 

Select this check box to have MAGic announce Tool Tips of any length. A Tool 
Tip frequently appears when you rest the mouse over an item for a brief period 
of time. It gives a short description of the item. 

Announce Help Balloons 

Help balloons provide information about a selected item. When this check box 
is selected, MAGic automatically reads this information as it is displayed.  



24 

Standard Activation 

When you first install and start MAGic, you are asked to activate the program. 
You can use Internet License Manager (ILM) to activate MAGic using an 
Internet connection. This is the easiest and quickest way to activate your 
product. If you do not have Internet access, you can activate manually by 
telephone, fax, or by visiting www.FSActivate.com. Refer to Other Activation 
Methods for more information. 

If you do not activate at this time, MAGic runs in 40-minute mode, which 
requires a computer reboot every 40 minutes. The activation process can be 
started later by opening the Help menu and choosing Update Authorization.  

To activate MAGic using the Internet, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Select Internet (RECOMMENDED) and choose Next.  

3. Insert the Authorization CD into your disc drive and choose Activate 
Using Authorization CD. You can find your Authorization CD in the 
same sleeve as your MAGic program disc. If you do not have your 
Authorization CD, choose Enter Your Authorization Number Manually.  

Note: If you have previously inserted your Authorization CD, you will not 
be asked to insert it again. Continue to the next step. 

4. If you used your Authorization CD, your 20-digit Authorization number is 
automatically inserted into the Authorization Number edit box. If your 
Authorization number is not shown, type it into the edit box. You can find 
your Authorization number in print and braille on your MAGic disc sleeve.  

5. Press ENTER to continue. You will be asked to connect to the Internet if 
you have not already done so. You must establish an Internet connection 
before continuing with the activation.  

6. If you have not registered MAGic, you are asked to do so now. 
Registering MAGic lets you receive technical support. Choose Register 
Now and complete the online registration form by following the 
instructions provided. You can choose to register later, but you must 
register the next time you activate MAGic.  

7. After you submit your registration, Internet License Manager attempts to 
activate MAGic. This process may take several minutes. When the 
activation is successful, choose Finish.  
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Note: If Internet License Manager cannot activate MAGic because of 
your firewall software, see Troubleshooting Firewall Software. 

Note: Adding or removing certain hardware components may cause 
your computer's Locking Code to change. If this occurs, you must 
reactivate MAGic. If you need to request more activations, go to 
www.FSActivate.com. 

Other Activation Methods 

To activate MAGic using a different method, do the following: 

1. In the Activation dialog box, choose Start Activation.  

2. Select Manual, by telephone, fax, or fsactivate.com, and choose Next.  

3. Select one of the following, and then follow the instructions that display in 
subsequent Activation dialog boxes:  

 Insert the Authorization CD into your disc drive and choose 
Activate Using Authorization CD, or  

 Choose Enter Your Authorization Number Manually  

Network Authorization 

If you purchased a network (multi-user) license of MAGic, refer to ILM Multi-
User Network Authorization for instructions on installing the license server and 
activating your software. Refer to Network MAGic for information about 
installing, authorizing, and setting up MAGic on a network. 

Dongle Authorization 

A dongle is a hardware device that you can connect to a computer's parallel or 
USB port (depending on the type of dongle). MAGic is authorized to run on that 
computer as long as the dongle remains connected. This is useful if you 
frequently need to use MAGic on many different computers and do not want to 
activate the program on each of them.  
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When MAGic starts, it first determines whether a dongle is connected to the 
computer. If one is connected, MAGic uses the features and information for the 
license associated with the dongle to authorize MAGic. If no dongle is 
connected, MAGic searches for the license information stored on the computer. 
You can use the Dongle Viewer utility to view information on the license 
associated with the dongle currently connected to your computer. To start this 
utility, go to the MAGic program group, open the Tools submenu, and choose 
Dongle Viewer. 

Note: It is recommended that you do not connect the dongle to your 
computer until after you install MAGic. If the dongle was 
connected before or during installation, you must restart your 
computer to receive proper authorization. 

Dongles are sold separately or as an additional MAGic feature. Contact 
Freedom Scientific Sales if you want to purchase one.  

Note: Certain international versions of MAGic require a dongle for 
authorization. Using one of these versions without a dongle 
displays an error message.  

Starting and Quitting MAGic 

Starting MAGic 

MAGic gives you a variety of ways to start the program:  

 Double-click the MAGic program icon on your Windows desktop  

 

 Press ALT+CTRL+M 

 Click the Start menu and choose All Programs, MAGic <version 
number>, MAGic (Windows 7 only)  

 Press WINDOWS Key+R, type "MAGic <version number>" (without the 
quotes), and press ENTER  

When you first start MAGic, your screen displays in 2x magnification using Full 
screen magnification view. Speech is also enabled (if your software is licensed 
for speech). You can then change the magnification level, magnified view, 
speech, and many other options in the MAGic user interface and Main menu.  
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Starting MAGic Automatically 

The MAGic Startup Wizard appears when you first start MAGic on a Windows 
computer. If you have an Administrator account, three options appear in the 
wizard. If you have a Standard User account, only the Start MAGic after log 
on for this user combo box appears. Use the default values for these options 
if you want MAGic to start before and after Windows starts. There is no need to 
change the default values. However, if the values were changed, the following 
procedure describes how to reset the default values so that MAGic starts 
automatically.  

To set MAGic to start automatically, do the following: 

1. From the Main menu, choose File and then Preferences.  

2. Choose Automatically Start MAGic. The Start MAGic Options dialog 
box opens.  

3. Do one of the following:  

 If three options are available, make sure that the Start MAGic at 
the Log On screen check box is selected; the Start MAGic after 
log on for all users check box is unchecked; and the Start MAGic 
after log on for this user combo box is set to Always  

 If only the Start MAGic after log on for this user combo box 
appears, make sure that it is set to Always  

4. Choose OK to accept the changes so that MAGic starts automatically 
when Windows starts.  

5. Choose OK to close the Preferences dialog box. MAGic automatically 
starts the next time you run Windows.  

Note: In Windows 8.1 or later, the “HD Smoothing Options” box 
displays. The available options determine if MAGic restarts with 
or without HD Text smoothing following a Windows or system 
error. For more information, refer to HD Smoothing Options. 
 
In Windows 7, the "Start MAGic DirectX helper after logon for all 
users" check box is selected by default. It allows MAGic to 
provide HD Text and color smoothing in some DirectX drawn 
applications including Internet Explorer. There is no need to clear 
this check box. 
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Quitting MAGic  

To quit MAGic, do one of the following: 

 Press ALT+F4  

 Click the Close button  in the top right hand corner of the MAGic user 
interface.  

 Select Exit MAGic from the Main menu  

Tip: If you want MAGic to ask to save your settings when you quit, 
open the File menu and choose Preferences. Select the Prompt 
to Save Settings on Exit check box. 
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Chapter 4  
Customizing MAGic 

Use the information in this topic as a guide when setting up MAGic for your 
visual and speech needs. When you first start MAGic, your screen displays in 
Full view mode with 2x magnification. Speech is also enabled (if your software 
is licensed for speech). Note that to momentarily silence speech, press CTRL. 
To toggle between full speech and Speech On Demand™ mode, press MAGic 
Key+F3. The default MAGic Key is the CAPS LOCK key on your keyboard.  

The MAGic user interface contains everything you need to customize 
magnification and speech to fit your needs. Use the procedures below as a 
reference for configuring both visual and speech settings.  

 

Visual Settings Speech Settings 

Choosing Color Enhancements Speech Settings 

Choosing a Magnification Level Full Speech or Speech On Demand 

Adjusting the Mouse Pointer Speech Rate 

Adjusting the Cursor Mouse and Typing Echo 

Adjusting Focus Selecting a Voice for MAGic 

Choosing a Magnification View Saving Voice Setting 

Saving Visual Settings 
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Choosing Color Enhancements 

The first place to start is with the Color Enhancements settings. The idea is to 
reduce glare and provide contrasts to make it easier to view items on the 
screen. 

1. Click the top half of the Color Enhancements button in the Visual tab. 
This turns color enhancements on.  

 

2. Next, click the bottom half of the Color Enhancements button and choose 
a default color scheme as a starting point. A scheme is a template that 
provides preset colors, brightness, and contrasts. You can set different 
color schemes for the magnified area of your display, the unmagnified 
area, or both.  

Choosing a Magnification Level 

The default magnification value is 2x with Full screen view. You can experiment 
with different magnification values using the Magnification Level spin box.  

1. Click the up and down arrows in the Magnification Level box to select a 
comfortable magnification value. Magnification values range from 1.0x to 
60x with incremental steps between 1.0x to 4x.  

 

2. While adjusting the magnification, click the 1x Toggle button to decrease 
magnification to 1x. This is a handy way of comparing how much of the 
display that you can actually see when it is magnified. Continue toggling 
between 1x and the current magnification to adjust magnification to what 
is comfortable for you.  

Note that for a quick side-by-side comparison; try using Split view to see 
the adjustments that you are making. Split view divides the screen 
between an unmagnified view and a magnified view. 
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Adjusting the Mouse Pointer 
1. To reduce eye fatigue and make it easy to locate and track your mouse 

pointer on the screen, click the top half of the Mouse Enhancements 
button. The mouse pointer immediately switches to one of the mouse 
scheme values. 

 

2. To select a different mouse scheme, click the bottom half of the button. 
These schemes provide a great starting point with contrasting colors and 
different mouse pointer shapes. To make additional adjustments, to the 
size, type, shape, color, transparency, and more, select Settings from the 
Mouse Enhancements list.  

Adjusting the Cursor 

To help the cursor standout against text and your document’s background, 
Cursor Enhancements can be turned on. This makes it easier to locate and 
follow the cursor when editing or writing text. To turn on this feature, click the 
top half of the Cursor Enhancements button.  
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While you can change the color of the flashing cursor, you can also change its 
style attributes, for example, an oval or box that surrounds the cursor, a 
crosshair that displays on top of the cursor, or triangles that display above and 
below the cursor. In addition, you can adjust the transparency, thickness, and 
more for these style attributes. To access these settings, click the lower half of 
the Cursor Enhancements button and then select Settings.  

Adjusting Focus 

To help identify and track your location in a window, dialog box, or application, 
use the Focus Enhancements feature. It places a visible rectangular border 
around objects. Click the top half of the Focus Enhancements button to turn 
this feature on or off.  

 

To change the color, transparency, and other attributes, click the lower half of 
the button and select Settings.  

Choosing a Magnification View 

After experimenting with color, mouse, cursor, and focus enhancements, revisit 
the Magnification View list and select a screen view that is most comfortable for 
you.  

 Full. The entire screen is magnified.  

 Split. The screen is split horizontally or vertically where one area is 
magnified and the other is not.  

 Lens. Displays a magnified rectangle that follows mouse pointer 
movement.  

 Dynamic Lens. Also displays a magnified rectangle that follows the 
mouse pointer, and automatically resizes to only magnify the currently 
selected item.  

 Overlay. Displays a stationary magnified window in the corner of the 
screen while the rest of the screen is unmagnified.  

Settings for Split, Lens, Dynamic Lens, and Overlay views can be fine-tuned in 
the View Properties dialog box. To quickly access it, click the Magnification 
View button and select Settings from the list.  
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Saving Visual Settings 

To make sure that MAGic retains your visual settings, press CTRL+S to save 
your settings. You can also save settings by clicking the Main menu button, 
choosing the File menu, and then “Save Default Settings.”  

 

Speech Settings 

Now that you have configured your visual settings for MAGic, it is now time to 
decide if you want to use speech, and if so, which voice features you want to 
use.  

Allowing MAGic to speak can reduce eye fatigue. Use it to help you locate 
where focus is on the screen. You can use speech features such as mouse 
echo and typing echo in conjunction with the mouse, cursor, and focus visual 
enhancements.  

To switch and access to basic speech settings, click the Speech tab in the 
MAGic user interface.  

Full Speech or Speech On Demand 

The Speech button is the first item in the Speech tab. Click the button to switch 
between full speech or Speech On Demand mode. Speech On Demand limits 
how much MAGic announces as you move among applications, documents, 
and windows. This mode uses a limited number of speech and reading 
commands. For more information, see Speech On Demand.  
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Speech Rate 

The first thing to decide with speech is how fast or slow you want MAGic to 
speak. Initially, you may want to decrease the speech rate until you are 
comfortable.  

Move the Speech Rate slider to the left to decrease speech or to the right to 
increase speech.  

 

If speech becomes overwhelming at first, press CTRL to momentarily silence 
speech. To toggle between full speech and limited speech, press MAGic 
Key+F3.  

Mouse and Typing Echo 

MAGic can read the word or the line of text that you point to with the mouse 
pointer. This is the Mouse Echo feature, and it can be turned on or off by 
clicking the top half of the Mouse Echo button. Clicking the bottom half of the 
button allows you to quickly select mouse echo by word or line. 

 

Typing Echo simply allows MAGic to repeat characters, words, or both as you 
type. Click the top half of the button to turn on this feature. Click the bottom half 
to select an echo setting. 

Try experimenting with these features to see if it is something that you want to 
use now or in the future.  

Selecting a Voice for MAGic  

Finally, you can select different voices to use with MAGic. Voice Profiles, which 
is an advanced feature, lets you pick different synthesizers, languages, and 
voices to your liking. You can create and apply a default voice profile that 
MAGic always uses, or you can create unique voice profiles for different 
applications. 
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Click the Voice Profiles button to quickly select a different synthesizer to use.  

 

To fine-tune voice settings, select Settings from the Voice Profiles list. This 
opens the Voice Adjustment dialog box. 

Saving Voice Setting 

Always remember to save changes to your settings by pressing CTRL+S, or 
clicking the Main menu button, choosing the File menu, and then “Save Default 
Settings.”  
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Chapter 5 
Magnification and Visual Enhancements 

Changing Screen Colors  

You can change screen colors to reduce glare and provide contrasts to make it 
easier to view items on the screen.  

 

Click the top half of the Enhancements button to turn this feature 
on or off.  
 
Click the lower half of the button to quickly switch between built-
in schemes and custom schemes that you have created. 
Customizations can be made through Settings at the bottom of 
the schemes list. 

Settings 

When you select Settings, the Color Enhancements appear. These options 
allow you to replace and switch colors, adjust the brightness and contrast, 
apply tinting, make your screen monochrome, and invert the brightness and 
colors of your screen. You can customize colors for both magnified and 
unmagnified areas of the screen. To modify settings, use the options available 
in the Magnified Area and Unmagnified Area tabs.  

The Color Schemes tab lets you save your color enhancements settings as a 
scheme or switch to a different scheme. For more information on schemes, 
refer to the help topic Using Schemes. 

Select the Enable Color Enhancements check box on any tab in this dialog 
box to apply color enhancements to your display. Clear this check box to 
disable the color enhancements. 
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Invert Brightness 

Select this check box if you want MAGic to invert the brightness of colors on 
your display. Dark colors will appear lighter, while light colors will appear 
darker. For example, if you select this check box, black text becomes white text 
and dark blue becomes light blue.  

Invert Colors 

Select this check box to reverse the colors that are displayed on your screen.  

Invert Black and White 

If you select this check box, MAGic replaces the color black with white and the 
color white with black.  

Restore System Colors Button 

Click Restore System Colors or press ALT+Y to revert to your original 
Windows color settings.  
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Brightness 

Use the Brightness slider to adjust the brightness of your screen. Brightness 
determines how light or dark colors appear. Move the slider down to reduce the 
brightness, move it up to increase the brightness. 

Contrast 

Use the Contrast slider to adjust the contrast of you screen. Contrast 
determines the difference between lighter and darker areas. Move the slider 
down to reduce the contrast, move it up to increase the contrast.  

Monochrome and Tint 

The Monochrome and Tint area allows you to tint your screen with a color or 
make the screen monochrome (black-and-white, yellow-and-white and so on). 
MAGic only applies these settings if you select the Enable Monochrome and 
Tint check box. 

Color 

In the Color list, choose the color you want MAGic to use to tint your screen. 
Choose "Grayscale" if you want your screen to appear monochrome (black-
and-white). To choose from additional colors, activate the Define Custom 
Color button and choose one of the available colors from the palette. If you 
want to use a color that is not included on the palette, refer to Defining Custom 
Colors. 

Level 

Use the Level slider to adjust the luminescence, or brightness, of the tinting. 
Move the slider to the left to make the color appear darker, move it to the right 
to make the color appear brighter. 

Blend 

Use the Blend slider to control the intensity of the tinting. Move the slider to the 
left for strong tinting. At stronger levels, the tinting affects the color of almost 
everything on the screen. Move the slider to the right for a lower level of tinting. 
At the lowest levels, the tinting only slightly alters the colors on your screen. 
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Color Switching 

The Color Switching area allows you to define rules that switch certain colors 
on your screen with colors of your choice. MAGic only applies these color 
switching rules if you select the Enable Color Switching check box. 

To create a new rule: 

1. Select the Replace Color radio button if you want to use one color 
instead of another. Select the Exchange Colors radio if you want to 
switch two colors on your screen. For example, if you select Replace 
Color and choose to replace red with blue, all red objects will appear blue 
instead. If you select Exchange Colors and choose to switch red and 
blue, all red objects appear blue, and all blue objects appear red.  

2. Select one color in the Color list and a second color in the With Color 
list. If you are creating a color replacement rule, MAGic will replace the 
first color with the second color. If you are creating a color exchange rule, 
MAGic will switch these two colors on your screen.  

3. Click Add Rule or press ALT+D to define your new rule and add it to the 
list.  

Follow the steps above to add more rules as necessary. To delete a rule, select 
it in the Active Color Switches list and click Remove Rule or press ALT+M.  

Saving a Scheme 

Changes made to these settings can be saved as a scheme. A scheme is a 
group of settings that can be used in certain applications or circumstances. 
Schemes allow you to quickly switch between different configurations of 
mouse, cursor, or color enhancements, according to your current needs. See 
Using Schemes for more about creating and modifying schemes. 

Changing Magnification Levels 

To change screen magnification, use the Magnification Level box, the 1x 
Toggle button, or the magnification hot keys. 

Note: The Visual Enhancements button must be selected to view 
and change magnification and other visual enhancements.  
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The UP ARROW button increases the magnification level, 
while the DOWN ARROW button decreases the magnification 
level. The number between the two buttons shows the current 
magnification level. The default level of magnification is 2x (2x 
is equivalent to two times the normal screen display). All visual 
enhancements remain active when switching between 
magnification levels.  

The following magnification levels are available: 

 1x to 2x in nine magnification increments (1.1x to 1.9x)  

 2x to 3x in three magnification increments (2.25x, 2.5x, and 2.75x)  

 3x to 4x in three magnification increments (3.25x, 3.5x, and 3.75x)  

 4x to 60x in whole number increments  

1x Toggle 

 

It is possible to change the magnification level to 1. This 
allows you to continue using magnification features, such 
as mouse, cursor, and color enhancements, while viewing 
the entire screen area.  

Use this button to switch between 1x magnification and the 
current magnification level. For example, if the current 
magnification level is 4x, clicking this button switches to 1x 
magnification. Clicking the button again restores 4x 
magnification.  

Hot Keys 

Increase 
Magnification 

MAGic Key+NUM PAD PLUS or  
CTRL+EQUALS or  
MOUSE WHEEL UP (scroll wheel up or away 
from you)  

Decrease 
Magnification 

MAGic Key+NUM PAD MINUS or  
CTRL+DASH or  
MOUSE WHEEL DOWN (scroll wheel down 
or towards you)  
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Magnification Level 
Toggle between 1x 
and Current 
Magnification  

MAGic Key+SHIFT+DELETE or  
MAGic Key+MOUSE MIDDLE CLICK (press 
down on scroll wheel)  

Toggling All Visual Enhancements 

 

Use this button to turn magnification and all visual 
enhancements (mouse, color, focus, and cursor) on or 
off. When off, all enhancements in the Visual tab are 
unavailable.  

Hot Keys 

Toggle visual enhancements on or off MAGic Key+DELETE 

Changing Magnification View 

Changing the Current Magnified View 

 

Click to select your preferred magnified view, or customize the 
current view's settings. Customizations can be made through 
Settings at the bottom of the list. 

Below are the available magnification views and settings.  

 Full. The entire screen is magnified  

 Split. The screen is split horizontally or vertically where one area is 
magnified and the other is not  

 Lens. Displays a magnified rectangle that follows mouse pointer 
movement  

 Overlay. Displays a stationary magnified window in the corner of the 
screen while the rest of the screen is unmagnified  

 Dynamic Lens. Also displays a magnified rectangle that follows the 
mouse pointer, and automatically resizes to only magnify the currently 
selected item  
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 Multi-Monitor. Indicates if Multi-Monitor mode is selected. From the Main 
menu, choose Visual, Multi-Monitor, and then Enable Multi-Monitor to 
enable or disable Multi-Monitor operation. For Multi-Monitor 
magnification, see Multi-Monitor Configuration.  

 Resize View. Use to resize or move the view when working in Split, 
Overlay, Lens, or Dynamic Lens views  

 Settings. Choose to adjust the selected view's settings  

View Settings 

You can customize how the Split, Lens, Overlay and Dynamic Lens views 
appear on your screen using the View Settings dialog box.  

To open the dialog box, click the Magnified View button and select Settings. 
Note that Settings is unavailable for Full and Multi-Monitor views.  

 

Split Settings 

The Split tab allows you to define properties for the Split view. Split view allows 
you to see both an unmagnified area and a magnified area at the same time. 
The Split view opens a magnified window in part of your screen, but leaves the 
other part unmagnified as a reference. 

You can select a color and thickness for the border that separates the two parts 
of the split screen. 
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You can also select where you want the magnified area to appear on the 
screen (Bottom, Top, Left, or Right), and select how much of the screen you 
want the magnified area to occupy. For example, if you select Quarter, the 
magnified area occupies 25% of the available screen area. 

Overlay Settings 

The Overlay tab allows you to define properties for the Overlay view. Overlay 
view creates a magnified window in the corner of the screen, while the rest of 
the screen remains unmagnified. This is similar to the Lens view, but the 
Overlay view does not move around the screen.  

You can select a color and thickness for the border of your overlay border.  

Lens Settings 

The Lens tab allows you to define properties for the Lens view. Lens view 
opens a small rectangular window, which is magnified, while leaving the 
remaining desktop unmagnified. The lens moves around the screen as you 
move your mouse or when the focus changes.  

You can select a color and thickness for the border of your lens. 

Dynamic Lens Settings 

The Dynamic Lens tab allows you to define properties for the Dynamic Lens 
view. Dynamic Lens view opens a small rectangular window, which is 
magnified, while leaving the rest of the screen unmagnified. This window 
follows the mouse pointer or your current location within a document or dialog 
box if you are using the keyboard. In addition, when you move to a dialog box 
option or menu command, MAGic automatically resizes the lens so that it only 
magnifies the currently selected item. If you type in an edit box or document 
window, the lens expands to the width of the entire screen so you can see as 
much of the text as possible. 

You can select a color and thickness for the border of your lens.  



 45 

Resize View 

 

Resize View is an item in the Magnification View list. 
When working in Split, Overlay, Lens, or Dynamic Lens 
views, select it to resize or move the current view.  
 
After choosing Resize View, notice that the cursor 
changes shape, and that MAGic automatically minimizes 
the user-interface. The shape of the mouse indicates in 
which direction you can click and drag your mouse to 
move or resize your view. 

 

If the pointer appears as an X, like above, it is not positioned over the view or 
one its borders. The X indicates that from this position the view cannot be 
resized or moved. 

 

A bi-directional cross indicates the ability to move the view to a different 
location on your screen. Click the view, and while holding the mouse button 
down drag the view to another location. Split view only moves to the top, 
bottom, left, or right edge of your screen, while you can move Overlay to any 
location on your screen. 

 

A vertical pointer indicates that resizing will occur in a vertical direction, larger 
or smaller. 

 

A horizontal pointer indicates that resizing will occur in a horizontal direction, 
either larger or smaller. 
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A diagonal pointer indicates that resizing will occur in both vertical and 
horizontal directions. MAGic only exhibits the diagonal mouse when you 
position the mouse over the corner of the view. The diagonal pointer is only 
available for the Overlay, Dynamic Lens, and Lens views.  

Changing the Mouse Pointer 

To reduce eye fatigue and make it easy to locate and track your mouse pointer 
on the screen, use Mouse Enhancements to enable/disable enhancements and 
modifications for your mouse pointer.  

 

Click the top half of the Enhancements button to turn this feature 
on or off.  
 
Click the lower half of the button to quickly switch between built-
in schemes and custom schemes that you have created. 
Customizations can be made through Settings at the bottom of 
the schemes list. 

Hot Keys 

Toggle Mouse Enhancements MAGic Key+F4 

Settings 

When you select Settings, the Mouse Enhancements appear. You can 
customize the appearance of your mouse for both magnified and unmagnified 
areas of the screen. To modify settings, use the options available in the 
Magnified Area and Unmagnified Area tabs.  

The Mouse Schemes tab lets you save your cursor enhancements settings as 
a scheme or switch to a different scheme. For more information on schemes, 
refer to Using Schemes. 

Select the Enable Mouse Enhancements check box on any of the tabs in this 
dialog box to apply enhancements to the mouse pointer. Clear this check box 
to disable mouse enhancements. You can also use the Mouse Enhancements 
button to enable or disable mouse enhancements. 
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Mouse Attributes 

The options in the Mouse Attributes area allow you to customize the 
appearance of your mouse pointer. 

Use HD Pointers 

Select this check box to turn on HD (high definition) mouse pointers, which are 
clear and sharply defined mouse pointers to assist you with magnified screen 
viewing. When enabled, you can select additional pointer shapes and styles 
using the Pointer Set list box. 

Pointer Set 

Use this list box to select one of the following HD mouse pointer styles: 
Standard pointers, Aero-like pointers based on the Windows Aero theme, or 
bold outline pointers. Note that this list box is unavailable when the Use HD 
Pointers check box is cleared. 
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Body Color 

Select a color for your mouse pointer in the Body Color list. To use the original 
system colors, choose "Original." To invert the brightness or colors of screen 
areas covered by the mouse pointer, choose "Invert Brightness" or "Invert 
Colors." 

To choose from additional colors, activate the Define Custom Color button 
and choose one of the available colors from the palette. If you want to use a 
color that is not included on the palette, refer to the help topic Defining Custom 
Colors. 

Border Color 

Select a color for the border of the mouse pointer in the Border Color list. To 
use the original system colors, choose "Original." To invert the brightness or 
colors, choose "Invert Brightness" or "Invert Colors." 

To choose from additional colors, activate the Define Custom Color button 
and choose one of the available colors from the palette. If you want to use a 
color that is not included on the palette, refer to the help topic Defining Custom 
Colors. 

Size 

Use the Size slider to increase or decrease the proportions of the mouse 
pointer. Values range from 0.5x to 4x in 0.5x step increments. The default is 1x. 

Transparency 

Use the Transparency slider to adjust the transparency level of the mouse 
pointer. A higher level of transparency allows you to see text and images 
beneath the area covered by the mouse pointer. 

Mouse Enhancement Attributes 

Enhancements are used to further modify the mouse pointer by making it 
easier to locate and maneuver on the screen. 

Style 

In the Style list, choose one of the following enhancement types to apply to 
your mouse pointer: 
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 Short Crosshair - Displays intersecting horizontal and vertical bars that 
are centered on your mouse pointer. You can adjust the size of these 
bars by using the Length and Height sliders.  

 Long Crosshair - This style is similar to short crosshair, but the 
horizontal and vertical bars extend to the edges of the view.  

 Oval - Displays an oval around the mouse pointer. You can adjust the 
size of the oval by using the Length and Height sliders.  

 Box - Displays a box around the mouse pointer. You can adjust the size 
of the box by using the Length and Height sliders.  

 Oval Scope - Combines the short crosshair and oval styles.  

 Box Scope - Combines the short crosshair and box styles.  

 Long Box Scope - Combines the long crosshair and box styles.  

 Long Oval Scope - Combines the long crosshair and oval styles.  

Color 

In the Color list, choose a color for the enhancement style you selected. To 
invert the brightness or colors of screen areas covered by the enhancement, 
choose "Invert Brightness" or "Invert Colors." To choose from additional colors, 
activate the Define Custom Color button and choose one of the available 
colors from the palette. If you want to use a color that is not included on the 
palette, refer to the help topic Defining Custom Colors. 

Display 

In the Display list, choose when MAGic should apply enhancements to the 
mouse pointer: 

 Always - The mouse enhancements are always active and visible on the 
screen.  

 Mouse Moving - The enhancements are only visible when the mouse 
pointer is moving.  

 Mouse Not Moving - The enhancements are only visible when the 
mouse pointer is stationary.  

 When MAGic Key is Pressed - The enhancements only appear when 
you press the MAGic Key.  
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Transparency 

Use the Transparency slider to adjust the transparency level of the mouse 
enhancement. A higher level of transparency allows you to see text and images 
beneath areas covered by the enhancements. 

Thickness 

Use the Thickness slider to adjust the thickness of the lines of the 
enhancement style you selected. Increased thickness makes the 
enhancements easier to see and causes them to stand out more. Decreased 
thickness causes the enhancements to appear more subdued and lets you see 
more of the screen. 

Length and Height 

Use the Length and Height sliders to adjust the size of the mouse 
enhancement style you selected. If you selected the oval, box, long oval scope, 
or long box scope style, these sliders let you control the width and height of the 
oval or box. If you selected the short crosshair style, these sliders let you 
change the length and height of the horizontal and vertical bars. 

Saving a Scheme 

Changes made to these settings can be saved as a scheme. A scheme is a 
group of settings that can be used in certain applications or circumstances. 
Schemes allow you to quickly switch between different configurations of 
mouse, cursor, or color enhancements, according to your current needs. See 
Using Schemes for more about creating and modifying schemes. 

Changing the Cursor 

To help the cursor standout against text and your document’s background, 
Cursor Enhancements can be turned on. This makes it easier to locate and 
follow the cursor when editing or writing text.  

 

Click the top half of the Enhancements button to turn this feature 
on or off.  
 
Click the lower half of the button to quickly switch between built-
in schemes and custom schemes that you have created. 
Customizations can be made through Settings at the bottom of 
the schemes list. 
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Hot Keys 

Toggle Cursor Enhancements MAGic Key+F8 

Settings 

When you select Settings, the Cursor Enhancements appear. You can 
customize the appearance of your cursor for both magnified and unmagnified 
areas of the screen. To modify settings, use the options available in the 
Magnified Area and Unmagnified Area tabs.  

The Cursor Schemes tab lets you save your cursor enhancements settings as 
a scheme or switch to a different scheme. For more information on schemes, 
refer to Using Schemes. 

Select the Enable Cursor Enhancements check box on any tab in this dialog 
box to apply enhancements to your cursor. Clear this check box to disable the 
cursor enhancements.  
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Cursor Attributes 

In the Color list, choose a new color for the flashing cursor that appears when 
you are typing text into an edit box, document, and so on. To use the original 
system color for the cursor, choose "Original." To choose from additional 
colors, activate the Define Custom Color button and choose one of the 
available colors from the palette. If you want to use a color that is not included 
on the palette, refer to Defining Custom Colors. 

Sample Cursor Enhancement 

This area allows you to preview your cursor enhancement settings. MAGic 
displays a sample of you current cursor enhancements using the text in this 
area. This lets you adjust the enhancements to achieve the desired effect 
before applying them.  

Cursor Enhancement Attributes 

The Cursor Enhancement Attributes area allows you to choose a cursor 
enhancement style. You can also adjust the appearance and size of the 
enhancement and when it displays on your screen.  

Style 

In the Style list, choose one of the following enhancement styles: 

 None - The cursor appears as a blinking vertical bar, with no additional 
enhancements.  

 Oval - A small area around the cursor is surrounded by an oval.  

 Triangle - Two small triangles appear above and below the current 
position of the cursor.  

 Box - The immediate area around the cursor is surrounded by a small 
rectangle.  

 Line - Perpendicular lines appear beneath the text and a small vertical 
line indicates the exact position of the cursor.  

Color 

In the Color list, choose a color for the enhancement style you selected. To 
invert the brightness or colors of screen areas covered by the enhancement, 
choose "Invert Brightness" or "Invert Colors." To choose from additional colors, 
activate the Define Custom Color button and choose one of the available 
colors from the palette. If you want to use a color that is not included on the 
palette, refer to Defining Custom Colors. 
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Display 

In the Display list, choose when MAGic should apply enhancements to the 
cursor: 

 Always - The cursor enhancements are always active and visible on the 
screen.  

 Cursor Moving - The enhancements are only visible when the cursor is 
moving, such as when you are typing text or using the arrow keys.  

 Cursor Not Moving - The enhancements are only visible when the 
cursor is stationary.  

 When MAGic Key is Pressed - The enhancements only appear when 
you press the MAGic Key.  

Transparency 

Use the Transparency slider to adjust the transparency level of the cursor 
enhancement. This is useful if your cursor enhancement frequently obscures 
the surrounding text. Higher levels of transparency allow you to see text and 
images beneath the enhancement. 

Thickness 

Use the Thickness slider to adjust the thickness of the cursor enhancement. 
Thicker cursor enhancements are easier to see and stand out more. Thinner 
cursor enhancements are more subdued and let you see more of the text. 

Length 

Use the Length slider to adjust the horizontal size of the cursor enhancement 
style. This affects how much text is included within the oval, box, and line 
enhancements. 

Height 

Use the Height slider to adjust the vertical size of the cursor enhancement 
style. This affects the height of the oval and box enhancements and increases 
the length of the vertical portion of the line enhancement.  
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Saving a Scheme 

Changes made to these settings can be saved as a scheme. A scheme is a 
group of settings that can be used in certain applications or circumstances. 
Schemes allow you to quickly switch between different configurations of 
mouse, cursor, or color enhancements, according to your current needs. See 
Using Schemes for more about creating and modifying schemes. 

Using Schemes 

The Mouse Schemes, Cursor Schemes, and Color Schemes tabs all let you 
create schemes. A scheme is a group of settings that can be saved and used in 
certain applications or circumstances.  

Schemes allow you to quickly switch between different configurations of 
mouse, cursor, or color enhancements, according to your current needs. For 
example, you can create a mouse enhancement scheme specifically for 
proofreading documents and another scheme for browsing Web pages. Below 
is an example of the Mouse Schemes settings in the Mouse Enhancements 
dialog box.  
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 The currently selected scheme is displayed in the Scheme list. To switch to a 
different scheme, choose a new scheme from the list and then click Apply or 
press ALT+A. If you select the Automatically Apply Schemes check box, 
MAGic applies the new enhancement settings as soon as you select a scheme. 

Tip: You can also select a scheme directly from the MAGic user 
interface. To do this, click the lower half of the Mouse 
Enhancements, Cursor Enhancements, or Color 
Enhancements buttons and then choose a scheme from the list. 

The Magnified Area Description and Unmagnified Area Description boxes 
show the current enhancement settings for the magnified area and the 
unmagnified area. If you modify any of these settings, the description changes 
accordingly.  
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Creating New Schemes 

To create a new scheme, do the following: 

1. Use the Magnified Area and Unmagnified Area tabs to define 
enhancement settings for the magnified and unmagnified areas.  

2. On the Mouse Schemes, Cursor Schemes, or Color Enhancement 
Schemes tab, click Save As or press ALT+S to create a new scheme 
based on your current settings.  

3. Enter a name for the scheme and then press ENTER. The new scheme 
appears in the Scheme list.  

Modifying Schemes 

To modify an existing scheme, do the following: 

1. Select the scheme you want to modify in the Scheme list.  

2. Change the enhancement settings for the magnified and unmagnified 
areas.  

3. On the Mouse Schemes, Cursor Schemes, or Color Enhancement 
Schemes tab, click Save As or press ALT+S.  

4. The name of the currently selected scheme displays in the Save Scheme 
dialog box. Press ENTER to save your modifications.  

Deleting Schemes 

To delete a scheme, do the following: 

1. Select the scheme you want to delete in the Scheme list.  

2. Click Delete or press ALT+D to delete the currently selected scheme.  

Transferring Schemes 

Changes to your mouse, cursor, and color schemes are saved to MAGic’s 
scheme.ini file. If you want to use your customized schemes on a different 
computer, copy the INI file to a USB Flash drive and transfer it to the other 
computer. Once the file is transferred, the new schemes can be selected when 
you click the lower half of any Enhancements button. 

The scheme.ini file is in the "Explore My Settings" folder on each computer. 
The location of the folder varies depending on your operating system as 
described below. 
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Windows 8.1 

Start screen > type “utilities MAGic” without the quotes > Explore My 
Settings 

Windows 7 

Start button > All Programs > MAGic (version number) >  
Explore MAGic > Explore My Settings 

Restoring Factory Schemes 

Click Restore Factory Schemes or press ALT+R to revert to the original 
Factory Settings scheme included with MAGic. Schemes that you or other 
users have created remain unchanged. 

Tracking Cursor and Mouse Movement 

Tracking allows MAGic to follow your activity on the screen. For example, 
MAGic can track your mouse pointer so that it always remains in the center of 
the magnified area.  

To change how MAGic tracks the cursor and mouse pointer, as well as menus, 
dialog boxes, and highlighted text, choose the Main menu, and then Visual 
followed by Tracking. 

 

Mouse 

To control how MAGic tracks your mouse pointer, select one of the following 
radio buttons: 
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 Edge – MAGic follows your mouse pointer only when it reaches the edge 
of the magnified area.  

 Center – MAGic continuously follows your mouse pointer, ensuring that it 
is always in the center of the magnified area.  

Cursor 

To control how MAGic tracks the cursor when you are typing text, select one of 
the following radio buttons: 

 Edge – MAGic follows your cursor only when it reaches the edge of the 
magnified area.  

 Center – MAGic continuously follows your cursor, ensuring that it is 
always in the center of the magnified area.  

Dialogs and Menus 

The Dialogs and Menus area lets you control how MAGic follows your 
movement through dialog boxes and menus. Select one of the following radio 
buttons: 

 Edge – MAGic automatically moves the magnified area when you reach 
the edge of the screen while moving through dialog boxes and menus.  

 Center – MAGic continuously tracks the active dialog box option or menu 
command, ensuring that it is always in the center of the magnified area.  

Document Reading 

To control how MAGic tracks highlighted text during document reading, select 
one of the following radio buttons: 

 Edge – MAGic automatically moves the magnified area when the 
highlight reaches the edge of the screen.  

 Center – MAGic continuously tracks the highlight, ensuring that 
highlighted text always remains in the center of the magnified area.  

Auto Switch 

If you select this check box, mouse tracking is temporarily stopped after you 
stop moving the mouse. The screen remains stationary as long as you keep the 
mouse pointer within the boundary of the screen. When you move beyond the 
edge of the screen, tracking starts again. Auto switch is useful when you want 
to move the mouse toward stationary objects on the screen. 
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Tether to Display 

If you select this check box, the mouse pointer is "tethered," or attached, to the 
magnified display. As soon as you move the mouse, the mouse pointer 
automatically appears at the current magnified location, even if it was not 
visible on the screen. If you do not select this check box, MAGic moves to the 
current location of the mouse pointer when you move the mouse. 

Tip: You can press CTRL+INSERT+NUM PAD MINUS to enable or 
disable this option at any time. 

Mouse Line Lock  

If you select this check box, you can only move the mouse pointer in horizontal 
and vertical directions. If you move the mouse in a diagonal direction, MAGic 
moves the mouse pointer in the closest direction.  

Track Carets and Cursors  

Select this check box if you want MAGic to track your cursor. 

Text Smoothing 

Text smoothing compensates for the stair-step effect that occurs as screen 
objects become blocky and pixelated when magnification is increased. By 
default, MAGic uses normal smoothing for Windows 8.1 or later, and high-
definition text smoothing for Windows 7. Note that text smoothing settings will 
differ based on your computer's operating system as described below. 

Windows 8.1 or Later 

When you enable text smoothing in Windows 8.1 or later, you can apply an 
extra visual boost, known as a smoothing effect. These different effects 
produce a better rendering of solid colors to enhance the edges of letters, 
making text easier to read, along with sharpening the edges of other objects, 
such as Start screen tiles, in the magnified area of the screen. 

Because everyone has different vision needs, MAGic offers several smoothing 
effects. You are encouraged to try each style and choose the one that works 
best for you. Keep in mind that your favorite may not be the best for another 
MAGic user. This is especially true when MAGic is used in a shared 
environment such as a public computer in an office or library. 



60 

To change text smoothing settings, do the following: 

1. From the Main menu, choose Visual and then Display.  

 

2. Select Enabled (default) or Disabled in the Text Smoothing box to toggle 
smoothing on or off. When enabled, the Smoothing Effect box is 
available.  

3. Select an item in the Smoothing Effect box to blur or enhance the edges 
of magnified objects. Experiment with the different styles described below 
to find the one that works best for you.  

 None: Turns off smoothing effects. This is the default setting.  

 Styles 1 and 2: Reduces screen noise by softening the edges of 
objects and text in the magnified area of the screen.  
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 Styles 3 and 4: Brightens or darkens contrast to enhance and 
sharpen the edges of objects and text in the magnified area of the 
screen.  

4. Smoothing changes take effect immediately. To close the dialog box, 
choose OK.  

5. To retain the smoothing style so that it is used the next time MAGic starts, 
press CTRL+S.  

Windows 7 

To change text smoothing settings, do the following: 

1. From the Main menu, choose Visual and then Display.  

 

2. In the Text Smoothing box, select one of the following:  

 HD Text: Displays the clearest and sharpest magnification of text 
and images on your screen. HD Text takes advantage of the True 
Type fonts installed on your computer to render the best possible 
image. This is the default setting.  

 Classic: Use if you notice slower performance on your computer 
when using HD Text.  

 None: Turns off text smoothing.  

Note: In addition to selecting an item from the Text Smoothing list, you 
can press MAGic Key+CTRL+F to cycle through the smoothing 
settings. 
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3. Choose OK to close the dialog box. To permanently save changes, press 
CTRL+S. 

Focus Enhancements 

Use Focus Enhancements to place a colored rectangular border around the 
item that currently has focus, such as menus, buttons or other controls. This 
assists you in locating and tracking the system focus.    

 

Click the top half of the Enhancements button to turn this feature 
on or off.  
 
Click the lower half of the button to select Settings to customize 
or create a new scheme.  

Hot Keys 

Toggle Focus Enhancement MAGic Key+F 

Settings 

When using Windows Vista or later, the colors of the user interface can appear 
muted and difficult to distinguish. The Focus Enhancement function lets you 
define a visible rectangular border that identifies and tracks the item that is 
currently selected on the screen. As you select different items, using either the 
mouse or keyboard, the rectangular border moves its focus to that place on the 
screen.  
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Enable Focus Enhancement 

When selected, Focus Enhancement is on. When unchecked, Focus 
Enhancement is off.  

Enhancement Attributes 

Color 

Select a color for the rectangular border.  

Define Custom Color 

Create a custom color for the rectangular border.  

Transparency 

Use the Transparency slider to adjust the border's transparency level.  

Thickness 

Use the Thickness slider to adjust the border's thickness. Thicker borders are 
easier to see and stand out more. Thinner borders are more subdued. 
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Spacing 

Use the Spacing slider to adjust the amount of space between the rectangular 
border and the selected item. Move the slider to the right to increase the 
amount of space between the item and the border. Move the slider to the left to 
decrease the amount of space between the item and the border.  

Exploring the Screen 

MAGic automatically tracks the focus as it moves to different controls or text on 
the screen, but many times you will want to manually explore the screen. One 
method is to simply move the mouse in the direction you wish to explore. 
MAGic will automatically follow the mouse as it moves around the screen. You 
can also use the panning features built into MAGic to explore.  

Panning moves your display either horizontally or vertically, so you can browse 
the screen, locate objects, and read magnified text easier. With magnification 
set at 2x or higher, you can pan automatically or incrementally. The advantage 
of automatic panning is that you can review the contents of the screen without 
using repetitive mouse movements. While incremental panning is similar to 
automatic panning, it is different in that your viewing area moves in small, fixed 
increments making it easier for you to explore your focal area. 

Automatic Panning  

Begin automatic panning in any direction by pressing the MAGic Key in 
conjunction with any arrow key. Panning then begins in that direction, and 
continues until you stop it, or until it reaches the edge of the screen.  

Note: If you disable line wrap in the Panning dialog box, then panning 
will stop at the right edge of the screen when panning from left to 
right.  

Use the following hot keys to pan in a specific direction.  

Pan Right MAGic Key+RIGHT ARROW 

Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 
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Stop Panning 

To stop panning, press the MAGic Key or the ESC key. You can also use the 
arrow key that corresponds with the direction in which you are currently 
panning. 

Panning Quick Advance 

Pressing MAGic Key+ENTER while panning right, scrolls the view to the 
beginning of the next line, pauses, and then continues to the right. 

Panning Speed 

Adjust panning speed during panning, or through the Panning dialog box. While 
panning, press NUM PAD PLUS to speed up, and NUM PAD MINUS to slow 
down.  

Adjustments made to panning speeds while panning are automatically saved 
for future panning sessions. There are independent settings for left to right 
(forward), right to left (Reverse), and Up/Down (vertical) panning. Vertical 
settings apply to both panning up and panning down. 

Quick Jump to Screen Edge 

Use the following hot keys to quickly jump to a screen edge. 

Move to Left Edge of Screen MAGic Key+HOME 

Move to Right Edge of Screen MAGic Key+END 

Move to Top of Screen MAGic Key+PAGE UP 

Move to Bottom of Screen MAGic Key+PAGE DOWN 

Panning Settings 

From the Main menu, choose Visual, and then Panning to specify panning 
properties. 
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Speed 

Panning speed is set independently for each panning direction: forward, 
reverse, or vertically. Panning speed values are between 1 and 12. You might 
want to select different speeds for different directions. As you read, you are 
panning forward, which might require a higher panning speed, than reverse. As 
you move in the reverse direction you are probably looking for something, so 
you would want to go slower. You may also want to set vertical panning a bit 
faster, because you will use vertical panning for skimming documents or Web 
sites.  

Line Wrap 

Select Line Wrap if you want MAGic to automatically wrap to the next line when 
you reach the right edge of the screen while panning. The edit spin boxes, 
below the Line Wrap check box, allow you to control the line wrap settings.  

Point Size 

You can adjust the vertical distance that MAGic travels between successive 
lines with the line wraps. Point size should correspond to your unmagnified font 
size. The default setting is 10 points. 

Line Delay 

Line delay controls the length of the delay while panning between lines. The 
line delay settings are in tenths of a second. The default setting is 10 (or one 
second). 
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Incremental Panning 

Before you can use the Incremental Panning feature you must assign hot keys 
for each incremental direction.  

1. Open Keyboard Manager.  

2. From the Category list, select Panning.  

3. In the Action list, select the incremental direction you want to assign a hot 
key to (for example, PanDownIncrement) and then choose Assign Hot 
Key.  

4. Within the Assign Hot Key dialog box type the hot key you want to use, 
then press ENTER. Note that a message displays if that hot key is 
currently assigned to a MAGic action.  

5. Repeat steps 3 and 4 to create more incremental panning hot keys.  

6. When you are done assigning hot keys, choose OK to exit the Keyboard 
Manager.  

Locator 

The Locator is a small window that opens on your screen that shows the area 
that is currently magnified. Use it to help you find where you are on the screen, 
as well as to quickly move to another portion of the screen.  

When you activate the Locator, the full screen is temporarily displayed 
unmagnified and a box with inverted colors appears over the screen area you 
were viewing when magnified. You also have options to display the locator as a 
magnifying lens to help you locate and move to screen areas of interest.  

Activating the Locator 

Press MAGic Key+F10 to turn the Locator on or off.  

After you have located the item, press ENTER or the left mouse button to move 
the magnified area to that portion of the screen. 

Alternatively, you can press ESC to exit the Locator without moving the 
magnified area. 

Moving the Locator 

Move the Locator around your screen using the mouse or the arrow keys.  

 Press PAGE UP to move to the top of the screen  
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 Press PAGE DOWN to go to the bottom of the screen  

 Press HOME to go to the far left side of the screen  

 Press END to go to the far right side of the screen  

Selecting Styles 

To select a style and border color for the Locator, choose the Main menu, and 
then Visual followed by Locator.  

 

Style 

Choose from three different styles for your locator: 

 Full Cross – Shows a portion of the screen in reversed colors. In 3x 
magnification or higher, the Locator appears with crosshairs running 
through the center of the block. With magnification set to 2x, the Locator 
appears as a block of inversed colors.  

 Eyeglass – Shows a square on the screen that is magnified while the 
rest of the screen is normal size.  

 Reverse Eyeglass – Shows a square on the screen that is magnified 
while the rest of the screen is normal size. Colors within the magnified 
square are reversed.  

Color 

Specify what color border you want to appear around your Locator. The 
customizable border only applies to the Eyeglass and the Reverse Eyeglass 
Locator styles.  
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Hot Keys  

Enable Locator Mode MAGic Key+F10 

Disable Locator and Return 
to Previous Location 

ESC 

Disable Locator and Magnify 
Current Location 

ENTER 

Transition Animation 

Transition Animation produces a fluid panning motion when focus moves from 
one part of the magnified screen to another. It also achieves a smooth zooming 
effect when increasing or decreasing magnification. This type of continuous 
movement eliminates any disorientation that may occur by an abrupt jump or 
zoom to a new area on the screen.  

There are three types of animation: magnification, focus, and Say All. You can 
make independent adjustments to any animation speed, or disable any 
animation using sliders in the Display dialog box. Transition Animation is 
available only for Windows 8.1 or later. 



70 

To change animation settings, do the following:  

1. From the Main menu, choose Visual and then Display.  

 

2. Make sure Enabled is selected in the Transition Animation group. 

When on, the duration settings are available. When off, all magnification 
and panning movements have a jump effect on the screen.  

3. Move the sliders to change the timing of the animations. You can also 
disable a specific animation by moving the slider to the far left. 
Experiment with the different durations as described below to set what 
works best for you.  

 Magnification Duration: Adjusts animation time when changing 
magnification levels. The default is 0.5 seconds and can be 
adjusted in 0.125 second increments. To disable animation, move 
the slider to the far left.  
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 Focus Duration: Adjusts the time it takes to move to a new focus 
location. The default is 1 second and can be adjusted in 0.25 
second increments. Slowing the animation speed is helpful at 
higher magnification levels. Increasing the animation speed is 
helpful at lower magnification levels. To disable animation, move 
the slider to the far left.  

 Say All Duration: Adjusts animation time when the spotlight moves 
to a new screen position when reading with Say All. To disable 
animation, move the slider to the far left.  

4. Transition Animation changes take effect immediately. To close the dialog 
box, choose OK.  

5. To retain the durations so that they are used the next time MAGic starts, 
press CTRL+S. 

Using Multiple Monitors 

Multi-Monitor Configuration 

This topic describes how to set up your Windows display settings and to 
manually enable and disable multiple monitors in MAGic.  

System Requirements 

The following hardware and software is required for Multi-Monitor operation: 

 A computer and video card that supports dual monitors  

 Two computer monitors  

 Windows 7 or later  

Note: If using an HDTV as a computer monitor, use the VGA or HDMI 
connector on the TV. Both 720p and 1080p are supported. 

Windows Configuration 

Before using the Multi-Monitor feature in MAGic, you must connect a second 
monitor to your computer, and configure Windows for multiple monitor 
operation. These procedures will vary based on your operating system. 

Note: Each monitor can use a different screen resolution. This provides 
greater flexibility between laptop and desktop monitors. 
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1. Press WINDOWS Key+M to minimize all open applications, and move 
focus to the Windows Desktop.  

Note: Focus must be on the Windows Desktop. If you see or hear that 
an icon on the desktop is selected, press CTRL+SPACEBAR to 
unselect it. 

2. Press the APPLICATION Key , and select Screen Resolution.  
(If the Windows 8.1 Start Screen is displayed, press the WINDOWS Key 
to jump to the Windows Desktop.)  

3. Select the extended display, and verify the following below. Note that the 
primary display is typically labeled as 1, and the extended display is 
labeled as 2.  

 The orientation is the same as the primary display  

 The color quality (depth) is the same as the primary display. The 
recommended color setting is 32-bit color. To locate the color 
settings, select Advanced Settings, Monitor tab, and then the Colors 
combo box for color settings.  

 The Multiple Displays combo box is set to "Extend these Displays"  

4. Choose OK to save changes.  

Switching Between Multi-Monitor and Single Monitor Modes 

MAGic always checks to see if two monitors are connected to your computer. If 
not, MAGic automatically reverts to single-monitor mode without requiring a 
computer reboot. This is useful when traveling with a laptop computer. 

When you have two or more monitors configured as an extended display in 
Windows, MAGic automatically switches to Multi-Monitor view. If your system 
reverts back to using a single monitor, MAGic detects the change and 
automatically switches back to your previous view, for example, Full, Split, or 
other magnified views.  

This functionality is ideal for laptop users who use a docking station with two or 
more monitors at work, but then use only the laptop monitor when they are on 
the road. The user does not have to change any MAGic settings to have this 
automatic change functionality. 
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Enabling and Disabling Multi-Monitor Support in MAGic 

When you have multiple monitors connected to your computer, it is still possible 
to run MAGic in single monitor mode. This allows you to use MAGic and its 
enhancements on one monitor, while another monitor works independently of 
MAGic.  

For example, if you have a program that supplies its own magnification, such 
as a CAD drawing program, you can place that application in the unmagnified 
monitor. This allows the application to not be magnified by MAGic, but still lets 
you use that program’s own magnification functionality to zoom in and out on 
the displayed drawings. 

To disable or enable Multi-Monitor Mode, do the following: 

1. From the Main menu, choose Visual and then Multi-Monitor.  
 
By default, "Enable Multi-Monitor" is selected. 

 

2. Click this menu item, and MAGic switches to single monitor mode and 
uses your previous magnification view, for example, Full or Split. 

3. To return to Multi-Monitor Mode, repeat steps 1 and 2.  

Multi-Monitor Independent Mode 

In Independent mode, both monitors are magnified, and each can operate 
independently. For example, you can have a spreadsheet open on one monitor 
while editing a document on the other monitor.  
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To move the mouse pointer between monitors, press MAGic Key+SHIFT+D. 
When switching between monitors, the cursor will return to its previous location 
in the open document. You can also drag the mouse pointer left, right, up, or 
down (depending on the monitor configuration) to jump to the other monitor. 
 
In Independent mode, WINDOWS Key+SHIFT+RIGHT ARROW and 
WINDOWS Key+SHIFT+LEFT ARROW allow you to move the current 
application window between monitors while maintaining mouse pointer and 
cursor location. 

To change Independent mode settings, do the following:  

1. Click the Magnification View list button, and then Settings to display the 
Multi-Monitor settings.  
 

 

2. Make sure Magnified Mode is set to Independent. This is the default 
setting.  
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3. To prevent the mouse pointer from accidentally moving to the other 
monitor, do the following.  

 Select the Restrict Mouse to Active Monitor check box.  

 Select the Switch After Waiting check box and then specify in 
seconds how long the mouse pointer must stay at the edge of the 
screen before it moves to the next screen.  

 Select the Switch on Double Tap Within check box and then 
specify in seconds the time required to perform the double tap 
before the pointer moves to the other monitor. If the double tap 
occurs outside of this period, the pointer does not move to the other 
monitor. (If you are using a touchpad, the double tap is a right-left-
right or left-right-left sliding motion. Use an up-down-up or down-up-
down sliding motion for vertically arranged monitors.)  

 Use the Sound When Reaching Monitor Edge combo box to 
select a WAV file to play that indicates that the mouse pointer is at 
the edge of the screen.  
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 Use the Sound When Switching Monitors combo box to select a 
WAV file to play that indicates when the mouse pointer has moved 
to the other monitor.  

4. Select OK to save changes, and close the Multi-Monitor Settings dialog 
box.  

5. To save Multi-Monitor mode so that it is on when you restart MAGic in the 
future, choose Save Default Settings from the File menu.  

Hot Keys 

Use to quickly switch focus from one 
monitor to the other. This eliminates the 
need to drag the mouse between monitors. 

MAGic Key+SHIFT+D 

Use to restrict the mouse pointer to the 
active monitor. MAGic Key+SHIFT+R 

Use to move the current application or 
window in focus to the monitor on the right 
or the left. This eliminates the need to click 
and drag an application window from one 
monitor to the other. 

WINDOWS 
Key+SHIFT+RIGHT ARROW 
or  
WINDOWS 
Key+SHIFT+LEFT ARROW 

Press and hold while dragging the mouse to 
smoothly move the mouse pointer between 
screens without scrolling any screen 
content. This is the View Lock feature. To 
resume normal operation, release MAGic 
Key+SHIFT. 

MAGic Key+SHIFT 
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Settings 

Restrict Mouse to Active Monitor 

Select this check box to limit mouse pointer movement to the active monitor. 
This stops you from accidentally moving the pointer between monitors. When 
selected, use any of the following methods to move the mouse pointer between 
monitors: (1) hold the mouse pointer against the edge of the active monitor’s 
screen for a specified number of seconds; (2) double tap the mouse pointer 
against the edge of the active monitor’s screen within a specified time period; 
(3) hold down MAGic Key+SHIFT while dragging the mouse pointer across the 
active monitor to the other monitor; or (4) press MAGic Key+SHIFT+R. This 
check box is not available for Overview mode. 

Switch After Waiting (seconds) 

Select this check box so that the mouse pointer waits at the edge of the active 
monitor’s screen for the specified number of seconds before moving to the 
other monitor. In the Switch After Waiting box, enter the amount of time you 
want the mouse pointer to stay at the edge of the monitor’s screen before 
moving to the other monitor. Values range from 0.1 second to 3 seconds. This 
check box is not available for Overview mode. 

Switch on Double Tap Within (seconds) 

Select to have the mouse pointer move between monitors after tapping the 
mouse pointer twice against the edge of the active screen. The double tap must 
occur within the specified number of seconds. In the Switch on Double Tap 
Within box, enter the time span required to perform the double tap before the 
mouse pointer moves to the other monitor. If the double tap occurs outside of 
this period, the pointer will not move to the other monitor.  Select a value from 
0.1 second to 3 seconds. This check box is not available for Overview mode. 

Important Note for Laptop Users 

When using the touchpad on your laptop, do the following to “double tap” and 
move the mouse pointer between monitors. 

To move from the left monitor to the right monitor: 

 Press and hold your finger on the touchpad.  

 Slide your finger right, left, and right again.  
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To move from the right monitor to the left monitor: 

 Press and hold your finger on the touchpad.  

 Slide your finger left, right, and left again.  

If your monitors are arranged vertically, use an up-down-up motion or down-up-
down motion. 

Sound When Reaching Monitor Edge 

Select a WAV file sound to indicate when the mouse pointer has reached the 
edge of the active monitor. This check box is not available for Overview mode. 

Sound When Switching Monitors 

Select a WAV file sound to indicate that the mouse pointer has successfully 
moved from one monitor to the other monitor. This check box is not available 
for Overview mode. 

Using View Lock 

Use the View Lock feature to freely move the mouse pointer across screens 
without moving any objects on the desktop. Press and hold MAGic Key+SHIFT 
while moving the mouse pointer across the screen. This provides a smooth 
transition from one monitor to the other without shifting the view on the screen. 
Normal mouse pointer movement resumes when you release MAGic 
Key+SHIFT. This feature is useful when you are moving back and forth 
between two monitors and you want to keep the screen views locked. 

FAQs 

Moving the mouse cursor between monitors is difficult since the application 
scrolls until the mouse reaches the edge. It would be better if I could just jump 
to the other screen without either monitor scrolling. 

Answer: Press MAGic Key+SHIFT+D to quickly jump from one monitor to the 
other. This is easier and faster since you do not have to drag and lift the mouse 
(or your finger on a touchpad) several times to travel the same desktop area.  

Double tapping my touchpad does not move the mouse pointer between 
monitors. 
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Answer: To double tap with a touchpad, press and hold your finger on the 
touchpad, and then slide it to the right, left, and right to move from the left 
monitor to the right monitor. Slide your finger left, right, and left to move from 
the right monitor to the left monitor. If your monitors are arranged vertically, use 
an up-down-up motion or down-up-down motion. 

A message displays stating that the color depth is not the same. 

Answer: Open the display settings in Windows and make sure that the color 
depth on both displays is the same. The recommended setting is 32-bit color. 

Multi-Monitor Overview Mode 

In Overview mode, the same screen and desktop appears on both monitors; 
however, one monitor is magnified and the other is not. Press MAGic 
Key+SHIFT+D to switch the magnified and unmagnified views between 
monitors. Note that if you switch from Independent mode, where both monitors 
are magnified, to Overview mode, all desktop and taskbar icons are 
consolidated to the primary monitor. 

To change Overview mode settings, do the following:  

1. Click the Magnification View list button, and then Settings to display the 
Multi-Monitor settings.  

 
 
The Multi-Monitor settings appear.  

2. Change Magnified Mode to Overview.  
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3. In the Unmagnified Display combo box (in the Overview Mode Settings 
group), select the monitor that will not be magnified. This combo box is 
not available for Independent mode.  

In Overview mode, you also have the following options. 

 Select the Show Enhancements in Unmagnified View check box 
to allow mouse, cursor, color, and focus enhancements to be used 
on the unmagnified monitor. When cleared, enhancements are only 
visible on the magnified monitor. You can also press MAGic 
Key+SPACEBAR followed by D and then E to toggle 
enhancements on or off on the unmagnified monitor.  

 Select the Show Mouse in Unmagnified View check box to allow 
the mouse pointer to be visible on the unmagnified monitor. When 
cleared, the mouse pointer is only visible on the magnified monitor.  

4. Select OK to save changes, and close the Multi-Monitor Settings dialog 
box.  

5. To save Multi-Monitor mode so that it is on when you restart MAGic in the 
future, choose Save Default Settings from the File menu.  
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Hot Keys 

Use to quickly switch focus from one 
monitor to the other. This eliminates the 
need to drag the mouse between monitors. 

MAGic Key+SHIFT+D 

Use to restrict the mouse pointer to the 
active monitor. 

MAGic Key+SHIFT+R 

Use to move the current application or 
window in focus to the monitor on the right 
or the left. This eliminates the need to click 
and drag an application window from one 
monitor to the other. 

WINDOWS 
Key+SHIFT+RIGHT 
ARROW or  
WINDOWS 
Key+SHIFT+LEFT ARROW 

Press and hold while dragging the mouse 
to smoothly move the mouse pointer 
between screens without scrolling any 
screen content. This is the View Lock 
feature. To resume normal operation, 
release MAGic Key+SHIFT. 

MAGic Key+SHIFT 

In Overview mode, toggles mouse, cursor, 
color, and focus enhancements on and off 
on the unmagnified monitor. 

MAGic Key+SPACEBAR, 
followed by D and then E 

Settings 

Unmagnified Display 

Use this combo box to select which monitor will not be magnified when 
configured for Overview mode. The combo box is not available for Independent 
mode. 

Show Enhancements in Unmagnified View 

Select this check box to allow mouse, cursor, color, and focus enhancements 
to be used on the unmagnified monitor. When cleared, enhancements are only 
visible on the magnified monitor. You can also press and release MAGic 
Key+SPACEBAR followed by D and then E to toggle enhancements on and off 
on the unmagnified monitor. This check box is only available for Overview 
mode.  



82 

Show Mouse in Unmagnified View 

Select the check box to allow the mouse pointer to be visible on the 
unmagnified monitor. When cleared, the mouse pointer is only visible on the 
magnified monitor. This check box is only available for Overview mode.  

Using View Lock 

Use the View Lock feature to freely move the mouse pointer across screens 
without moving any objects on the desktop. Press and hold MAGic Key+SHIFT 
while moving the mouse pointer across the screen. This provides a smooth 
transition from one monitor to the other without shifting the view on the screen. 
Normal mouse pointer movement resumes when you release MAGic 
Key+SHIFT. This feature is useful when you are moving back and forth 
between two monitors and you want to keep the screen views locked. 

FAQs 

Moving the mouse cursor between monitors is difficult since the application 
scrolls until the mouse reaches the edge. It would be better if I could just jump 
to the other screen without either monitor scrolling. 

Answer: Press MAGic Key+SHIFT+D to quickly jump from one monitor to the 
other. This is easier and faster since you do not have to drag and lift the mouse 
(or your finger on a touchpad) several times to travel the same desktop area.  

Double tapping my touchpad does not move the mouse pointer between 
monitors. 

Answer: To double tap with a touchpad, press and hold your finger on the 
touchpad, and then slide it to the right, left, and right to move from the left 
monitor to the right monitor. Slide your finger left, right, and left to move from 
the right monitor to the left monitor. If your monitors are arranged vertically, use 
an up-down-up motion or down-up-down motion. 

A message displays stating that the color depth is not the same. 

Answer: Open the display settings in Windows and make sure that the color 
depth on both displays is the same. The recommended setting is 32-bit color. 
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Chapter 6 
Speech with MAGic 

Choosing Speech and Speech Rate 

MAGic can be purchased with or without the speech option. The speech option 
provides quick feedback to changes of focus, as well as reducing eye fatigue 
when reading documents, as you can rest your eyes and let MAGic read the 
document to you. If you purchased MAGic without speech, you can add this 
option by calling your local dealer or contacting Freedom Scientific. The topics 
in the “Speech with MAGic” and “Reading with MAGic” sections describe the 
MAGic speech functionality. 

When MAGic is first installed, speech is automatically on. This is known as Full 
Speech mode since MAGic announces all movement as you switch between 
documents and applications, characters as you type, or even point to text with 
the mouse pointer if mouse echo is enabled. MAGic can also run in Speech On 
Demand mode. This limits the amount of speech heard based on a subset of 
specific speech and reading commands. For more information, see Speech On 
Demand.  

Note that when running MAGic with JAWS for Windows screen reading 
software, the speech functions in MAGic are disabled because JAWS handles 
all speech operations. For more information, see MAGic and JAWS.  

 

Click this button to toggle between speech on all the time 
(full speech) or to have limited speech (Speech On 
Demand).  

 

Move the slider left or right to decrease or increase how 
fast MAGic speaks. Any changes made with the slider take 
effect immediately and are automatically saved.  
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Hot Keys 

Enable Full Speech or 
Enable Speech On 
Demand  

MAGic Key+F3 

Increase Speech Rate and 
Save New Rate 

WINDOWS 
Key+ALT+CTRL+PAGE UP 

Increase Speech Rate - 
Temporary  

ALT+CTRL+PAGE UP 

Increase and Save New 
Speech Rate During Say All 

PAGE UP 

Decrease Speech Rate and 
Save New Rate 

WINDOWS 
Key+ALT+CTRL+PAGE DOWN 

Decrease Speech Rate - 
Temporary 

ALT+CTRL+PAGE DOWN 

Decrease and Save New 
Speech Rate During Say All 

PAGE DOWN 

Speech On Demand Hot Keys 

See Speech On Demand for a list of the default actions and hot keys that are 
available when using Speech On Demand mode.  

Speech On Demand 

What is Speech On Demand? 

Using speech with MAGic can reduce eye fatigue by helping to focus and find 
your location on the screen. However, there are times when too much speech 
can be overwhelming, which is where Speech On Demand™ can be very 
helpful. Speech On Demand is a feature that allows you to limit the amount of 
speaking performed by MAGic as you navigate windows and documents or 
perform other actions using hot keys. In MAGic 12 or later, you can now switch 
between full speech and Speech On Demand mode.  
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Speech On Demand consists of three elements: designated unit commands, 
mouse echo, and typing echo. Unit commands consist of such actions as Say 
Word, Say Sentence, Say All, as well as adjusting reading rates. The Speech 
On Demand factory settings are for mouse echo to be on, and typing echo to 
be off. These settings can quickly be changed using the Mouse Echo and 
Typing Echo buttons in the Speech tab. As for unit commands, a list of factory 
actions and hot keys are provided below. Note that by using MAGic's Keyboard 
Manager, you can expand the number of actions and hot keys available for 
Speech On Demand.  

During initial product installation, you can determine if MAGic starts using full 
speech or Speech On Demand mode. This is done using the Speech Level 
setting in the Speech Settings page in the Startup Wizard.  

Switching to Speech On Demand Mode 

To switch from full speech to Speech On Demand mode, do the following. 

1. Click the Speech tab.  

2. Click the top half of the Speech button. MAGic announces "Speech On 
Demand."  
(By default, Mouse Echo, Voice Profiles, the Speech Rate slider, and a 
limited number of speech hot keys are available.) 

 

3. Speech is now muted with the following exceptions.  

 MAGic announces and performs the action associated with a 
Speech On Demand hot key.  

 MAGic reads text that you point to with the mouse pointer.  

To restore full speech, click the top half of the Speech button. MAGic 
announces "Full Speech." 

Changing Speech On Demand Settings 

Use the Speech On Demand settings to customize Speech On Demand, or 
disable all speech. To change settings for Speech On Demand, do the 
following. 
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1. Click the bottom half of the Speech button, and choose Settings. The 
Speech On Demand Settings dialog box opens.  

 

2. Select or clear any of the following check boxes:  

 Allow Designated Reading Commands: When selected, only the 
actions marked as Speech On Demand in the Keyboard Manager 
will be announced by MAGic when the action is performed. The 
designated reading commands enabled during Speech On Demand 
in MAGic are based on common "say unit" commands you would 
like to use when speech is "off"; for example Say Word, Say 
Sentence, and Say paragraph. Additionally, Say All is also available 
when in Speech On Demand mode. When cleared, no actions 
initiated with a hot key are announced.  

 Allow Mouse Echo: Select to turn on Mouse Echo. When selected, 
MAGic reads text that you point to with the mouse pointer. The 
factory setting is for this option to be off.  

 Allow Typing Echo: Select to turn on Typing Echo. When selected, 
MAGic repeats characters, words, or both as you type. The factory 
setting is for this option to be off.  

Note: If you prefer to use traditional functionality to switch between full 
speech and no speech (as available in MAGic 11 or earlier), then 
clear all check boxes to turn off all MAGic speech. Items in the 
Speech tab will be unavailable. 

3. Choose OK to save changes and close the dialog box.  

Designating an Action for Speech On Demand  

Besides the default speech actions, you can assign other actions to be 
available when using Speech On Demand. For example,  
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 When configured for full speech, pressing MAGic Key+F8 performs the 
action, and MAGic announces "Cursor Enhancements Enabled" or 
"Cursor Enhancements Disabled"  

 When configured for Speech On Demand, pressing the same hot key will 
perform the action, but MAGic will not announce, "Cursor Enhancements 
Enabled" or "Cursor Enhancements Disabled." This is because Cursor 
Enhancement Toggle is not a default Speech On Demand action.  

To designate an action for Speech On Demand, do the following: 

1. In the Tools tab, click the Keyboard button. The Keyboard Manager 
opens.  

2. In the Keyboard Manager dialog box, select an action in the Action list 
(for example, CursorEnhancementToggle).  

3. Select the Speech On Demand check box, which is located below the 
Action list.  

4. Click OK to save the change and close Keyboard Manager.  

5. The next time you press the hot key that is assigned to that action, MAGic 
will announce the action as it is performed (for example, "Cursor 
Enhancements Enabled").  

Default Actions and Hot Keys 

Below are the default actions and hot keys available when using Speech On 
Demand mode.  

Action Hot Key 

Say All From Location 

INSERT+DOWN ARROW or  
MAGic Key+A or  
MAGic Key+LEFT MOUSE 
BUTTON CLICK  

Say Character NUM PAD 5 

Say Word 
MAGic Key+ALT or  
INSERT+NUM PAD 5 

Say Line 
MAGic Key+L or  
INSERT+UP ARROW 
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Say to Cursor INSERT+HOME 

Say from Cursor INSERT+PAGE UP 

Say Sentence MAGic Key+S 

Say Paragraph MAGic Key+P 

Say Selected Text INSERT+SHIFT+DOWN ARROW 

Say Window Prompt and Text 
MAGic Key+TAB or  
INSERT+TAB 

Say Window Title 
MAGic Key+T or  
INSERT+T 

Say Bottom Line of Window INSERT+PAGE DOWN 

Increase Speech Rate and Save 
New Rate 

WINDOWS 
Key+ALT+CTRL+PAGE UP 

Increase Voice Rate - 
Temporary 

ALT+CTRL+PAGE UP 

Increase and Save New Speech 
Rate During Say All 

PAGE UP 

Decrease Speech Rate and 
Save New Rate 

WINDOWS 
Key+ALT+CTRL+PAGE DOWN 

Decrease Voice Rate - 
Temporary 

ALT+CTRL+PAGE DOWN 

Decrease and Save New 
Speech Rate During Say All 

PAGE DOWN 

Note: When using the document and text reading commands, if you 
move the mouse MAGic reads from the current location of the 
mouse pointer. If you move the insertion point, MAGic reads from 
the location of the insertion   
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Selecting a Voice Profile 

A voice profile consists of settings for the synthesizer, language, voice, and 
other speech items that define how MAGic speaks. Traditionally in MAGic, 
users have created specific language voice profiles, along with task specific 
profiles such as profiles for proofreading, pleasure reading, and speed reading. 
Beginning with MAGic 13, single profiles can now contain the settings for 
multiple languages, allowing users to have a single task specific profile that 
works regardless of the language they switch to. 

For example, if a person spoke English, Spanish, and French, they can create 
a single "proofreading" profile. With speech set to English, they would turn on 
the announcement of all punctuation and set the speaking rate to be a little 
slower than their normal reading rate. Next, they would switch the language to 
Spanish, choose their preferred voice, and make the punctuation and reading 
rate changes. After that, they would do the same for French and save their 
profile with "proofreading” as the name. This proofreading profile can now be 
used regardless of whether the voice is set to English, French, or Spanish. 

As with previous versions of MAGic, you can set profiles to automatically be 
used when you enter specific applications. For example, you may want a profile 
that simply sets punctuation to “All” when your focus is in a coding application. 

The sections below describe how to create and manage voice profiles. 

Use this button to, 

 

Select a voice profile to use as the default, for example, Eloquence. 
It will apply globally for all MAGic speech.  

Select Settings from the Voice Profile list to open the Voice 
Adjustment dialog box. You can then customize an existing profile 
and save it as a new voice profile. For more information see Voice 
Adjustment. 

Create a voice profile to use when performing a specific task, for 
example, when proofreading Word documents, reading news 
articles using your web browser, or using software tools to create 
your own web pages.  

Select a voice profile to use for the current application, which can be 
different from the default profile, for example, Vocalizer Expressive. 
If you select Default, then the application will use the same voice 
profile defined as the MAGic default, for example, Eloquence.  
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Note:  In addition to using this button to change profiles on the fly, you 
can also press MAGic Key+F11 to select a profile as the MAGic 
default, or for the current application. 

Hot Keys 

Select a Voice Profile MAGic Key+F11 

Select a Language WINDOWS Key+CTRL+L 

Creating a New Voice Profile 

Starting with an existing voice profile is an easy and quick way to create a new 
profile. You begin with basic voice settings, customize the settings to match the 
activity to be performed or the application to be used, and then save the new 
profile using a name that easily identifies it. 

Before creating the profile, give some thought to how you want to use it and if 
you want to use it in situations where you will encounter multiple languages. 
For example, you can create a single voice profile that contains multiple 
languages with unique settings for each language. With each language, you 
can choose among the available voices you have installed for that language. 
For your native language, you may be very comfortable with a very fast speech 
rate, but with other languages, you may want to have the speech rate slowed 
down for better understanding. If MAGic detects language tags in a document 
or web page, it will automatically switch to the appropriate language. (If these 
tags are missing, you can always press WINDOWS Key+CTRL+L to manually 
change languages. This hot key opens the Select a Language dialog box. It 
shows all languages currently installed on your computer.) 

Note: To create multi-language profiles, you must have different 
synthesizer voices installed on your computer. These can be 
downloaded for free from the Freedom Scientific web site. To 
access the latest Vocalizer Expressive voices, choose Help from 
the Main menu, and then More Voices. 

You can also create a voice profile oriented toward a specific task or activity. 
For example, you can have a voice profile dedicated to proofreading Word 
documents, or a profile dedicated for leisurely reading of emails or web pages, 
or a profile for software applications you use when creating your web page. 
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To create a new voice profile, do the following: 

1. Open the Voice Adjustments dialog box.  
(From the Speech tab, choose Voice Profiles and then Settings.) 

Note: Full speech must be enabled to open the Voice Adjustments 
dialog box. It cannot be opened while using Speech On Demand. 

2. Select a factory voice profile in the Profile Name box. For example, 
Vocalizer Expressive – (factory).  

3. Select a language in the Synthesizer Language box. For example, 
English – United States or English – United Kingdom.  

4. Select a voice in the Person box. For example, Allison Premium – United 
States or Daniel Premium – United Kingdom.  

5. Make any necessary changes to the speech rate, punctuation, or other 
voice settings.  

6. Choose Apply, and then No when asked if you want to apply these 
changes as the default voice profile.  

7. If you want to add another language to this profile, repeat steps 3 through 
6, but select a different language and voice, for example, Spanish – 
Spain and Monica Premium – Spain. You can add as many languages as 
you have installed on your computer. 

Note: You can select a primary language for the profile. To do this, see 
“Selecting a primary Language” in the section below. 

8. When finished, choose Save As and type a name for the new voice 
profile. Choose Yes or No to make this the new default profile, and then 
choose OK to close the dialog box. 

Note: If you do not rename the new profile, it will use the same name 
as the selected factory voice profile. However, its name will no 
longer be identified as "factory" in the Profile Name box. 

Selecting a Primary Language 

While setting up your profile, you have the option of selecting a primary 
synthesizer language. This is the language that is heard when you activate the 
profile. By default, this is set to "Match MAGic UI Language," which means that 
it always matches the language of the MAGic interface. For example, an 
English version of MAGic will use English as its primary synthesizer language. 
A Spanish version will use Spanish as its primary synthesizer language. 
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To use a different primary language in the profile, do the following: 

1. Select a language in the Synthesizer Language box. 

2. Choose the "Set Language as Primary" button. 

3. Choose Yes if asked to change the primary language. 

4. Save the profile. MAGic now uses this selection as its primary language. 
It is also identified as "primary" in the Synthesizer Language box. 

Restoring a Factory Voice Profile 

To restore a default voice profile: 

1. Select the modified default voice profile in the Profile Name box, for 
example, Vocalizer Expressive. 

2. Choose the Delete Profile button and then Yes to delete the profile. 
MAGic switches to the first voice profile in the Profile Name box. 

3. Select the Profile Name box again, and the profile appears and is 
identified as "factory" in the list, for example, Vocalizer Expressive – 
(factory). 

Deleting a Voice Profile 

To delete a voice profile, do the following: 

1. Open the Voice Adjustments dialog box.  

(From the Speech tab, choose Voice Profiles and then Settings.)  

2. In the Profile Name box, select the voice profile that you want to delete.  

3. Choose Delete Profile and then Yes to delete the profile. MAGic switches 
to the first voice profile in the Profile Name box.  

Note: You cannot delete a default voice profile that is labeled as 
"factory," for example, Eloquence - (factory) or Vocalizer 
Expressive - (factory).  

4. Select another voice profile in the Profile Name combo box, or choose 
OK to close the dialog box. 
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Selecting a Voice Profile for an Application 

To select a voice profile for an application, do the following: 

1. Make sure that focus is in the application and then press MAGic 
Key+F11.  

The Select a Voice Profile dialog box opens. It contains a box labeled 
Default, which assigns a voice profile that is used globally by MAGic, and 
the For <application name> box, which assigns a voice profile for a 
specific application.  

2. In the For <application name> box, select a profile, and then choose OK. 

Note: If you select Use Default, which is the first item listed in the box, 
MAGic will use the same voice profile currently selected in the 
Default box for the current application. 

Voice Profile Adjustment Settings 

Use the Voice Adjustment settings to change MAGic's voice, speech rate, 
pitch, synthesizer, language, punctuation level, and other speech options. 
These speech preferences are used any time MAGic speaks. If you only want 
to change certain aspects of MAGic's speech (such as the speech used to read 
documents) use the Adjust combo box settings. You can save your speech 
settings as a voice profile, allowing you to switch between different settings 
quickly and easily. See Selecting a Voice Profile to learn more about creating, 
selecting, and deleting profiles. 

To open Voice Adjustment settings: 

 

Click this button and then choose Settings, or 

From the Main menu, choose Speech, Voices, and then Voice 
Adjustment  

Open the MAGic Context Menu, select Voices, and then Voice 
Adjustment   

Note: Full speech must be enabled to open the Voice Adjustments 
dialog box. It cannot be opened while using Speech On Demand. 
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Settings 

You can save your voice settings as part of a voice profile. Use the Profile 
controls to select an existing profile that you want to edit or to select a factory 
default profile that can be used as a template to create a new voice profile. To 
save your current voice settings as a voice profile, choose the Save As button. 

Tip: You can quickly switch to any of the voice profiles you have 
created by pressing MAGic Key+F11. A context menu displays, 
allowing you to choose one of the available profiles. 

Profile Name 

Use this combo box to select the voice profile that you want to use. This 
provides a starting point for you to select a synthesizer and modify various 
options in this dialog box. After customizing your voice settings, you can name 
it and save it as a new profile using the Save As button. 
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Note: Eloquence is the default speech synthesizer. When you use a 
synthesizer other than Eloquence, you may experience a delay of 
several seconds as you load the other synthesizer. 

Delete Profile 

Use this button to delete a voice profile.  

Note: This button is not available when a factory voice profile is 
selected, for example, Eloquence - (factory) or Vocalizer 
Expressive - (factory).  

Synthesizer Name 

This box always displays the name of the synthesizer that is used by the 
current voice profile. (The box always appears as disabled and cannot be 
manually changed.) 

Synthesizer Language 

Select the synthesizer language that you want to use for the voice profile. The 
languages that are available are determined by the speech synthesizer you are 
using. In addition, you can also select different dialects, or accents, for the 
same language if voices for those dialects are installed. For example, English 
(United States) or English (United Kingdom). 

You can configure different voice settings for each available language and save 
them in the same voice profile. For example, if English is the primary language 
in the profile, you can configure the speech rate, punctuation, pitch, and so on. 
If you also have one or more Spanish voices available, you can select Spanish 
from this combo box, and then configure a different rate, pitch, or punctuation 
level that will automatically be used when MAGic switches to that language. 
Note that if you have voices for different dialects in the same language, such as 
English (United States) and English (United Kingdom), the same voice settings 
will apply for all dialects in the same language. 

The default synthesizer language setting is "Match MAGic UI Language," which 
means that it always matches the language of the MAGic interface. For 
example, an English version of MAGic will use English as its primary 
synthesizer language. A Spanish version will use Spanish as its primary 
synthesizer language. 

Tip: Press WINDOWS Key+CTRL+L to switch languages in the 
currently active voice profile. 
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Set Language as Primary 

Use this button to set the currently selected synthesizer language as the 
primary language for the voice profile. This is the language that is heard when 
you activate the profile. It is also labeled as "primary" in the Synthesizer 
Language box. This button is not available when the primary language is 
selected. 

By default, the primary language is the same as the language of the installed 
version of MAGic. (This is easily identified as "Match MAGic UI Language" in 
the Synthesizer Language box.) For example, if you are using an English 
version of MAGic, the primary language for the profile is English. For Spanish 
MAGic, the primary language for the profile is Spanish. 

Speak Sample 

Use this button to hear a sample of the currently selected voice using the 
current voice settings. The voice is selected using the Person list box. 

Voice Group Box 

The Voice area allows you to change various characteristics of MAGic's 
synthesized speech. 

Adjust 

You can configure MAGic so that slight variations to MAGic speech are heard 
when navigating different parts of an application's interface, for example, 
menus and dialog boxes, or when listening to helpful information such as tutor 
messages. The Adjust combo box lets you select specific voice context and 
then set various voice parameters, such as speech rate and punctuation, so 
that you can easily distinguish where and what MAGic is reading on your 
computer screen. The following describes the items in the Adjust combo box. 

 All Context - When selected, you can make one set of changes to the 
Voice controls that can then be applied at once to the Document Reading 
Voice, Mouse Voice, Keyboard Voice, Message Voice, and Menu and 
Dialog Voice items listed in this combo box.  

 Document Reading Voice - This is the primary cursor used by MAGic. It 
corresponds to the system focus. To use a specific voice to distinguish 
when MAGic is reading a document, moving through or selecting options 
or icons, and performing most standard Windows functions, select this 
item and then change voice parameters such as speech rate, 
punctuation, person, and so on.  
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 Mouse Voice - This item is linked to mouse pointer functions in Windows 
and other applications. Select Mouse Voice and then change other voice 
settings in the Voice group to differentiate when the mouse pointer is 
active.  

 Keyboard Voice - Use the Keyboard voice when you want MAGic to 
announce characters and words in a different voice when typing echo is 
on. To customize the Keyboard voice, select this item and then change 
voice settings such as rate, punctuation, and so on.  

 Message Voice - Use this item when you want tutor messages 
announced in a specific voice. A tutor message can provide navigation 
tips in Windows and other applications. For example, if you press ALT to 
access an application's menu bar, MAGic announces the message, "To 
navigate, press LEFT ARROW or RIGHT ARROW." To customize the 
Message voice, select this item and then change voice settings such as 
rate, punctuation, and so on.  

 Menu and Dialog Voice - Use this item to hear menus and dialog boxes 
announced using different voice settings.  

Person 

The Person list allows you to select which synthesizer voice you want to use. 
The voices that are available are determined by which speech synthesizer you 
have selected. 

Rate 

The Rate slider allows you to adjust the rate of speech for the currently 
selected synthesizer and voice. As you use MAGic, you may want to hear 
different types of activities at different rates. For instance, while you are typing, 
you may want MAGic to read more quickly, so that you can ensure the 
accuracy of your typing. On the other hand, if you are reading a document, you 
might want MAGic to speak more slowly, so you can concentrate on content. 

Move the slider to the left or right to decrease or increase the speech rate. The 
percentage value announced via speech is relative to the current position of the 
slider bar. The value displayed in the dialog box is based on a setting within the 
synthesizer, for example, words per minute. 

Punctuation 

The Punctuation list allows you to specify how much punctuation MAGic 
speaks. Available options are "None," "Some," "Most," and "All." 
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Pitch 

The Pitch slider allows you to adjust the pitch for the currently selected voice. 
The percentage value announced via speech is relative to the current position 
of the slider bar. The value displayed in the dialog box is based on a setting for 
pitch within the synthesizer. Note that some SAPI5 and Vocalizer Direct 
synthesizers do not support pitch change like Eloquence and some other 
hardware and software synthesizers. 

Volume 

Move the slider to the left or right to increase or decrease volume for the 
selected voice. The percentage value announced via speech is relative to the 
current position of the slider bar. The value displayed in the dialog box is based 
on a setting for volume within the synthesizer. Note that when using the 
Eloquence synthesizer, you must use the Windows volume controls to adjust 
volume. 

Spell Rate Change Percent 

When you hold down INSERT and press NUM PAD 5 twice quickly to spell a 
word, the word is spelled at a rate of speech slower than the normal speech 
rate. The value in the Spell Rate Change Percent edit box determines the 
extent to which the speech rate decreases. 

Upper Case Pitch Change Percent 

MAGic indicates that a letter is capitalized by reading it with higher-pitched 
speech. The value in the Upper Case Pitch Change Percent edit box 
determines the extent to which the pitch increases beyond the normal level. 
The values and ranges for this setting vary depending upon which synthesizer 
is selected.  

Voices and Synthesizers 

MAGic supports several synthesizers provided by Freedom Scientific. You can 
use these to install a variety of voices and languages for MAGic speech. When 
you install MAGic from the DVD, you have the option to install a small number 
of Vocalizer Expressive voices. Once installed, you can then create a voice 
profile to define how MAGic speaks.  

A complete list of supported languages and voices are available from the 
Freedom Scientific Web site. To listen to samples and download additional 
voices, choose Help and then More Voices from the Main menu.  
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Verbosity 

From the Main menu, choose Speech, and then Verbosity to control the event 
driven functions that MAGic speaks. Select the check boxes of the items that 
you want to hear.  

 

Automatically Speak 

This area contains check boxes that allow you to determine which items MAGic 
reads as you navigate dialog boxes or documents. If the check box next to the 
item is selected, then MAGic will announce that item. The following are brief 
descriptions of each available verbosity option: 

 Control Group Name - Often, options in a dialog box are put into groups 
when they have related functions. When this check box is selected, 
MAGic speaks the group box heading the first time you move to or select 
an item in the group.  

 Control Name - MAGic automatically reads the prompts or labels for 
dialog box options when you move to them. Control names appear on the 
screen, and usually provide information about a control.  

 Control Type - MAGic announces the type of the currently selected 
dialog box option. There are several common types of controls found in 
Windows, including edit boxes, combo boxes, buttons, list boxes, and so 
on. Control types do not appear as text on the screen.  
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 Dialog Name - MAGic reads the text that appears on the title bar of a 
dialog box when it becomes active.  

 Dialog Text - MAGic reads the descriptive, non-interactive text that 
appears in dialog boxes.  

 Document Name - MAGic announces the title of the active document 
window. This can be the title of a document in Microsoft Word, a text 
document in Notepad, or e-mail message in Outlook.  

 Help Balloon - Help balloons provide information about the selected 
item. Select this check box to have MAGic automatically read this 
information as it displays on the screen. An example of when a help 
balloon displays is when you connect new hardware to your computer.  

 Item Number - MAGic automatically announces the selected item's 
numeric position in relation to the total number of items in a window, 
group, or list.  

 Item State - MAGic announces information that reflects the state of an 
item. For example, MAGic will notify you whether a choice in a list box is 
selected or not selected.  

 Position Information - MAGic provides information that describes an 
item’s location in relation to the larger structure that contains it. For 
example, the coordinates of a table can be considered positional 
information because they describe that cell’s position within the table.  

 MAGic Message- MAGic provides you with messages that aid in 
navigation by verifying that a Windows action has taken place. For 
example, the message, "Top of window," assists in navigation by alerting 
you that you have reached the top of the current window.  

 Screen Message - MAGic reads text that appears on the screen, but 
may not be attached to a particular control. For example, some radio 
buttons have additional or related information found in another nearby 
area of the screen.  

 Selected Item - MAGic automatically reads the selected item within a list 
or window.  

 Status Information - MAGic provides additional speech feedback when 
typing MAGic commands using the keyboard. For example, press MAGic 
Key+NUMPAD PLUS or MAGic Key+NUMPAD MINUS to increase or 
decrease the magnification level, and MAGic will also announce 3x, 4x, 
and so on. If you clear this check box, MAGic does not announce this 
additional information.  
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 Tool Tips – Tool Tips frequently appear when you rest the mouse over 
an item for a brief period of time. The Tool Tip gives you a short 
description of the item. If this check box is selected, MAGic speaks Tool 
Tips of any length.  

Access Key Verbosity 

Within menus and buttons, often a letter is underlined. You can press the 
underlined letter (also called an access key) in conjunction with the ALT key to 
activate the command or button. You can choose which access keys MAGic 
announces by selecting one of the following options:  

 None - MAGic does not announce any access keys.  

 Speak All - MAGic announces access keys in both menus and dialog 
boxes.  

 Speak Menus Only - MAGic only announces access keys in menus.  

 Speak Dialogs Only - MAGic only announces access keys in dialog 
boxes.  

Restore Factory Settings 

Choose the Restore Factory Settings button to return to the default MAGic 
verbosity choices. These were the settings in use when you first installed the 
program. 

Verbosity Schemes 

From the Main menu, choose Speech, and then Verbosity Scheme to create 
and switch between verbosity schemes. Verbosity schemes give you additional 
control over which items MAGic announces, as well as how they are 
announced. You can also define custom text that MAGic speaks when you 
move to a control or other element. Alternatively, you can assign a sound that 
you want MAGic to play instead of speaking. You can also choose to combine 
both speech and sounds, or tell MAGic to ignore certain items entirely. 
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Scheme 

In the Scheme list, select the verbosity scheme that you want to use. If you 
create and save a new scheme, it appears in this list.  

Save As 

After you choose which speech and sounds you want MAGic to use when 
announcing various control types and states, choose the Save As button to 
save your preferences as a scheme. Navigate to the folder where you want to 
save the scheme, and then type a name for the scheme in the File Name edit 
box. This is the name that appears in the Scheme list. Select your new scheme 
in the Scheme list to activate it.  

Delete 

Choose the Delete button to delete the verbosity scheme currently selected in 
the Scheme list. 
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Control Type 

The Control Type list shows all of the various controls that MAGic can 
announce. A control can be a dialog box option, HTML element, heading, 
button, or other item. The Behavior column lists the action that MAGic takes 
when you move to that control type. "Speak" means that MAGic announces the 
control type using synthesized speech. "Play Sound" means that MAGic plays a 
specific sound instead of speech. "Speak & Play Sound" means that MAGic 
both speaks the control type and plays a sound. "Ignore" means that MAGic 
does not announce the control in any way.  

Behavior 

To change the action associated with a control, select the control in the 
Control Type list and then choose a new action from the Behavior list. If you 
select "Play Sound" or "Speak & Play Sound," you must choose the Select 
Wave File button to pick which sound you want to use. 

Tip: Assign the behavior "Ignore" to control types that you do not want 
MAGic to announce. 

Text 

If you select "Speak" or "Speak & Play Sound" in the Behavior list, you can 
type some custom text in this edit box that you want MAGic to announce. 
MAGic reads this text instead of the control type.  

Select Wave File 

If you select "Play Sound" or "Speak & Play Sound" in the Behavior list, 
choose the Select Wave File button to open the Select Sound dialog box. 
Select the sound that you want to use and choose OK. You can choose the 
Play button to hear a preview of the selected sound. If the sound you want to 
use is not in the list, choose the Browse button to locate the file on your 
computer. You can use any sound file with a .wav file extension. After you 
locate and select the file, choose OK to add it to the list of available sounds. 



104 

 

Control State 

The Control State list shows all of the control states that MAGic can 
announce. Control states provide various information about the status of a 
control. For example, the control states for a check box are "Checked" and 
"Unchecked." The Behavior column lists the action that MAGic takes when you 
move to an item with that control state. "Speak" means that MAGic announces 
the control state using synthesized speech. "Play Sound" means that MAGic 
plays a specific sound instead of speech. "Speak & Play Sound" means that 
MAGic both reads the control state and plays a sound. "Ignore" means that 
MAGic does not announce the control state in any way.  

Behavior 

To change the action associated with a control, select the control in the 
Control State list and then choose a new action from the Behavior list. If you 
select "Play Sound" or "Speak & Play Sound," you must choose the Select 
Wave File button to pick which sound you want to use.  

Text 

If you select "Speak" or "Speak & Play Sound" in the Behavior list, you can 
type some custom text in this edit box that you want MAGic to announce. 
MAGic reads this text instead of the control state.  
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Select Wave File 

If you select "Play Sound" or "Speak & Play Sound" in the Behavior list, 
choose the Select Wave File button to open the Select Sound dialog box.  

 Spotlighting Text with Speech 

MAGic can spotlight text as it is spoken. The spotlight moves to emphasize the 
text and images that MAGic reads within documents and Web pages.  

To turn spotlighting on or off, do the following: 

1. From the Menu button, choose Speech, and then Spotlight Options.  

2. In the Spotlight Style list, do one of the following:  

 Select Box, Block, or Underline to turn the spotlight on  
(If you like, you can also change the spotlight's color, transparency, 
and thickness using the other options in the dialog box.)  

 Select None to turn the spotlight off  

3. Click OK to save changes.  

Spotlight Options 

Use these options to customize how MAGic spotlights text on a page.  

 

Spotlight Style 

When MAGic uses synthesized speech to read the text on your screen, it can 
spotlight the text it is speaking. This allows you to easily follow the text visually 
while MAGic reads. In the Spotlight Style list, choose one of the following 
options to specify how you want MAGic to spotlight text: 
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 None – MAGic does not spotlight text as it reads.  

 Box – Surrounds the text MAGic reads with an empty, rectangular 
outline.  

 Block – Spotlights the text MAGic reads with a solid rectangle.  

 Underline – Underlines the text that MAGic reads.  

Color 

In the Color list, choose a color for the spotlight style you selected. If you want 
to invert the colors in the area covered by the spotlight, choose "Invert Colors." 

Transparency 

Use the Transparency slider to adjust the transparency level of the selected 
spotlight style. A higher level of transparency allows you to see more of the 
surrounding area covered by the spotlighting. 

Thickness 

Use the Thickness slider to adjust the thickness of the spotlight style you 
selected. This lets you change the vertical size of the underline and block 
spotlight styles, and determine the thickness of the border for the box spotlight 
style. 

Selecting a Sound Card 

For instructions describing how to select a sound card for MAGic speech output 
when multiple sound cards are installed, go to Selecting a Sound Card for 
MAGic Speech. For an overview of multiple sound card operation with MAGic, 
read the following information. 

Windows typically makes the last sound card added to your system the default 
sound card. This means that MAGic speech automatically goes to the new 
audio device, which can be frustrating if you want to use that device for 
something other than MAGic. 

Using MAGic, you can override the Windows default selection, and choose 
which sound card to use for speech output. For example, if you are editing 
music, you can let Windows direct your music through a higher-end audio card 
while MAGic directs its speech output to an inexpensive sound card in your 
computer.  
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Things to Remember About the Sound Card List 

In Control Panel, a single sound card can appear as multiple sound devices, for 
example, as speakers, as a digital audio interface, as HDMI output, and so on.  

Any audio device identified in the list as a "digital" item may not have speakers 
connected. If you select this item, you may lose speech.  

Make sure to plug in speakers or a headset to any internal or external USB 
device that you want to use for MAGic speech.  

When only one sound card is installed in your computer, MAGic's Sound Card 
dialog box will always show two items: the Windows default sound card, and 
the name of the installed sound card. These two items represent the same 
audio device. By default, MAGic will choose "Windows default sound card." 
This means that when you add another sound card, MAGic will use it because 
Windows makes the most recently added sound card the Windows default 
audio device. The Windows default sound card can change as you add or 
remove audio devices. 
 
However, if you choose the sound card by its name, it becomes the audio 
device that MAGic uses for speech output. When you add another sound card 
to your computer, the new sound card will also appear by name in the Sound 
Card dialog box. Although the Windows operating system will make the newly 
added sound card the Windows default sound card, MAGic will continue to use 
the first sound card since you selected it by name in the dialog box. Even as 
you add and remove other sound devices from the system, MAGic will continue 
to use this sound card for speech output. 
 
Finally, if you select a specific sound card to use for MAGic speech output, and 
then remove that card from the system, MAGic will automatically fall back to the 
Windows default sound card. This means that MAGic will use the same sound 
card that the Windows operating system identifies as the default audio card. If 
you later restore the sound card to the system, MAGic will again send speech 
output to that card instead of the Windows default sound card.  
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Selecting a Sound Card for MAGic Speech 

To select a sound card for speech, do the following: 

1. From the Main menu, choose Speech, and then Sound Cards.  
A list of installed devices display in the Sound Cards dialog box. The 
current sound card is selected.  

Note: The first item that always appears in the list is labeled Windows 
default sound card.  It is the same sound card that Windows 
recognizes as the default sound device in the Control Panel. This 
is typically the most recent audio device added to the system. 

2. Use the UP or DOWN ARROW keys to move to a sound device, and then 
press ENTER to select the card. The menu closes and MAGic now uses 
the selected card.  

Lowering Audio Volume of Other Programs 
While MAGic is Speaking 

In Windows 8.1 and later, you can specify that the volume of audio from other 
programs be lowered while MAGic is speaking. This is commonly referred to as 
audio ducking. For example, if you are listening to music or playing a video and 
MAGic begins talking, the volume of the music or video will be slightly lowered 
so you can comfortably hear MAGic and then raised back to its current level 
when MAGic stops talking.  

By default, the audio volume from other programs remains at the same volume 
as MAGic speech. You can change this by selecting “Lower the volume of other 
programs while MAGic is speaking” in the Startup Wizard or in Preference. 

Lowering Volume Using the Startup Wizard 
1. From the Main menu, choose Help and then Startup Wizard.  

2. Click Next until the Speech Settings appear.  

3. Select "Lower the volume of other programs while MAGic is speaking."  

4. Click Next and then Finish.  
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Lowering Volume Using Preferences 
1. From the Main menu, choose File and then Preferences.  

2. Select "Lower the volume of other programs while MAGic is speaking" 
and click OK to close the dialog box.  

3. Press CTRL+S to permanently save the change.  

Using Multiple Sound Devices 

Turning on audio ducking is most useful if both MAGic speech and other 
program audio are coming through the same sound device. If you use multiple 
sound devices, such as a USB headset and external speakers connected to 
your computer's sound card, you can configure MAGic speech to use the 
headset while other audio comes through the external speakers which you can 
then control using the physical volume control. For more information, see 
Selecting a Sound Card. 
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Chapter 7 
Reading with MAGic 

Reading with Text Viewer 

What is Text Viewer 

Text Viewer is a reading tool that displays a continuous line of text across the 
top or bottom of your screen.  The text is based on the location of the cursor, 
mouse pointer, or last point of interest. You can format the text using font styles 
and colors so that it is easier to read documents, e-mails, Web pages, and 
more. 

The Text Viewer consists of a rectangular window that you can place at the top 
or bottom of your screen. As MAGic reads text on the magnified screen, or as 
you type, the same text displays in the Text Viewer. This provides a single area 
of focus instead of you having to visually track the spoken text displayed in 
other areas of the screen. This is especially useful when reading by Say All. 
Also, by using a font style and colors that are comfortable for you, it is easier to 
view words and symbols that are difficult to read. 

 

Click the top half of the button to turn this feature on or off. 
 
Click the lower half of the button to move the viewer to the 
top or bottom of the screen, or to change the viewer's font 
styles, colors, or spotlight tracking. 

Hot Keys 

Toggle Text Viewer on or off MAGic Key+CTRL+V 

Toggle Text Viewer position MAGic Key+CTRL+DOWN ARROW 

Pan Right MAGic Key+CTRL+RIGHT ARROW 

Pan Left MAGic Key+CTRL+LEFT ARROW 

Switch Text Viewer between 
monitors 

WINDOWS Key+CTRL+RIGHT ARROW 
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How to Use Text Viewer 
1. Click the Text Viewer button in the Tools tab, or press MAGic 

Key+CTRL+V. 
The Text Viewer displays at the top or bottom of the screen. Top is the 
default position. 

 

2. Begin reading your document, Web page, or current open application by 
using MAGic’s reading hot keys, mouse echo, or cursor echo.  

3. As MAGic reads the text on the screen, it simultaneously displays and 
spotlights the same text in the Text Viewer window. 

4. To close Text Viewer, click the Text Viewer button again, or press MAGic 
Key+CTRL+V. 

To change Text Viewer settings, click the lower half of the button to open 
the Text Viewer dialog box. 

To change the Text Viewer position on the screen, click the lower half of 
the Text Viewer button and choose Top or Bottom. 

To move the Text Viewer between two monitors, press WINDOWS 
Key+CTRL+RIGHT ARROW.  

Learning the Text Viewer Window 

The following describes the Text Viewer window, its icons, and hot keys. 

 The Text Viewer window displays across the top or bottom of your 
screen. Top is the default position.  

 The window contains a full line of text that is based on the current 
location of the mouse pointer, cursor, or the current menu or dialog.  

 The Text Viewer has three visual indicators that identify the source of the 
text displayed in the window. The indicators display on the left side of the 
window.  

 

A vertical bar displays when MAGic is reading from the 
cursor position on the screen 
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A mouse pointer displays when MAGic is reading from 
the mouse pointer position on the screen 

 

A gear settings icon displays when MAGic is reading text 
in a dialog box or menu 

 

 You can pan left or right to read additional text that is not currently 
displayed in the window.  

 Press MAGic Key+CTRL+RIGHT ARROW to pan right.  

 Press MAGic Key+CTRL+LEFT ARROW to pan left.  

 Panning indicators display on the left side and right side of the window.  

 

 

Indicates that more text is available to the left 

 

Indicates that no text is available to the left 

 

Indicates that more text is available to the right 

 

Indicates that no text is available to the right 

Spotlight tracking of text in the window can be set for Automatic Advance or 
Center. When set for Automatic Advance, the spotlight moves across the 
window as text is read, for example, when reading by Say All (INSERT+DOWN 
ARROW) or Say Line (INSERT+UP ARROW). When set for center, the 
spotlight remains in the center while the text scrolls across the window.  

Changing Text Viewer Settings 
1. Click the lower half of the Text Viewer button and select Settings. 

The Text Viewer dialog box opens. It has the Display tab and the 
Tracking tab.  
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2. Use the Display tab to:  

 Place the viewer at the top or bottom of the screen  

 Set font styles such as size, font, style, and colors  

 Set spacing between words in the viewer’s window  

3. Use the Tracking tab to:  

 Select the type of spotlight tracking, for example, the spotlight can 
remain in the center of the Text Viewer, or it can advance over each 
word as MAGic reads the text.  

 Select a spotlight style, for example, box, block, or underline, and 
then configure its attributes such as spotlight color, text color, and 
so on.  

4. When finished, click OK to close the dialog box.  

5. To permanently save the new settings, press CTRL+S  

Reading Text with MAGic 

MAGic can use synthesized speech to read text that appears on your screen, 
including documents, menus, dialog boxes, e-mail messages, Web pages, and 
more. Additionally, MAGic can spotlight the text as it is spoken. To customize 
MAGic’s speech, use the commands available on the Speech menu. 

Tip: You can silence MAGic’s speech at any time by pressing CTRL. 
To toggle between full speech or Speech On Demand, press 
MAGic Key+F3. 

Using the Mouse to Read Text 

Mouse echo is a feature that allows you to read text with your mouse. To use 
mouse echo, just move your mouse pointer to some text on your screen and 
then stop. After a short delay, MAGic will speak the word you pointed to. You 
can use the Mouse Echo button on the MAGic user interface to enable or 
disable this feature. For more information, refer to Mouse Echo. 

In addition, you can hold down the MAGic Key and press the left mouse button 
to start reading from the current location of the mouse pointer. You do not need 
to hold down the MAGic Key while MAGic reads. MAGic stops reading when 
you move the mouse or press a key. 
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Using the Keyboard to Read Text 

MAGic has a number of different keystrokes that let you use the keyboard to 
read text. To use these keystrokes, move the insertion point or mouse pointer 
to any location within the document. Then press one of the following key 
combinations to read from that location:  

To ... Use this hot key ... 

Begin reading from your 
current location 

INSERT+DOWN ARROW or  
MAGic Key+A or  
MAGic Key+LEFT MOUSE BUTTON 
CLICK 

Fast forward while reading 
during Say All 

RIGHT ARROW 

Rewind while reading during 
Say All 

LEFT ARROW 

Read the current character NUM PAD 5 

Read the current word 
MAGic Key+ALT or  
INSERT+NUM PAD 5 

Spell the current word 
MAGic Key+ALT (twice quickly) or  
INSERT+NUM PAD 5 (twice quickly) 

Read the next word INSERT+RIGHT ARROW 

Read the previous word INSERT+LEFT ARROW 

Read the current line 
MAGic Key+L or  
INSERT+UP ARROW 

Read the next line DOWN ARROW 

Read the previous line UP ARROW 
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To ... Use this hot key ... 

Read from the beginning of 
the line to the current 
position of the cursor 

INSERT+HOME 

Read from the current 
position of the cursor to the 
end of the line 

INSERT+PAGE UP. 

Read the current sentence MAGic Key+S 

Read the next sentence MAGic Key+CTRL+S 

Read the current paragraph MAGic Key+P 

Read the next paragraph 
MAGic Key+CTRL+P or  
CTRL+DOWN ARROW 

Read the previous 
paragraph 

MAGic Key+ALT+P or  
CTRL+UP ARROW 

Read text that you have 
selected 

INSERT+SHIFT+DOWN ARROW 

Hear the contents of the 
Clipboard 

MAGic Key+X 

Read the contents of the 
Clipboard using the 
Clipboard Text Viewer 

MAGic Key+SPACEBAR, followed by C or  
INSERT+SPACEBAR, followed by C 

Note: By default, the MAGic Key is assigned to the CAPS LOCK key. 
To change this, open the Keyboard menu and choose MAGic 
Key. Refer to MAGic Key for more information. 
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When you read text with these keystrokes, MAGic spotlights the word it is 
currently speaking. To change the color and/or style of this spotlighting, open 
the Speech menu and choose Document and Text Reading. For more 
information, refer to Document and Text Reading. 

Reading Text in Dialog Boxes 

In addition to the reading commands listed previously, you can use the 
following keystrokes to hear information in Windows dialog boxes:  

To ... Use this hot key ... 

Read the title bar of the active window 
or dialog box 

MAGic Key+T or  
INSERT+T 

Read the bottom of the active window 
(which usually contains the status bar) 

INSERT+PAGE DOWN 

Read the top line of the active window 
(which usually contains the title bar) 

INSERT+END 

Hear the name of the default button that 
will be activated when you press 
ENTER 

INSERT+E 

Read the currently selected dialog box 
option (such as an edit box or check 
box) 

INSERT+TAB 

Hear the access key for the currently 
selected dialog box option 

SHIFT+NUM PAD 5 
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Reading with Mouse Echo 

When Mouse Echo is enabled, MAGic reads text that you point to with the 
mouse pointer.  

 

Click the top half of the button to turn this feature on or off.  
 
Click the lower half of the button to select reading by character, 
word, lines, or paragraph. You can also set MAGic to stop speech 
when you move the mouse pointer, and open the Mouse Echo 
settings. 

Hot Keys 

Toggle Mouse Echo MAGic Key+M 

Layered Keystrokes 

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by the keystrokes listed below to perform the action.  

Toggle Mouse Echo E, O 

Echo Character E, C  

Echo Word E, W  

Echo Line E, L  

Echo Paragraph E, P  

Help Message E, QUESTION MARK 
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Settings 

When you select Settings, the Mouse Echo options appear.  

 

Enable Mouse Echo 

Use this check box to turn mouse echo on or off. 

Note: MAGic still speaks ToolTips if mouse echo is off. If you do not 
want MAGic to speak ToolTips, open the Speech menu and 
choose Verbosity. Then clear the Tool Tips check box. 

Speech Delay 

Specify the length of time you want MAGic to wait before it reads the character, 
word, line, or paragraph at the current location of the mouse pointer. The delay 
is measured in seconds. If you move the mouse pointer away before the delay 
has elapsed, MAGic does not read the character, word, line, or paragraph. 

Point & Speak 

In this area, select one of the following options: 

 Character at Mouse Position - MAGic reads the character at the current 
location of the mouse pointer. You must point at the character for the 
length of time specified in the Mouse Speech Delay box before MAGic 
reads the character. 
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 Word at Mouse Position - MAGic reads the word at the current location 
of the mouse pointer. You must point at the word for the length of time 
specified in the Mouse Speech Delay box before MAGic reads the word.  

 Line at Mouse Position - MAGic reads the line of text at the current 
location of the mouse pointer. You must point at the line for the length of 
time specified in the Mouse Speech Delay box before MAGic reads the 
line.  

 Paragraph at Mouse Position - MAGic reads the paragraph at the 
current location of the mouse pointer. You must point at the paragraph for 
the length of time specified in the Mouse Speech Delay box before 
MAGic reads the paragraph. 

Mouse Movement Stops Speech 

Select this check box to allow MAGic to interrupt speech when you move the 
mouse pointer over text. If you clear this check box, you can move the mouse 
pointer anywhere on the screen without interrupting speech. This option does 
not interrupt speech generated by mouse echo. 

 Reading with Typing Echo 

When Typing Echo is enabled, MAGic repeats characters, words, or both as 
you type. Words are spoken after pressing the SPACEBAR or ENTER keys, or 
typing a sentence ending punctuation character. 

 

Click the top half of the button to turn this feature on or off.  
 
Click the lower half of the button to select typing echo by words, 
characters, or both. You can also select Settings to set 
capitalization rules. 

Hot Keys 

Select Typing Echo Unit INSERT+2 

Select Capitalization Options MAGic Key+F2 

Settings 

When you select Settings, the Typing Echo options appear.  
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Enable Typing Echo 

Select this check box to turn on typing echo. Clear this check box to turn off 
typing echo.  

Typing Echo Unit 

Select one of the following options to determine whether MAGic should repeat 
characters you type, words that you type, or both: 

 Characters - MAGic speaks each character that you type.  

 Words - MAGic speaks each word that you type after you press the 
SPACEBAR or ENTER keys, or typing a sentence ending punctuation 
character.  

 Characters and Word - MAGic speaks each character that you type and 
then reads the entire word after you press the SPACEBAR.  

Tip: You can press INSERT+2 at any time to cycle through the 
available typing echo units. 

Indicate Capitalization 

Select one of the following options to determine how you want MAGic to 
indicate that a letter is capitalized: 
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 No Indication - MAGic does not indicate capitalization.  

 Pitch Increment - MAGic indicates that a letter is capitalized by reading it 
in a higher pitched voice.  

 Say "Cap" - MAGic says the word, "Cap," before reading a letter that is 
capitalized.  

Indicate Capitalization During 

If you selected the Pitch Increment radio button, select one of the following 
options to determine when MAGic indicates that a letter is capitalized: 

 Say Character and Spelling - MAGic only indicates capital letters when 
spelling a word or reading by character.  

 Say Word, Character and Spelling - MAGic indicates capital letters 
when spelling, reading by word, and reading by character.  

 Say Line, Word, Character and Spelling - MAGic indicates capital 
letters when spelling and when reading by line, word, or character.  

Tip: You can press MAGic Key+F2 at any time to cycle through the 
various options for indicating capitalization. 

Reading Options 

From the Main menu, choose Speech, and then Reading Options to 
customize how MAGic scrolls the page as it is reading the document. This 
dialog box also lets you determine if MAGic automatically starts reading web 
pages when they are loaded. 
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Auto Scroll During Reading 

The Auto Scroll During Reading area lets you customize how speech 
advances when the bottom of a window is reached. 

 None – Reading stops at the bottom of the window regardless of the size 
of the document. The document does not scroll automatically; you must 
move to the next screen manually and make MAGic begin speaking 
again.  

 By Page – Reading continues beyond the window limit by automatically 
feeding the next page of the document.  

 By Line – Reading continues beyond the window limit by automatically 
feeding the document one line at a time.  

Auto Speak Web Pages 

Select the Auto Speak Web Pages check box if you want MAGic to 
automatically begin reading when you view Web pages or other HTML 
documents. 

Forms Mode 

Forms Mode is a function that lets you type text in edit fields or select combo 
box values in Web pages and Adobe Acrobat forms. MAGic automatically 
enters this mode when you use the mouse to click in a form control, or press 
TAB, SHIFT+TAB, or ARROW Keys to move to a form control. You can also 
use Navigation Quick Keys, which are keystrokes that allow you to quickly 
move through and edit forms. Press MAGic Key+Z to toggle Navigation Quick 
Keys on or off.  

Sounds Indicating Forms Mode On or Off 

MAGic uses sounds to indicate when it enters and exits Forms Mode. For 
example, when you first click or navigate to a control, such as the Name field, 
you will hear a sound to let you know that you are in Forms Mode. As you move 
to subsequent controls, such as an Address field, you will not be alerted by a 
sound. However, when you reach the end of these form fields, for example, a 
Submit button, you will hear a slightly different sound. This indicates that 
MAGic has exited Forms Mode. 

By default, sounds are on, but can be turned off using the Forms Options in 
Quick Settings (MAGic Key+O) for Web browsers and Adobe Acrobat. 
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Moving Through Forms 

Press INSERT+F5 to display a list of form controls (such as edit boxes, check 
boxes, radio buttons, and combo boxes) on a page. Select any item in the list 
and press ENTER to move to the control. MAGic automatically activates Forms 
Mode for the item, allowing you to enter information or make a selection. 

Navigation Quick Keys can also be used to move to different form controls on 
the page. Below is a brief list of these keys. For a complete list, see Navigation 
Quick Keys. 

 Press F to move to the next form control  

 Press C to move to the next combo box  

 Press E to move to the next edit box  

 Press R to move to the next radio button  

 Press X to move to the next check box  

 To move to the previous form control of that type, press and hold SHIFT 
before pressing a Navigation Quick Key  

When using Navigation Quick Keys to jump to a form control, such as F for next 
form field or E for next edit box, you must press ENTER so that you can type 
text in that field or scroll through and select a value. To manually exit Forms 
Mode, press NUM PAD PLUS or ESC. 

Note: Navigation Quick Keys are off by default. To toggle Navigation 
Quick Keys on or off, press MAGic Key+Z. 

Navigation Quick Key Delay 

When using Navigation Quick Keys you can set MAGic to use a 0.5 to 5 
second delay between you pressing a key and MAGic activating Forms Mode. 
For example, when you press E to move from one edit box to the next, a three 
second delay gives MAGic time to announce the name of the current box, while 
also giving you time to decide if this is the one that you want. If you press E 
again within three seconds, MAGic moves to the next edit box. Once you move 
to the edit box that you want, MAGic will automatically enter Forms Mode after 
waiting for three seconds. At this point, if you press E again, it is typed in the 
edit box. Note that you can always press ENTER to immediately activate Forms 
Mode and skip the delay. 
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By default, the delay is always off when using Navigation Quick Keys, which 
means that you must press ENTER to start Forms Mode. However, as 
described above, you can set the length of the delay so Forms Mode turns on 
automatically after a given period of time when using Navigation Quick Keys. 
To do this, use the Forms Options in Quick Settings (MAGic Key+O) for Web 
browsers and Adobe Acrobat. 
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Chapter 8 
Saving MAGic Settings 

If you adjust any of the magnification, speech, or other settings in the various 
dialog boxes, you must save your changes if you want MAGic to use those 
settings the next time it starts.  

To save your current settings: 

 Open the File menu and choose Save Default Settings, or  

 Press CTRL+S  

These default settings are applied whenever there are no application-specific 
settings for the program you are using. If you do not save your settings, your 
changes will be discarded when you quit MAGic.  

Tip: MAGic can ask you whether you want to save your changes 
when you quit the program. To enable this feature, open the File 
menu and choose Preferences. Then, select the Prompt to Save 
Settings on Exit check box. 

You can recall your default MAGic settings at any time. To do this, open the 
File menu and choose Open Default Settings or press CTRL+SHIFT+D. 
These default settings replace your current settings.  

Application-Specific Settings 

Your usual magnification and speech settings may not be suited to all programs 
that you use. For this reason, MAGic allows you to save specific groups of 
settings that are automatically applied while you use certain programs. These 
are referred to as application-specific settings. 

For example, if you prefer greater magnification when surfing the Internet, you 
could create and save settings that are only applied while you are using 
Internet Explorer. Whenever you are working with Internet Explorer, MAGic will 
increase the level of magnification. When you quit Internet Explorer or switch to 
a different program, MAGic will reduce the magnification level. Application-
specific settings make it easy to customize MAGic to work well with all of your 
favorite programs. 
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To save a group of application-specific settings for a program, do the following: 

1. Start the program that you want to create application-specific settings for.  

2. From the File menu or the MAGic Context Menu, choose Create 
Application Settings (where the word Application is the name of the 
program you are saving settings for).  

Tip: The program name displayed on the menu is the last program 
you used before switching to MAGic. If you are using the MAGic 
context menu, the program is the one that is currently active. 
Make sure that the correct program name appears on the menu 
before creating or saving your settings. 

3. Type a name for the application-specific settings file, or use the 
suggested name. Then, choose OK to create the file.  

4. Use the MAGic menus and dialog boxes to select the magnification and 
speech options that you want to use for this program.  

5. From the File menu, choose Save Application Settings (where the word 
Application is the name of the program you are saving settings for).  

The next time you start this program, MAGic will automatically apply the 
settings you have selected. If you switch to a different program, MAGic returns 
to your default settings or the settings you have chosen for the other program. 
When you quit the program, MAGic applies your default settings. 

Modifying Application-Specific-Settings 

If you want to change your current application-specific settings for a program, 
do the following: 

1. Start the program that you want to modify your application-specific 
settings for.  

2. Use the MAGic menus and dialog boxes to select the magnification and 
speech options that you want to use for this program.  

3. From the File menu, choose Save Application Settings (where the word 
Application is the name of the program you are saving settings for).  

Managing Application-Specific Settings 

You can easily see which programs you have created application-specific 
settings for. To do this, open the File menu and choose Manage Application 
Settings. The Manage Application Settings dialog box appears, showing all 
programs with defined application-specific settings.  
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If you no longer want MAGic to use the settings you have defined for a 
program, clear the check box next to the program's name. To quickly clear all 
the check boxes, choose the Disable All button. You can re-enable any group 
of application-specific settings by selecting the check box next to the program's 
name. To quickly select all the check boxes, choose the Enable All button.  

To delete an application-specific settings file, select it in the list and then 
choose the Remove Selected button. 
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Chapter 9 

Changing Preferences 

From the Main menu, choose File and then Preferences to change the way 
you use MAGic on your computer. You can use this dialog box to start MAGic 
when your computer starts, disable your screen saver while MAGic is running, 
minimize MAGic when it starts, enable/disable the bilingual user interface, 
specify whether MAGic should prompt you before overwriting schemes, and 
determine whether MAGic asks you to save your settings when you quit. After 
you close this dialog box, you must save any changes made to your 
preferences. To do this, choose File and then Save Default Settings from the 
Main menu.  

 

Automatically Start MAGic 

Select Automatically Start MAGic to configure how MAGic will start. For more 
information, see Starting and Quitting MAGic. 
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Minimize on Startup 

If you select the Minimize on Startup check box, the MAGic user interface will 
be minimized when you start the program. Click MAGic Screen Magnification 
in the taskbar or press MAGic Key+U to display the user interface. 

Run MAGic from System Tray 

Select the Run MAGic from System Tray check box if you do not want the 
MAGic window to appear in the Windows taskbar with other programs that you 
are currently using. In addition, the MAGic window does not appear in the list of 
active windows when you press ALT+TAB. An icon appears in the Windows 
system tray (located in the bottom right corner of the screen) to indicate that 
MAGic is running. Double-click this icon or press MAGic Key+U to display the 
MAGic program window. If you minimize the MAGic window, it is removed from 
the taskbar again. 

Note: You must restart MAGic before any change to this option can 
take effect.  

Prompt to Save Settings on Exit 

Select the Prompt to Save Settings on Exit check box if you want MAGic to 
ask you to save your settings when you quit the program or shut down your 
computer. If you do not select this check box, you must press CTRL+S or open 
the File menu and choose Save Settings to save your settings. 

Disable Screen Saver 

Select the Disable Screen Saver check box if you want to prevent your screen 
saver from starting while MAGic is running. Your screen saver will be enabled 
again when you quit MAGic. 

Enable Bilingual User Interface 

Select the Enable Bilingual User Interface check box to change the language 
of MAGic’s menus, dialog boxes, and online help system when you switch to a 
voice profile that uses a different language. The resource files for the language 
must be installed in order to use this feature. Clear this check box if you do not 
want to change the language of MAGic’s user interface when you switch to a 
voice profile that uses a different language.  
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Note: The current release of MAGic contains only English and Spanish 
resource files.  

Prompt to Overwrite Schemes 

Select the Prompt to Overwrite Schemes check box if you want MAGic to ask 
for confirmation before saving a mouse, cursor, or color enhancements scheme 
with the same name as an existing scheme. If you do not select this check box, 
MAGic will save the new scheme over the old scheme without asking for 
confirmation. 

Note: Different types of schemes can have the same name. For 
example, a cursor enhancement scheme can have the same 
name as a mouse enhancement scheme. 

Initial State of NUM LOCK Key 

MAGic uses the numeric keypad to perform numerous speech, magnification, 
tracking, and panning functions.  By default, the NUM LOCK key is turned off 
so that you can easily use these functions.  However, you may have a job that 
requires extensive use of the numeric keypad, in which case, you must always 
turn on the NUM LOCK key after MAGic starts.  

The Initial State of NUM LOCK Key option allows you to control whether or not 
the NUM LOCK key is enabled when MAGic starts.  

 Turn off at startup: This is the default value.  When selected, the NUM 
LOCK key is off when MAGic starts.  

 Turn on at startup: Enables the NUM LOCK key so that it is on when 
MAGic starts.  

 Do not modify: MAGic uses the current NUM LOCK key setting.  

Note: JAWS screen reading software has a similar option. When 
running the two applications together, the JAWS selection takes 
precedence over the MAGic selection. 

Enable Remote Access Client 

Select this check box if you want to use MAGic during terminal sessions. You 
can clear this check box if you will not be using MAGic when you connect 
remotely to another computer. You must purchase the remote access option for 
your software license to use MAGic during terminal sessions. 
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Enable Remote Access Server 

Select this check box if users that connect remotely to your computer will be 
using MAGic during their terminal sessions. If you clear this check box, remote 
MAGic users will not have speech access to terminal sessions. You must 
purchase the remote access option for your software license to use MAGic 
during terminal sessions. 

Automatic Notification of Updates  

Select this check box to have MAGic indicate when a software update is 
available. You then have the option to install it now or later. When this check 
box is cleared, you will not be alerted when software updates are available. In 
this case, you must manually check for updates using the update feature in the 
MAGic Help menu. This check box is selected by default. 

Lower the Volume of Other Programs While 
MAGic is Speaking 

When this check box is selected, the volume for all programs will be reduced 
while MAGic is speaking. This check box is cleared by default and is only 
available if MAGic is running in Windows 8.1 or later. 
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Chapter 10 
Updating MAGic 

Freedom Scientific is continually seeking to improve and expand MAGic. 
Periodically, MAGic updates are released. It is recommended that you keep 
your software up-to-date so that you experience the greatest possible 
performance. Updates include everything from adjustments made to MAGic 
due to changes in other applications, the addition of new MAGic features, and 
fixes to issues found by users. 

Checking for Updates 

Note: When MAGic starts, it can alert you if a software update is 
available. You then have the option to install it now or later. This 
notification method is controlled using the Automatic Notification 
of Updates check box. To access the check box, choose the 
Main menu, followed by the File menu, and then Preferences. It 
is selected by default. If you turn off automatic notification, you 
must manually check for updates as described below. 

Updating your software is quick and easy. To search for updates or new 
training materials, do the following: 

1. Establish a connection to the Internet.  

2. Start MAGic.  

3. From the Main menu, choose Help, and then Check for Updates.  

4. MAGic searches the Internet for updates and displays a list of any that 
are available to download. Use the arrow keys to move through the list, 
and press the SPACEBAR to select the check box next to any updates 
that you want to download and install. You can choose the Details button 
to view more information about the currently selected update.  
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Note: If your computer has active firewall software (such as Windows 
Firewall), you may receive a warning indicating that either the 
FSAutoUpdate Application or FSAutoUpdate.exe is attempting to 
access the Internet. You must allow this process to access the 
Internet through the firewall in order to retrieve updates. If you 
are using Windows Firewall, you can do this by choosing the 
Unblock button when the warning message displays. For other 
firewall software, refer to the product's documentation. The 
firewall must allow MAGic to access the Internet using ports 20 
and 21 or port 80. 

5. When you are finished selecting updates, choose the Install button. You 
may be required to restart your computer.  

Downloading Special Updates 

Some users will be provided with a Freedom Scientific access code so that 
they can download special or private beta versions of MAGic. To search for 
these special updates, do the following: 

1. Establish a connection to the Internet.  

2. Start MAGic.  

3. From the Help menu, choose About MAGic.  

4. Choose the Special Update Code button.  

5. Type your Freedom Scientific special update code in the edit box and 
then press ENTER.  

6. From the Help menu, choose Check for Updates and follow the 
procedure described in the previous section to download and install 
updates.   
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Chapter 11 

Business and Classroom Features 

Links List 

Use the Links List button to quickly locate and select links on a Web page.  

 

 

1. Make sure focus is in your Web browser.  

2. Switch to the MAGic user interface.  

3. In the Tools tab, click the Links button.  

4. Select a link and then choose Move to Link.  

Keyboard Operation 
1. With focus in your Web browser, press INSERT+F7 to open the Links 

List.  

2. Press UP ARROW or DOWN ARROW, or the first letter of a link's text to 
move through the list of links.  

3. Press ENTER to open a link.  

You can also move through the controls in this dialog by pressing TAB. There 
are buttons to move to the location of a link on the page or to open a link. There 
are radio button groups to filter and sort the links that display in the list. There 
are also access keys for all these controls, so you can select the options 
without leaving the list of links. 

Setting Access Key 

Move to Link  ALT+M  

Activate Link  ALT+A  

Sort Links in TAB Order  ALT+T  

Sort Links Alphabetically  ALT+P  
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Setting Access Key 

Display All Links  ALT+L  

Display Visited Links Only  ALT+V  

Display Unvisited Links  ALT+U  

Headings List 

Click this button to open the Headings list. 

 

 

1. Make sure focus is in your Web browser or document.  

2. Switch to the MAGic user interface.  

3. In the Tools tab, click the Headings button.  

4. Select a heading and then choose Move to Heading.  

In HTML, headings are used to indicate the start of sections and subsections of 
a page. When viewing all headings on a page, if the headings are used 
properly, the hierarchy of the heading levels indicates how the page is 
structured. This makes it easier to find information and understand the 
relationships within the information. 

MAGic recognizes headings at levels 1 through 6. When Navigation Quick 
Keys are on, you can press H to move to the next heading, or press SHIFT+H 
to move to the prior heading. (Navigation Quick Keys are off by default. To 
toggle on or off, press MAGic Key+Z.) 

Keyboard Operation 

1. With focus in the Web browser or document, press INSERT+F6 for a lists 
of headings on the current page.  

2. Move to a listed heading in the Headings List with the arrow keys, or type 
the first few letters of heading text to move to it.  

3. Press ENTER to move to the selected heading.  

Press ALT plus the number of the heading level (1 through 6) to display only 
headings at that level. Press ALT+L to display all headings. 
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To list headings in alphabetic order, press ALT+P. To list headings in TAB 
order, press ALT+T. 

Skim Read 

 

Click to open the Skim Reading dialog box and create your own 
skim reading rules. 

The Skim Reading feature lets you quickly browse through long documents or 
Web pages. By default, MAGic reads the first line of each paragraph, but you 
can choose to read the first sentence of each paragraph instead or set up your 
own skim reading rules. To change your skim reading preferences, click the 
Skim Read button or press CTRL+SHIFT+INSERT+DOWN ARROW.  

To begin skim reading in a document, press CTRL+INSERT+DOWN ARROW.  

Tip: While skim reading, you can begin reading the entire document 
by pressing INSERT+DOWN ARROW to carry out the Say All 
command. To begin skim reading again, press 
CTRL+INSERT+DOWN ARROW.  

Skim Reading Dialog Options 

The options available in the Skim Reading dialog box are described below. 

Use Rule Type 

Select one of the following radio buttons to choose the skim reading mode you 
want to use: 

 Read First Line of Paragraph: When you press CTRL+INSERT+DOWN 
ARROW, MAGic reads the first line of each paragraph.  

Note: The other options in this dialog box are not available if you select 
this radio button. 

 Read First Sentence of Paragraph: When you press 
CTRL+INSERT+DOWN ARROW, MAGic reads the first sentence of each 
paragraph.  

Note: The other options in this dialog box are not available if you select 
this radio button. 
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 Text Rules Apply for Reading: When you press 
CTRL+INSERT+DOWN ARROW, MAGic searches for text according to a 
text rule that you define. MAGic then reads the line, sentence, or 
paragraph that contains the matching text, depending on the option you 
have selected in the Speak Unit list.  

 Attributes and Color Rules Apply for Reading: When you press 
CTRL+INSERT+DOWN ARROW, MAGic searches for text according to 
the selected text color and attributes. The selections made are 
cumulative, meaning that if you select bold and red text, MAGic will only 
search for text that is red and bold. If you add the italic attribute, then 
MAGic will only search for text that is red, bold, and italic. Any text that 
lacks any of these attributes or color is ignored by MAGic.  

Rules History 

This combo box allows you to create a new text reading rule or select an 
existing text reading rule. Text rules are logical expressions that tell MAGic to 
search for specific text when skim reading. MAGic then reads the line, 
sentence, or paragraph that contains the matching text, depending on the 
option you have selected in the Speak Unit list. You must select either the Text 
Rules Apply for Reading radio button or the Attributes and Color Rules Apply 
for Reading radio button if you want to use text rules while skim reading. 

If you are creating a new text rule, select <New> from the combo box and then 
enter the appropriate search pattern, color or attribute rules, or speak unit rules. 
Once the rule is configured, press the Start Skim Reading button to save and 
start the new skim reading rule. 

<New> is the default setting for this combo box. 

Text Search Pattern 

In the Text Rule edit box, enter a word or phrase that you want MAGic to 
search for while skim reading. Optionally, you can use a regular expression to 
further refine your search. There are many different ways to create these 
expressions. If you only want to search for text units that contain two or more 
words, separate each word with ".*" (that is, a period followed by an asterisk 
with no spaces between the words or symbols). For example, you can use the 
following expression to search for text units containing both the words "JAWS" 
and "MAGic": 
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JAWS.*MAGic 

If you want to search for text units that contain any of several different words, 
separate each word with "|" (that is, a vertical bar with no spaces between the 
words or symbols). For example, you can use the following expression to 
search for text units containing either the words "JAWS" or "MAGic": 

JAWS|MAGic 

You can create more advanced expressions as well. For example, you can use 
the following expression to search for text units containing any year starting 
with "19": 

19\d{2}\s 

Tip: For more information on creating complex expressions, refer to 
the section Regular Expression Language Elements in the MSDN 
Library. 

After you enter some text or a regular expression, type a name for the text rule 
in the Rule Name edit box. Choose OK to save the text rule. You can select 
which text rule you want to use in the Text Rules list. 

Color or Attribute Rules 

 Text Color edit box: Use this combo box to select or enter a specific 
color that a passage of text uses. You can use the UP and DOWN 
ARROWS to cycle through a list of text colors, or you can type a color 
into the combo box. MAGic uses word prediction to predict the color that 
you want. An asterisk appears as the default setting.  

 Background Color edit box: Use this combo box to select a background 
color to be used for the skim reading rule. You can use the UP and 
DOWN ARROWS to cycle through a list of text 
colors, or you can type a color into the combo box. MAGic uses word 
prediction to predict the color that you want. An asterisk appears as the 
default setting.  

 Attribute Check Boxes: Select an attribute check box to search for the 
type of selected text in a document or Web page. Each attribute can be 
used in conjunction with any other text attribute. The following attributes 
are available: Bold, Italic, Underline, Strikeout, Double Strikeout, 
Superscript, Subscript, Shadow, and Outline. These check boxes are only 
available when the Attributes and Color Rules Apply for Reading radio 
button is selected.  



142 

Delete Rule 

To delete a text rule, select it in the Rules History list and then choose the 
Delete Rule button. 

Delete All Rules 

To delete all your saved text rules, choose the Delete All Rules button. 

Speak Unit 

Select whether MAGic should read the paragraph, sentence, or line containing 
any text that matches the currently selected text rule. 

Use Regular Expression 

A regular expression is a search string that uses special characters to help you 
define the search and match text patterns. This feature is used primarily by 
advanced users. Do not select this check box if you are simply performing a 
plain text search. This check box is unchecked by default and is only available 
if the Text Rules Apply for Reading radio button is selected. 

Skim Reading Indication 

If you select this check box, MAGic notifies you when skimming past units of 
text that do not match the currently selected text rule. MAGic beeps once for 
every 20 units that it skips. 

Start Skim Reading 

Choose this button to save your changes and begin skim reading from your 
current location. 

Create Summary 

Choose this button to create a summary of the current page in the Results 
Viewer. This summary contains all the text you would hear if you began skim 
reading from your present location using your currently selected options. The 
summary remains available until you create another, even if you switch to 
another document or program  
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Research It 

 

Click to launch Research It. 

Research It is a versatile tool that provides quick access to data while also 
making it easy to return to your primary task. It uses what is known as a lookup 
source and the Results Viewer to find information, whether it is the meaning of 
a word, your local weather forecast, top news stories, sports scores, directions 
to and information about a local business, and more. Using just a few 
keystrokes, you can launch Research It from any application on your computer. 
The following describes keystrokes, available lookup sources, and various 
ways to launch and use Research It. 

Research It On the Fly 

To quickly lookup an item of interest using Research It, do the following: 

1. Press INSERT+SPACEBAR, R. 
The Research It dialog box appears with focus in the Word or Phrase edit 
combo box.  

2. Do one of the following:  

 Type a word, phrase, date, tracking number, or other item into the 
edit combo box, press TAB, and then select a lookup source from 
the list.  

 Select an item from the edit combo box history list, press TAB, and 
then select a lookup source from the list.  

 Press TAB to jump directly to the Lookup Source list, and then 
select a lookup source. (This option is useful when using a news 
lookup source.)  

3. Press ENTER. 
After a few seconds, the Results Viewer window opens and displays the 
search results.   

Note: For specific examples describing how to enter search 
parameters, refer to Research It Examples. 
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Keystrokes 

The following briefly describes the available Research It keystrokes.  

 INSERT+SPACEBAR, R: Opens the Research It dialog box, where you 
can then type a word or expression of interest, and then select a lookup 
source to perform your search. This can be a zip code, or city and state, 
or city and country that can be used with the Weather lookup tool to read 
a forecast, or a date that is used to view baseball or football schedules 
and scores, or a word to use with the Wikipedia search query to view its 
meaning or description. This convenient, layered keystroke provides the 
most efficient way to search for a term. Note: When using this keystroke, 
press and release INSERT+SPACEBAR, and then press R.  

 INSERT+WINDOWS Key+R: Launches Research It and uses the primary 
lookup source to directly show results in the Results Viewer. This 
keystroke bypasses the Research It dialog box. By default, Wiktionary is 
the primary lookup source. This means that while the cursor is on a word 
in a document or Web page, you can press this keystroke and quickly 
lookup the Wiktionary description for that word. You can always change 
the primary lookup source at any time using the Options button in the 
Research It dialog box, which lets you select which lookup source to use 
as the MAGic default or as the default for individual applications. For 
example, if you spend most of your day searching for or working with 
medical terms, the Health Search on WebMD lookup source would be a 
good choice to set as your default. Likewise, if your job requires that you 
frequently lookup UPS tracking numbers, then the UPS Tracking lookup 
source would be a good candidate for your primary lookup source. As you 
become more familiar with Research It, and as more lookup modules are 
created and made available to you, you will want to change the default 
lookup source used by MAGic, or just use a different lookup source on 
the fly.  

 INSERT+CTRL+WINDOWS Key+R: Functions the same as the 
INSERT+SPACEBAR, R keystroke.  

 INSERT+F2, R: Opens Research It from the Run Manager dialog box. It 
provides another way for you to select a lookup source for the word at the 
current cursor location. Note that this is temporary and does not change 
your default settings. MAGic will continue to use the primary lookup 
source the next time you run Research It.  

 ESC: Closes the Results Viewer window and returns to your original 
focus point.  
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Lookup Sources 

MAGic comes with the following lookup sources.  

 Wiktionary: Provides a dictionary description of the word at the current 
cursor location in a document or Web page. You can also use the edit 
combo box to type a word to lookup. Wiktionary is the primary lookup 
source. Refer to the Wiktionary example for more information.  

 Amazon Product Search: Displays search results from Amazon.com® 
for the word or item entered in the edit combo box. Results appear as 
links followed by price and shipping information.  

 Area Code Lookup: Type a U.S. or Canadian area code into the edit 
combo box to learn the city, state, or province location for that area code.  

 BBC Top News Stories: Displays a link and a synopsis of news stories 
as reported by the BBC. Select the link to read the complete story. See 
the News Stories example to help you configure the news search.  

 Bookshare™ Book Search: Displays search results from Bookshare.org 
based on an author’s name, a book’s ISBN number, or words found in a 
book title or book description. If a match is found, the result appears as a 
link containing the author, title, and copyright date.  

 Business Search: Allows you to search for a specific or general 
business in your area using its name or business category and location. 
The location can be in the form of a zip code, city, or city and state. 
Search results will provide the name, address, phone number, and, when 
applicable, Web site link. Always use a semicolon to separate the 
business name or category from the location, for example, pizza; 33716. 
This particular search will return a list of pizza restaurants in and around 
the 33716 zip code. If you know the name and location of a business, 
such as John Doe Plumbing in St. Petersburg, Florida, you can type john 
doe plumbing; st petersburg, florida to retrieve the address and phone 
number. If you would rather see results for more plumbers in your city, 
enter the term plumbers and then the location for a list of these 
businesses in your area.  
Note: Use a comma to separate the city and state location. Also, do not 
use a period when typing city name abbreviations, for example, type St 
Petersburg, or Washington, DC. For more information, refer to the 
Business Search example.  
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 CNN Headline News: Displays a link and a synopsis of news stories as 
reported by CNN Headline News. Select the link to read the complete 
story. To use this lookup source, leave the edit combo box blank, and 
then select it from the list.  

 Convert Currency: Use this lookup source to convert an amount of 
money from one currency into a foreign equivalent. The current day’s 
exchange rate is used to convert the currency values typed into the 
lookup edit field. Note: Three letter abbreviations are used to represent 
international currencies, for example, USD for U.S. dollars, GBP for 
British pounds, or EUR for Euros. To view a list of valid currency 
abbreviations, select the Convert Currency lookup without entering a 
monetary value. Research It will indicate that you must enter valid 
currency values and will then display a list of currency abbreviations for 
numerous countries. Run Convert Currency again, but this time use the 
appropriate currency abbreviations from the previous list. When typing 
currencies and amounts into the lookup edit field, first type the amount 
and currency you are converting from, and then type the currency that 
you are converting to. For example, to convert 100 U.S. dollars into 
British pounds, type 100 USD GBP using a space between each item 
typed. The result will appear similar to 100 U.S. dollars = 61. 2070021 
British pounds. Refer to the Convert Currency example for more 
information.  

 Flight Info Lookup: Provides recent or current flight status when you 
type an airline abbreviation followed by a valid flight number in the edit 
combo box. Two letter abbreviations are used to identify an airline. A list 
of abbreviations will appear in the Results Viewer if you enter an invalid 
airline code, an invalid flight number, or no information in the edit combo 
box. Text typed in the edit combo box is not case-sensitive and can be 
entered with or without a space between the airline abbreviation and flight 
number.  

 Health Search on WebMD: Provides search results from the Web site 
WebMD® for the words entered in the lookup edit field or located at the 
current cursor position in a document or Web page. If a match is found, 
results appear as a link with a brief synopsis. Note: You may be 
interested in using this as your primary lookup source if your job requires 
you to search for and use medical terms.  

 NHL Scores: Reports national hockey league scores and schedules for 
the date entered in the edit combo box. If you do not enter a date, you will 
get today's schedule or game results.  
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 Reuters Top News Stories: Displays a synopsis of the top five news 
stories as reported by Reuters news agency. A link for the complete story 
is also available. To use this lookup source, leave the edit combo box 
blank, and then select it from the list.  

 Stock Quotes: Displays current and up to 52-week historical financial 
information for the stock symbol entered in the edit field or selected from 
a document, spreadsheet, or Web page. To do this, type the stock 
symbol in the edit combo box, and select this lookup source.  

 Technology News from CNET: Displays a link and a synopsis of the 
latest headlines from CNET news. Select the link to read the complete 
story. To use this lookup source, leave the edit combo box blank, and 
then select it from the list.  

 Time Search: Displays the current time and time zone for any location 
typed into the edit field.  
Note: Be specific when entering a location since one name may 
represent multiple cities. For example, if you only type London into the 
edit combo box, you will receive time results for London, England, U.K., 
London, Ontario, Canada, and London, Arkansas, U.S.A. If no result is 
returned, enter another city that is close to the preferred location.  

 UPS Tracking: Returns progress and delivery status information for a 
valid UPS™ tracking number. Type the number in the edit combo box, 
and select this lookup source.  
Note: This lookup source is a good candidate to set as your default if 
your job requires you to frequently track UPS shipments.  

 Weather: Reports the current weather forecast for a city or location 
entered in the edit field. See the Weather example for more information.  

 Wikipedia: Provides encyclopedia results for the word at the current 
cursor location in a document or Web page. You can also use the edit 
combo box to type a word to lookup. See the Wikipedia example for more 
information.  

Research It Examples 

There are several ways to run Research It. You can use the default lookup 
source, or you can select a lookup source from the Research It list. Below is an 
example of how to use the Wiktionary lookup source. For more examples, refer 
to “Research It” in the MAGic help file. For other ideas and ways to use 
Research It, listen to the August 2009 FSCast for a demonstration. 
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Wiktionary 

Imagine that you are reading a document online and you come across an 
unfamiliar word. With Wiktionary set as your primary lookup source, you can do 
the following: 

While the cursor is on that word, press INSERT+WINDOWS Key+R to launch 
Research It. After a few seconds, the Results Viewer window opens and 
displays a Wiktionary-based description of the word.  With the Results Viewer 
open, you can also select and copy the information to the Windows clipboard.  

After reading the description, press ESC to close the Results Viewer, and 
MAGic returns to the cursor location in your document.  

Changing the Default Lookup Source  

The fastest way to change the default lookup source is through the Research It 
dialog box as described in the following steps.  

1. Press INSERT+SPACEBAR, R. The Research It dialog box opens.  

2. Press TAB to move to the Options button, and then press ENTER. The 
Research It Options dialog box opens.  

3. Press the UP or DOWN ARROWS to select a lookup source, and then 
press TAB to move to the Set Primary button.  

4. Press SPACEBAR to make the selected item the primary lookup source, 
and then choose OK to save changes and close the Research It Options 
dialog box.  

Note: After setting a default lookup source, you can use 
INSERT+WINDOWS Key+R, which bypasses the Research It 
dialog box and automatically launches the Results Viewer using 
the new default. You can also continue to use 
INSERT+SPACEBAR, R to run Research It.  

Removing or Adding a Lookup Source 

To remove or add an item to the Lookup Source list, do the following: 

1. Press INSERT+SPACEBAR, R. The Research It dialog box opens.  

2. Press TAB to move to the Options button, and then press SPACEBAR. 
The Research It Options dialog box opens.  

3. Press UP or DOWN ARROWS to select a lookup source, and then do 
one of the following:  
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 To remove a lookup source from the list, press SPACEBAR to clear 
the check box.  

 To add a lookup source to the list, press SPACEBAR to select the 
check box.  

4. Press TAB to move to the OK button and then press ENTER. 

Note: When you update your copy of MAGic, all lookup sources are 
restored and appear in the list box. 

Troubleshooting 

If you have trouble running Research It, and your computer uses a proxy server 
to connect to the Internet, try the following: 

1. While MAGic is running, open Internet Explorer.  

2. Press ALT+T to open the Tools menu and then select Internet Options.  

3. Press CTRL+TAB to navigate to and open the Advanced page.  

4. Press H to navigate to the HTTP 1.1 Settings, and then select both Use 
HTTP 1.1 through proxy connections and Use HTTP 1.1.  

5. Choose OK.  

6. Restart MAGic.  

Keyboard Manager 

 

Click this button to open the Keyboard Manager.  

Use the Keyboard Manager to:  

 Assign keystrokes, or hot keys, to MAGic functions. Hot keys can be 
applied globally or to specific applications.  

 View current hot key assignments  

 Change or remove current hot key assignments  

 Restore default hot key assignments  

 Designate which actions will be available for Speech On Demand  

 Reassign keys on the MAGic Large Print Keyboard  
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 Create shortcuts and associate hot keys to run programs, locate files, and 
open Web pages  

 

 Use the Applications list to select a specific program and view its 
associated functions and hot keys. These functions appear in the Action 
list, and the assigned hot keys appear in the Current Hot Keys list.  

 Use the Category list to further define functions such as magnification, 
speech, and navigation. By using both the Applications and Category 
lists, you can reduce the number of items in the Action list and make it 
more manageable.  A brief explanation of the selected item appears 
below the Action list.  

 Select Speech On Demand to make the action that is currently selected 
in the Action list available when MAGic is configured for Speech On 
Demand operation. This means that when you use the hot keys assigned 
to the action in the list, MAGic will announce the action as it is performed. 
For more information, see Speech On Demand.  
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 Using the Differentiate Between Paired Keys check box, you can 
configure MAGic to treat the left and right paired keys (ALT, CTRL, and 
SHIFT) as separate keys. This means that you can make a hot key that 
uses only the LEFT CTRL key in combination with other keys. The 
RIGHT CTRL key can be used with a different set of key combinations to 
do something entirely different. This distinction allows you to create even 
more hot key combinations.  

 Choose Create Shortcut to make a shortcut that launches an 
application, opens files on your computer or network folder, or opens a 
favorite Web site. For example, you can assign the M1 key (available on 
the MAGic Large Print Keyboard) to open a document that you need to 
regularly access.  

 Finally, you can choose MAGic Key to change the modifier key (CAPS 
LOCK, ALT, SHIFT, CTRL, or WINDOWS Key) used to perform MAGic 
functions from the keyboard.  

Assigning Hot Keys 

To add a hot key, do the following: 

1. Use the Applications and Category lists to reduce the number of items in 
the Action list.  

2. Select an action in the Action list, and click Assign Hot Key or press 
ALT+S. The Assign Hot Key dialog box opens.  

Note: If a hot key is already assigned, it appears in the Current Hot 
Keys list.  

3. Press the combination of keys that you want to assign to the selected 
action. The key combination appears in the Assign To edit box. Choose 
OK to exit the dialog box and return to Keyboard Manager.  

Note: When you assign hot keys to actions, it does not matter whether 
you press the right or left ALT, CTRL, or SHIFT key. However, 
you may want to use only the left or right key so that additional 
key combinations remain available.  

4. To specify the left or right ALT, CTRL, or SHIFT keys for a hot key, select 
the Differentiate Between Paired Keys check box before you activate 
the Assign Hot Key button. For example, you can create a hot key 
combination that uses only the LEFT CTRL key or the RIGHT CTRL key.  
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Note: The hot keys that you assign while this check box is selected will 
always require you to press the correct left or right key. If you 
later clear the check box, previously created hot keys still require 
you to use the correct left or right key. 

5. Choose OK or Apply to save the new hot key assignment.  

To remove a hot key, do the following: 

 Select it in the Current Hot Keys list and click Remove Hot Key or press 
ALT+R. Confirm that you want to delete the hot key.  

To restore default hot keys, do the following:  

 Click Restore Defaults or press ALT+D to return all hot key assignments 
to their original key combinations.  

Creating Shortcuts 
1. Click Create Shortcut or press ALT+O.  

2. In the Assign Hot Key edit field, press the key combination you want to 
use to activate the shortcut.  

3. Type the path to a file, program executable, or Web site address in the 
Location edit field.  

For example, C:\\files\myfile.txt, or http://www.freedomscientific.com. 
Select the Browse button to search for the application or document you 
want to use if you do not know the direct path.  

4. Type a name for the shortcut in the Shortcut Name edit field. This name 
then appears in the Action list.  

Changing Speech On Demand Actions 
1. Select an action in the Action list.  

2. Do one of the following:  

 Select the Speech On Demand check box to make the action 
available when using Speech On Demand mode, or  

 Clear the check box to make the action unavailable when using 
Speech On Demand mode  

3. Choose OK or Apply to save the change.  
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MAGic Large Print Keyboard  

The MAGic Large Print Keyboard contains extra keys that are assigned to the 
most commonly used MAGic functions.  These functions also appear in the 
Action list. When highlighted, an image of the key displays in the Keyboard 
Manager dialog box for easy identification.  Also, in the Current Hot Keys list, 
the prefix Mk is used to identify a key’s default assignment. If you like, you can 
assign other functions to these keys. For example, if you do not use dual 
monitors, you can change the Jump to Next Display key to mute system 
sounds.  

Windows Commands in the Action List 

A list of standard Windows commands for Web browsers, media players, and 
other items are available in the MAGic Keyboard Manager. Select any 
command from the Windows Commands category and assign it a unique 
keystroke (hot key) for use with the MAGic Large Print Keyboard, or a standard 
computer keyboard. For example, you can assign ALT+SHIFT+B to the 
Browse Home action. When using your Web browser, press this hot key to 
return to your home page. 

 Browser Back. Opens the previous Web page in the Web browser.  

 Browser Favorites. Opens the list of Favorites in Internet Explorer or 
Bookmarks in Firefox.  

 Browser Forward. Opens the next Web page in the Web browser.  

 Browser Home. Opens your Web browser’s home page.  

 Browser Refresh. Refreshes (reloads) the current Web page.  

 Browser Stop. Terminates downloading of the current Web page or file in 
your Web browser.  

 Launch Calculator. Starts the Microsoft Calculator.  

 Launch Mail. Starts the default e-mail program.  

 Launch Media Player. Starts the default media player.  

 Launch My Computer. Starts My Computer, which gives access and 
information about your computer’s hardware.  

 Media Next Track. Moves to the next track in the media player.  

 Media Play/Pause. Switches between play and pause in the media 
player.  



154 

 Media Previous Track. Moves to the previous track in the media player.  

 Media Stop. Stops the current track being played in the media player.  

 Microphone Mute. Mutes the microphone.  

 Microphone Volume Down. Decreases the microphone’s input volume 
level.  

 Microphone Volume Up. Increases the microphone’s input volume level.  

 Redo. Repeats the last action.  

 Search. Opens Windows Search so you can search for documents, e-
mails, pictures, and other content on your computer.  

 Undo. Cancels the last action.  

 Volume Down. Decreases the playback volume level of the sound device.  

 Volume Mute. Mutes the playback volume of the sound device.  

 Volume Up. Increases the playback volume level of the sound device.  

Default Speech On Demand Actions 

See Speech On Demand for a list of default Speech On Demand actions.  

Dictionary Manager 

Use Dictionary Manager to change the way MAGic speaks words, phrases, 
abbreviations, or symbols. If MAGic mispronounces your name, for example, 
you can change the pronunciation with the Dictionary Manager. You can also 
assign a sound to play, speak the word in a different language, or any 
combination of these options. MAGic contains a large dictionary of words and 
their pronunciations. As a word is read on the screen, MAGic checks it against 
the dictionary and follows the rules when it speaks the word.  

 

Click this button to open the Dictionary Manager.  

Hot Keys 

Open Dictionary Manager in any application MAGic Key+D 
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Use the Dictionary Manager to add, change, or delete word pronunciation rules. 
You can modify a word so that all applications use the same pronunciation of a 
word by applying changes to the Default Dictionary file (default.jdf), or you can 
create an application specific dictionary file (for example, Word2007.jdf). 

Add a Word to the Dictionary Manager 

Add a word to Dictionary Manager to specify how you want MAGic to 
pronounce that word. 

1. Locate the word in an application and move the active cursor to the 
beginning of the word.  

2. Press MAGic Key+D. If the application does not currently have a 
dictionary (JDF) file, MAGic creates a new file. Press ENTER to accept 
the suggested file name or type a new name and choose OK.  

3. When Dictionary Manager opens, do one of the following: 

 If you want to change how the word is pronounced only in the 
current application, choose the Add button.  

 If you want to change how the word is pronounced in all 
applications, press ALT+F, and then D to open the default 
dictionary file. Next, choose the Add button.  

4. When you choose Add, the Add Dictionary Definition dialog box opens. 
The Actual Word edit box displays the word that was at the location of the 
active cursor when you first opened Dictionary Manager. You may need 
to delete punctuation marks from the end of the actual word. If the word 
you want to add is different than the contents of the edit box, edit or 
replace what is there with the word you want to add.  

5. Press TAB to move to the Replacement Word edit box and type the 
corrected pronunciation. When you add or change a dictionary definition, 
you are telling MAGic how to phonetically pronounce the word. The 
Replacement Word can be a word or a combination of letters and spaces. 
You may need to try several combinations until MAGic speaks the word 
or phrase correctly. Press the access key ALT+A to hear the actual word, 
and press ALT+R to hear the replacement word. If you only want to 
assign a sound or different language to the word, leave the Replacement 
Word edit box blank. However, if you do not type a replacement word 
when assigning a sound, MAGic plays the sound and does not speak the 
word at all. To hear both the word and the sound, type the word as is in 
the Replacement Word edit box.  
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6. If you want MAGic to play a sound when you read this word, choose the 
Select Sound button. Use the ARROW Keys to select the sound you 
want MAGic to play and choose OK. To sample the sound that you 
selected, choose the Play Sound button.  

Tip: The Open Sound dialog box only displays sound files in your user 
and shared settings folders. To use a sound saved in another 
location, choose the Import button. Navigate to the folder where 
the sound is located, select it, and press ENTER to copy the 
sound into your user settings folder. You can then select the 
sound from the list. 

7. If you want MAGic to read the word using a different language, select the 
language in the Language list. The list only displays languages that are 
supported by the active MAGic synthesizer.  

8. When you are satisfied with the way MAGic speaks the word, press 
ENTER to accept the change.  

9. Press ALT+F, and then S to save your changes to the MAGic dictionary 
file. MAGic saves new or modified dictionary files in your user settings 
folder. Press ALT+F, and then X to close the Dictionary Manager.  

Root Word Pronunciation Changes 

Dictionary Manager also lets you specify the root of a word, and have all the 
extensions of it pronounced correctly. So with one entry, you could change the 
pronunciation of "reposition," "repositioning," and "repositions." Just follow the 
steps above, but add an asterisk (*) at the end of the word in the Actual Word 
edit box within Dictionary Manager. Type in the replacement word as normal. 
For example, type "reposition*" in the Actual Word edit box, and type "re 
position" in the Replacement Word edit box. 

Change or Delete Existing Entries in the Dictionary 
Manager 

You can change or delete entries that you have added to the current dictionary 
file. To change an entry, select it in the Dictionary Entries list. If the list of 
entries is long, you can search for the word by typing it into the Search for 
Entries edit box. After you select the entry you want to change or delete, 
choose either the Change or Delete button. Choosing the Change button opens 
the Change Dictionary Definition dialog box. You can then make any changes 
to the entry. 
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Similarly, you can choose the Delete button to delete the selected dictionary 
entry. MAGic prompts you to confirm your choice to delete the entry.  

When you have finished changing or deleting entries, press ALT+F, and then X 
to save your changes to the dictionary file. 

Dictionary Entries Tree Menu  

The Dictionary Entries tree view contains a list of all rules for the current 
Dictionary Manager. In addition to creating rules for specific words, rules can 
also be defined to restrict the rule to a particular language, synthesizer, or 
voice. If such a rule exists, the language will appear at the top of the tree view. 
The language rules restrict the dictionary rule to text spoken in the language. 
Use the RIGHT ARROW key to expand the tree for a specific language to 
access language specific rules. Further restrictions within the language can 
apply to specific synthesizers.  The synthesizer rules restrict the dictionary rule 
to text spoken with a specific synthesizer. Use the RIGHT ARROW key to 
expand the tree for a specific synthesizer to access synthesizer specific rules. 
Further restrictions within the synthesizer can apply to specific synthesizer 
voices.  The voice rules restrict the dictionary rule to text spoken with a specific 
synthesizer voice. Use the RIGHT ARROW key to expand the tree for a 
specific synthesizer voice to access synthesizer voice specific rules. Use the 
LEFT ARROW to collapse items, and use the UP and DOWN ARROW keys to 
move through and select items in the tree view. First letter navigation is also 
available so that you can quickly jump to an item in the tree view.  

Shared Dictionary Files 

MAGic allows you to have both user and shared versions of a dictionary file for 
the same application. MAGic applies the settings in user dictionary files only 
when a particular user is logged on to the computer. The settings in shared files 
apply to all users on the computer or network. This allows system 
administrators to create dictionary entries for all users on a network or 
computer. If a user creates a modified version of a shared dictionary file, those 
settings override the shared settings while that user is logged on the computer.  

To locate shared dictionary files, choose the Windows Start button, and then 
select: 

All Programs > MAGic X (where X is the MAGic version number) > Explore 
MAGic > Explore Shared Settings.  

To locate your user dictionary files, choose the Windows Start button, and then 
select: 
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All Programs > MAGic X (where X is the MAGic version number) > Explore 
MAGic > Explore My Settings.  

Dictionary Manager Menu Bar 

The Dictionary Manager menu bar has three items: File, View, and Help. 

File Menu 

In the File menu, you have the following options: 

New - Choose New to add Dictionary files for applications that do not already 
have .jdf files. After you choose this command, type a name for this dictionary 
file and press ENTER.  

Note: Pressing MAGic Key+D while in the current application 
automatically opens a new dictionary file if one does not exist for 
that application. 

Open - If you want to make a change to the Dictionary files for several 
applications, select the .jdf file for the application from the Open File dialog and 
press ENTER to open the Dictionary file. You can then add, change, or delete a 
dictionary entry for that application. The list of files contains both shared and 
user files located in the MAGic settings folders. To copy a dictionary file from 
another location into your user settings folder, choose the Import button.  

Save - Saves the dictionary file after changes are entered. If the file is 
unnamed, a Save As dialog box opens. It is important to name the file with the 
same name as the program file. MAGic will save the file with the extension .jdf.  

Open Default File - If you want the word to be spoken the same way in every 
application, choose Open Default File (CTRL+SHIFT+D) to add, change, or 
delete default dictionary entries.  

View Menu 

In the View menu, you have the following options:  

Toolbar - Press ENTER to display or hide a basic toolbar menu in the 
Dictionary Manager dialog.  

Status Bar - Press ENTER to display or hide the status of the current 
processing request. 
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Display Full Path - Press ENTER to display or hide the complete current file 
location. 

Help Menu 

In the Help menu, you have the following options: 

Help Topics - This option opens MAGic help to the Dictionary Manager help 
topics. 

About Dictionary Manager - This option displays information about the 
specific Dictionary Manager version. 

Quick View Frame 

The Quick View Frame feature allows you to specify regions of the screen 
(called frames) that you can monitor while you work in other areas. MAGic can 
display one of these frames in the magnified area so you can see any changes 
or updates to that part of the screen. To choose which frame you want to 
display, or to customize the frame's position, border color, and color 
enhancements, choose the Main menu, and then Tools followed by Quick 
View Frame. 

Properties  

The Properties tab allows you to select or modify the active frame and change 
the frame’s position and border color. 
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Enable Quick View Frame 

Select the Enable Quick View Frame check box to display the active frame on 
your screen in the location specified in the Frame Position list. Clear this 
check box to hide the Quick View Frame.  

Tip: You can also press MAGic Key+Q to turn the Quick View Frame 
on or off.  

Active Frame 

In the Active Frame list, choose the frame that you want MAGic to display. You 
can create and save any number of frames and then choose the frame the best 
suits your current needs. To create a frame, do the following:  

Move the mouse pointer to the top left corner of the region you want to enclose 
within the frame and press MAGic Key+LEFT BRACKET.  

Move the mouse pointer to the bottom right corner of the region and press 
MAGic Key+RIGHT BRACKET.  
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Tip: To quickly create a frame that is automatically sized to fit a dialog 
box option, move your pointer to the option and press MAGic 
Key+LEFT BRACKET twice quickly. 

Type a name for this frame, then click OK or press ENTER. This is the name 
that will appear in the Active Frame list.  

Ensure that the frame is positioned over the area of the screen that you want to 
monitor. You can move the frame to another location by dragging the frame’s 
title bar.  

If you want to resize the frame, move your pointer over a corner or edge of the 
frame border. When the pointer changes to a double-headed arrow, drag the 
border in the desired direction.  

When you have finished resizing and positioning the frame, click Close on the 
Quick View Manager toolbar (located in the top left corner of the screen) or 
press ESC. Choose Yes when MAGic asks if you want to save your changes.  

Tip: You can press MAGic Key+9 to open the Quick View Manager 
and view/modify any frames you have saved. 

Border Color 

Choose a color for the border of the active frame from the Border Color list. 

Frame Position 

Use the Frame Position list to determine where you want the active frame to 
appear on your screen.  

Modify Active Frame Button 

Click Modify Active Frame or press ALT+M to resize or move the frame you 
selected in the Active Frame list. Drag the frame’s title bar to move it to 
another part of the screen. To resize the frame, move your pointer over a 
corner or edge of the frame border. When the pointer changes to a double-
headed arrow, drag the border in the desired direction. 
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Color 

The Color tab lets you apply color enhancements to the active frame. You can 
adjust the brightness and contrast, create color switching rules, apply tinting, 
and more. The options available on this tab are identical to those in the Color 
Enhancements dialog box. For more information on these options, refer to 
Color Enhancements. 

 

Clipboard Text Viewer 

The Clipboard is a Windows feature that allows you to copy items from one 
location and then paste them in another location. You can copy text from 
documents, Web pages, form fields, edit boxes, and any other place where you 
can select text.  

The Clipboard Text Viewer window displays all text that has been copied to the 
Windows Clipboard using the Windows Copy (CTRL+C) and Cut (CTRL+X) 
commands. You can also use the Append to Clipboard command (MAGic 
Key+WINDOWS Key+C) to append additional text to the current contents of 
the Clipboard. This is a useful feature in that,  

1. It does not overwrite the current contents of the Clipboard.  

2. It allows you to continue adding text to the Clipboard until you are ready 
to paste it into a document.  
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To open the Clipboard Text Viewer and view all text currently on the clipboard, 
press MAGic Key+SPACEBAR, followed by C. You can then select and copy 
specific blocks of text displayed in the viewer and paste it in other applications.  

When you close the viewer, the current content is deleted. Also, the Clipboard 
content is overwritten with new text when you use the Windows Copy or Cut 
commands. A message displays indicating that the current text in the viewer 
will be overwritten.  

MAGic Clipboard Commands 

Open or Refresh Clipboard 
Text Viewer 

MAGic Key+SPACEBAR, followed by C 

Append to Clipboard MAGic Key+WINDOWS Key+C 

Say Contents of Clipboard MAGic Key+X 
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Chapter 12 

MAGic Hot Keys 

In addition to the menus, magnification, and speech buttons, there are a 
number of keyboard hot keys you can use at any time to read text, change how 
MAGic magnifies your screen, or perform a variety of other functions.  

The default MAGic Key is the CAPS LOCK key on your keyboard.  

Note: Some actions have more than one hot key associated. The 
alternative hot key is listed for laptop users. The alternative hot 
keys do not use the extended number pad. Also if your NUM 
LOCK is turned on, then you should use the alternative hot keys, 
or we suggest you turn off NUM LOCK . 

General 

Launch MAGic CTRL+ALT+M 

Display/Hide MAGic 
User Interface 

MAGic Key+U 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Open MAGic Context 
Menu 

MAGic Key+APPLICATION Key or  
MAGic Key+RIGHT MOUSE BUTTON CLICK  

Quick Settings MAGic Key+O 

Magnification, Views, & Enhancements 

Increase Magnification 

MAGic Key+NUM PAD PLUS or  
CTRL+EQUALS or  
MAGic Key+MOUSE WHEEL UP (roll the scroll 
wheel up or away from you while holding MAGic 
Key) 
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Decrease 
Magnification 

MAGic Key+NUM PAD MINUS or  
CTRL+DASH or  
MAGic Key+MOUSE WHEEL DOWN (roll the 
scroll wheel down or towards you while holding 
MAGic Key)  

Magnification Toggle 
On/Off 

MAGic Key+DELETE 

Toggle between 1x 
Magnification and 
Current Magnification  

MAGic Key+SHIFT+DELETE or  
MAGic Key+MOUSE MIDDLE CLICK (press 
down on scroll wheel while holding MAGic Key)  

Switch to Next 
Magnified View 

MAGic Key+NUM PAD SLASH 

Switch to Previous 
Magnified View 

MAGic Key+SHIFT+NUM PAD SLASH 

Change Text 
Smoothing View (HD 
Text, Classic, and 
None) 

MAGic Key+CTRL+F 

Toggle Color 
Enhancements On/Off  

MAGic Key+F12 

Toggle Cursor 
Enhancements On/Off 

MAGic Key+F8 

Toggle Mouse 
Enhancements On/Off 

MAGic Key+F4 

Toggle Focus 
Enhancements On/Off 

MAGic Key+F 
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Panning and Screen Movement 

Pan Right MAGic Key+RIGHT ARROW 

Pan Left  MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during 
Panning 

NUM PAD PLUS 

Decrease Speed 
during Panning 

NUM PAD MINUS 

Move to Left Edge of 
Screen 

MAGic Key+HOME 

Move to Right Edge of 
Screen 

MAGic Key+END 

Move to Top of Screen MAGic Key+PAGE UP 

Move to Bottom of 
Screen 

MAGic Key+PAGE DOWN 

Move to Beginning of 
Next Line 

MAGic Key+ENTER 

Tracking 

Tracking Toggle 
On/Off 

MAGic Key+R 

Move View to Mouse 
Pointer 

MAGic Key+NUM PAD 5 

Move View to Cursor MAGic Key+SHIFT+NUM PAD 5 
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Cursor Movement 

Route Cursor to 
Mouse 

INSERT+NUM PAD PLUS 

Route Mouse to 
Cursor 

INSERT+NUM PAD MINUS 

Locator Mode 

Start Locator MAGic Key+F10 

Stop Locator and 
Move to Selected Area 

ENTER 

Stop Locator without 
Moving the Magnified 
Area 

ESC 

Move Left LEFT ARROW 

Move Right  RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to Far Left Side 
of Screen 

HOME 

Move to Far Right 
Side of Screen 

END 

Move to Top of Screen PAGE UP 

Move to Bottom of 
Screen 

PAGE DOWN 
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Quick View Frame 

Toggle Quick View 
Frame On/Off 

MAGic Key+Q 

Set upper left corner of 
frame 

MAGic Key+LEFT BRACKET 

Set lower right corner 
of frame 

MAGic Key+RIGHT BRACKET 

Create frame around 
current dialog box 
option 

MAGic Key+LEFT BRACKET twice quickly 

Open Quick View 
Manager 

MAGic Key+9 

Speech  

Silence Current 
Speech 

CTRL 

Toggle Full Speech or 
Speech On Demand  

MAGic Key+F3 

Increase Speech Rate 
and Save New Rate 

WINDOWS Key+ALT+CTRL+PAGE UP 

Increase Speech Rate 
- Temporary  

ALT+CTRL+PAGE UP 

Decrease Speech 
Rate and Save New 
Rate 

WINDOWS Key+ALT+CTRL+PAGE DOWN 

Decrease Speech 
Rate - Temporary 

ALT+CTRL+PAGE DOWN 

Voice Profiles Toggle MAGic Key+F11 

Select Language WINDOWS Key+CTRL+L 
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Set Screen Echo INSERT+S 

Select Verbosity 
Scheme 

INSERT+ALT+S 

Document and Text Reading 

Read All From 
Location (Say All)  

INSERT+DOWN ARROW or  
MAGic Key+A or  
MAGic Key+LEFT MOUSE BUTTON CLICK  

Fast Forward During 
Say All  

RIGHT ARROW 

Rewind During Say All  LEFT ARROW 

Increase and Save 
New Speech Rate 
During Say All 

PAGE UP 

Decrease and Save 
New Speech Rate 
During Say All 

PAGE DOWN 

Read Active Window 
(reads from the 
beginning of document 
window) 

INSERT+DOWN ARROW (twice) 

Say Currently 
Selected Text 

INSERT+SHIFT+DOWN ARROW 

Say Current Character NUM PAD 5 

Say Current Word 
MAGic Key+ALT or  
INSERT+NUM PAD 5 

Spell Current Word 
MAGic Key+ALT (twice) or  
INSERT+NUM PAD 5 (twice) 

Say Next Word INSERT+RIGHT ARROW 
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Say Prior Word INSERT+LEFT ARROW 

Say Current Line 
MAGic Key+L or  
INSERT+UP ARROW 

Say Next Line DOWN ARROW 

Say Prior Line UP ARROW 

Read to Cursor INSERT+HOME 

Read from Cursor INSERT+PAGE UP 

Say Current Sentence MAGic Key+S 

Say Next Sentence MAGic Key+CTRL+S 

Say Current 
Paragraph 

MAGic Key+P 

Say Next Paragraph 
MAGic Key+CTRL+P or  
CTRL+DOWN ARROW 

Say Prior Paragraph 
MAGic Key+ALT+P or  
CTRL+UP ARROW 

Say Contents of 
Clipboard 

MAGic Key+X 

Skim Read INSERT+CTRL+DOWN ARROW 

Skim Reading 
Preferences 

INSERT+CTRL+SHIFT+DOWN ARROW 

Note: When using the document and text reading commands, if you 
move the mouse MAGic reads from the current location of the 
mouse pointer. If you move the insertion point, MAGic reads from 
the location of the insertion point.  
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Text Viewer 

Toggle Text Viewer on 
or off 

MAGic Key+CTRL+V 

Toggle Text Viewer 
position 

MAGic Key+CTRL+DOWN ARROW 

Pan Right MAGic Key+CTRL+RIGHT ARROW 

Pan Left MAGic Key+CTRL+LEFT ARROW 

Switch Text Viewer 
between monitors 

WINDOWS Key+CTRL+RIGHT ARROW 

Dialog Box Reading 

Read Title Bar 
MAGic Key+T or  
INSERT+T 

Read Bottom of 
Window 

INSERT+PAGE DOWN 

Say Top Line of 
Window 

INSERT+END 

Say Default Button in 
Dialog Box 

INSERT+E 

Say Window Prompt 
and Text 

MAGic Key+TAB or  
INSERT+TAB 

Say Current Access 
Key 

SHIFT+NUM PAD 5 

Table Reading 

Say Current Cell ALT+CTRL+NUM PAD 5 

Say Cell to Right ALT+CTRL+RIGHT ARROW 
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Say Cell to Left ALT+CTRL+LEFT ARROW 

Say Cell Below ALT+CTRL+DOWN ARROW 

Say Cell Above ALT+CTRL+UP ARROW 

Say First Cell ALT+CTRL+HOME 

Say Last Cell ALT+CTRL+END 

Say First Cell in 
Column 

ALT+CTRL+SHIFT+UP ARROW 

Say Last Cell in 
Column 

ALT+CTRL+SHIFT+DOWN ARROW 

First Cell in Row ALT+CTRL+SHIFT+LEFT ARROW 

Last Cell in Row ALT+CTRL+SHIFT+RIGHT ARROW 

Typing Echo 

Cycle through Indicate 
Capitalization options 

MAGic Key+F2 

Cycle through Typing 
Echo Unit options 

INSERT+2 

Mouse Echo 

Mouse Echo Toggle  MAGic Key+M 

Note: Toggling the mouse echo rotates between speak lines, speak 
words, and mouse echo off. 

Navigation Quick Keys 

Toggle Navigation 
Quick Keys On/Off 

MAGic Key+Z or INSERT+Z 
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Error Reporting and Recovery 

Submit Error Report  
(Close, restart MAGic, 
submit report) 

INSERT+WINDOWS Key+F4 

Recover MAGic MAGic Key+WINDOWS Key+F8 

Some actions in MAGic do not have hot keys assigned. You can define hot 
keys for many of these features from within the Keyboard Manager.  
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Chapter 13 

Layered Keystrokes 

MAGic layered keystrokes offer a fast and convenient way to perform an action 
or navigate tables. These keystrokes reduce the number of keys that you need 
to hold down at once to perform an action. 

 For specific Word commands, see Word Layered Keystrokes.  

 For specific Excel command, see Excel Layered Keystrokes.  

General Layered Keystrokes 

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by the keystrokes listed below to perform the action.  

Full Speech or Speech On 
Demand 

S 

Launch Research It R 

Screen Capture of Entire Screen CTRL+C, S 

Screen Capture of Active 
Window 

CTRL+C, W 

Open Clipboard Text Viewer C 

Exit Layered Keystroke mode ESC or SPACEBAR or TAB or ENTER 

Mouse Echo Layered Keystrokes 

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by the keystrokes listed below to speak the text that you point to with 
the mouse pointer.  

Toggle Mouse Echo E, O 

Echo Character E, C  

Echo Word E, W  
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Echo Line E, L  

Echo Paragraph  E, P  

Help Message  E, QUESTION MARK 

Exit Layered 
Keystroke mode 

ESC or SPACEBAR or TAB or ENTER 

Table Layered Keystrokes 

Press and release MAGic Key+SPACEBAR or INSERT+SPACEBAR, 
followed by the keystrokes below to navigate and read tables.  

List Keystrokes 
Available in this Layer 
(Help) 

T, SHIFT+SLASH 

Move to Cell Above 
T, UP ARROW or  
T, ALT+CTRL+UP ARROW 

Move to Cell Below 
T, DOWN ARROW or  
T, ALT+CTRL+DOWN ARROW 

Move to Prior Cell  
T, LEFT ARROW or  
T, ALT+CTRL+LEFT ARROW  

Move to Next Cell  T, RIGHT ARROW 

Say Current Cell 
T, NUM PAD 5 or  
T, ALT+CTRL+NUM PAD 5 or  
T, ALT+COMMA 

Move to Beginning of 
Current Row 

T, HOME or 
T, CTRL+LEFT ARROW or  
T, ALT+CTRL+SHIFT+LEFT ARROW 

Move to End of 
Current Row 

T, END or  
T, CTRL+RIGHT ARROW or  
T, ALT+CTRL+SHIFT+RIGHT ARROW 
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Move to First Cell in 
Table 

T, CTRL+HOME or  
T, ALT+CTRL+HOME 

Move to Last Cell in 
Table 

T, CTRL+END or  
T, ALT+CTRL+END 

Move to Top of 
Current Column 

T, CTRL+UP ARROW or  
T, ALT+CTRL+SHIFT+UP ARROW 

Move to Bottom of 
Current Column 

T, CTRL+DOWN ARROW or  
T, ALT+CTRL+SHIFT+DOWN ARROW 

Move to Beginning of 
Current Row 

T, CTRL+LEFT ARROW 

Move to End of 
Current Row 

T, CTRL+RIGHT ARROW 

Jump to Next Table 
T, CTRL+ENTER or  
T, ALT+CTRL+ENTER 

Jump to Prior Table 
T, CTRL+SHIFT+ENTER or  
T, ALT+CTRL+SHIFT+ENTER 

Read Current Row 
T, SHIFT+UP ARROW or  
T, WINDOWS Key+COMMA 

Read from Current 
Cell 

T, SHIFT+PAGE UP 

Read to Current Cell T, SHIFT+HOME 

Read Current Column 
T, SHIFT+NUMPAD 5 or  
T, WINDOWS Key+PERIOD 

Read to Bottom of 
Column 

T, SHIFT+PAGE DOWN 

Read from Top of 
Column 

T, SHIFT+END  
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Jump to Previous Cell  
T, WINDOWS Key+J or  
T, CTRL+SHIFT+WINDOWS Key+J 

Exit Layered 
Keystroke mode 

ESC or SPACEBAR or TAB or ENTER 
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Chapter 14 

Navigation Quick Keys 

Navigation Quick Keys allow you to move easily and quickly around Web 
pages, Adobe Acrobat PDF files, application help files, and so on. The following 
examples highlight what you can do with Navigation Quick Keys: 

 When reading a Web page in Internet Explorer, pressing the letter H 
moves focus to the next heading, reads it aloud, but it also provides a 
visual indication of where you are on the Web page.  

 The Navigation Quick Key P moves you to the next paragraph and begins 
reading using a synchronized reading box to make it easier to know 
where MAGic is reading. As you navigate around Web pages, a visual 
box appears around each line that is read.  

Note: Navigation Quick Keys are off by default. To toggle Navigation 
Quick Keys on and off, press MAGic Key+Z. You can also 
change the default setting using Quick Settings as described later 
in this topic.  

MAGic Navigation Quick Keys 

The following is a list of Navigation Quick Keys that are available when running 
MAGic. 

Note: If you press and hold the SHIFT key in combination with a keystroke 
below, MAGic moves to the previous unit or element. For example, if B moves 
to the next button on a Web page, then SHIFT+B moves to the previous button.  

 A – Next Radio Button  

 B – Next Button  

 C – Next Combo Box  

 E – Next Edit Control  

 F – Next Form Control  

 G – Next Graphic  

 H – Next Heading  
(Press 1 - 6 on the number row to jump to the next heading at that level.)  

 L – Next List  



180 

 P – Next Paragraph  

 Q – Move to the Main Region of a Page  

 R – Next Region  

 T – Next Table  

 X – Next Checkbox  

 SEMICOLON – Next OnMouseOver  

 CTRL+WINDOWS Key+J – Jump to Table Cell  

Using Quick Settings to Toggle Navigation Quick Keys On and 
Off  

1. With focus in your Web browser or PDF file, press MAGic Key+O.  

2. In the Search box, type "Navigation Quick Keys" without the quotes and 
press ENTER.  

3. Next, press SPACEBAR to toggle the Navigation Quick Keys option from 
off to on. (To turn off Navigation Quick Keys, repeat this step.)  

4. Press ENTER to close Quick Settings.  
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Chapter 15 

MAGic Large Print Keyboard 

The MAGic Large Print Keyboard contains extra keys that are assigned to the 
most commonly used MAGic functions. Its large, contrasting letters also make it 
easier to type and use MAGic hot keys. The following describes the MAGic 
keys on the keyboard. You can also use the Keyboard Manager to customize 
and reassign hot keys to other MAGic features. 

Note: If installing and using the keyboard for the first time, make sure to 
install the keyboard driver before using MAGic so that you can 
take advantage of the extra MAGic keys. Refer to the keyboard's 
user documentation for more information. 

 

 

Launch MAGic: Starts MAGic if it is not running. If 
MAGic is running, this key initiates shutting down MAGic.  

 

Visual Enhancements: Toggles on or off, all of MAGic’s 
visual enhancements including magnification, mouse 
enhancements, color enhancements, focus 
enhancements, and cursor enhancements.  

 

Toolbar: Shows or hides the MAGic toolbar, which is also 
known as the MAGic user interface.  

 

Mouse Enhancements: Turns mouse enhancements on 
or off. When enabled, mouse enhancements make the 
mouse pointer easier to track and maneuver on the 
screen.  

 

Cursor Enhancements: Turns cursor enhancements on 
or off. When enabled, this makes the cursor easier to 
locate and follow when writing or editing text.  
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Color Enhancements: Turns color enhancements on or 
off. When enabled, this affects how MAGic displays colors 
on the screen. Color enhancements can be adjusted to 
meet individual needs for handling glare and contrast.  

 

Focus Enhancement: Turns the focus enhancement on 
or off. When enabled, this displays a rectangular border 
that identifies and tracks the control that currently has the 
computer focus such as the highlighted item in a menu or 
the selected control in a dialog box.  

 

Text Viewer: Turns the Text Viewer on or off. When 
enabled, the Text Viewer window displays across the 
screen and simultaneously shows the same text that 
appears on the magnified screen.  

 

Mag Level Toggle: Switches between the current 
magnification level and 1x magnification. All visual 
enhancements will remain active.  

 

Research It: Starts the Research It feature. Use it to 
easily search the Web for words, local weather forecast, 
news stories, local businesses, and more.  

 

Links List: Opens a dialog box containing a list of links in 
the current Web page or Word document.  

 

Select and Say: Reserved for a future MAGic feature. 
You can assign this key to a MAGic function, shortcut, or 
Windows command using the MAGic Keyboard Manager. 
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M1: This key is reserved for users to assign to their 
preferred MAGic functions, shortcuts, or Windows 
commands using the MAGic Keyboard Manager.  

 

M2: This key is reserved for users to assign to their 
preferred MAGic functions, shortcuts, or Windows 
commands using the MAGic Keyboard Manager. 

 

M3: This key is reserved for users to assign to their 
preferred MAGic functions, shortcuts, or Windows 
commands using the MAGic Keyboard Manager. 

 

Mouse Echo: Turns mouse echo on or off. To specify 
whether characters, lines, words, or paragraphs are 
spoken when you move the mouse, open the Mouse 
Echo dialog box from the Speech menu, or right-click the 
Mouse Echo button on the MAGic user interface and 
select the option you want. The default setting is to echo 
lines. When turning mouse echo off and back on, the 
currently selected option is used.  

 

Typing Echo: Turns typing echo on or off. To specify 
whether MAGic speaks characters, words, or both 
characters and words as you type text, open the Typing 
Echo dialog box from the Speech menu, or right-click the 
Typing Echo button on the MAGic user interface and 
select the option you want. When turning typing echo off 
and back on using the Typing Echo key, the currently 
selected option is used.  

 

Speech Toggle: Toggles between having speech on all 
the time (full speech) versus having limited speech 
(Speech On Demand).  
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Jump to Next Display: When using dual monitors, this 
key allows users to quickly move the computer focus and 
the mouse pointer to the other monitor.  

 

View Lock: When using dual monitors, press and hold 
while moving the mouse pointer across the screen or to 
another monitor without scrolling the display. This 
provides a smooth transition from one monitor to the other 
without shifting the view on the screen. Users can use this 
key to easily drag items from one monitor to the other, 
such as moving applications or copying text from one 
application to another. Release the key to resume normal 
mouse pointer movement. On single monitor systems, 
pressing this key locks the current view, preventing the 
mouse from moving outside the view or scrolling the 
screen.  

Top half of  

Wheel Up: Increase the level of magnification by rolling 
the keyboard scroll wheel toward the top of the keyboard.  

Bottom half of  

Wheel Down: Decrease the level of magnification by 
rolling the keyboard scroll wheel toward the bottom of the 
keyboard.  

 

Decrease Rate: Slows down the rate of MAGic speech. 

 

Increase Rate: Increases the rate of MAGic speech. 
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Chapter 16 

Mouse and Keyboard Control 

With MAGic, you can use both your mouse and your keyboard to access most 
features. You decide what is best for you. Many people use a combination of 
the two. The MAGic documentation gives you information on how to perform 
actions with both the keyboard and the mouse. For example, to toggle Visual 
Enhancements on and off, you can either press MAGic Key+DELETE, or you 

can point and click the Visual Enhancements button  with the mouse.  

Using the Keyboard with MAGic 

The MAGic Key 

When you use the keyboard in MAGic, the most important thing to know is the 
MAGic Key. The default MAGic Key is the CAPS LOCK key on your 
keyboard. Press the MAGic Key in combination with other keys to carry out 
MAGic commands. You can specify what key you use for your MAGic Key in 
the MAGic Key dialog box, which is activated by choosing the Tools menu, 
selecting the Keyboard Manager, and then selecting the MAGic Key button.  

Pass the MAGic Key Through 

If your MAGic Key is set to the default of CAPS LOCK, how do you use your 
CAPS LOCK key as usual?  

Press the CAPS LOCK key twice quickly, and caps lock turns on.  

To turn off caps lock, press the key twice quickly. Use this double key press to 
pass through any of the MAGic Keys that you use. For instance, if you select 
INSERT as your MAGic Key, press the INSERT key twice to use the actual 
insert function.  

Pass Through Key Command  

If you have an application that uses the same keystroke combination as one 
assigned to MAGic, you can pass the keystroke combination through to the 
application, so it will not function as a MAGic keystroke in that instance.  
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Press MAGic Key+3 (on the numbers row), and then press the keystroke you 
want to use in the application. Use the Pass Through Key command for any 
key combination that is used in MAGic and in other applications.  

Keyboard Manager 

With MAGic, you can customize all of your keystrokes using Keyboard 
Manager, activated by choosing the Keyboard Manager button in the Tools 
tab. If you specify certain keystrokes for use in MAGic, you may need to use 
these keystrokes in other applications. Keep the Pass Through Key command 
of MAGic Key+3 in mind when you customize keystrokes. 

MAGic Large Print Keyboard 

A large print keyboard is available for use with MAGic. It contains extra keys 
that are assigned to the most commonly used MAGic functions.  Its large, 
contrasting letters make it easier to type and use MAGic hot keys. You can also 
use the Keyboard Manager to customize and reassign keys to other MAGic 
features. For more information, refer to MAGic Large Print Keyboard.  

Using the Mouse with MAGic 

Point and Click 

With MAGic you don’t have to learn keystrokes to perform actions. You can use 
the mouse to point at items on the user interface, and click the buttons to 
activate features. For example, to enable mouse enhancements, just point at 
the Mouse Enhancements button and press the LEFT MOUSE BUTTON. 

If you are not sure how to activate a feature, use your mouse to open the 
menus and find the feature you need.  

Left-Click vs. Right-Click 

The left mouse button is the more commonly used mouse button, because it 
activates buttons and menus.  

You can use the right mouse button and MAGic Key (press MAGic 
Key+RIGHT MOUSE BUTTON) to display the MAGic Context Menu. This 
menu allows you to quickly access many useful MAGic commands. If you are 
not a mouse user, you can press MAGic Key+APPLICATION Key to see the 
menu.  
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Mouse Wheel Commands 

If your mouse has a mouse wheel between the left and right buttons, you can 
use it to perform a variety of useful MAGic commands: 

 Hold down the MAGic Key while rolling the MOUSE WHEEL UP to 
increase the current magnification level.  

 Hold down the MAGic Key while rolling the MOUSE WHEEL DOWN to 
decrease the current magnification level.  

 Hold down the MAGic Key and click the MOUSE WHEEL (or MIDDLE 
MOUSE BUTTON) to switch from the current magnification level to 1x 
magnification. Perform this command again to switch back to your 
previous magnification level.  

MAGic Key 

Pressing the MAGic Key in combination with other keys activates a MAGic 
command if one is assigned, otherwise it will pass the key combination through 
to the application. Pressing the MAGic Key by itself and releasing it will not 
carry out any action.  

The default MAGic Key is CAPS LOCK. To assign a different key, do the 
following.  

1. From the Tools tab, choose Keyboard. The Keyboard Manager opens. 

2. Choose MAGic Key and then select any of the following other options:  

 Extended INSERT (found on the six pack)  

 NUM PAD INSERT  

 Either INSERT  

 SCROLL LOCK (the key just above HOME on the six pack).  
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Chapter 17 

Utilities 

MAGic Utilities and Program Group 

MAGic has several utilities that you can quickly access to view license 
information, configuration and settings files, and help topics.  

From the Windows 7 Start menu, choose All Programs, and then MAGic 
<version number>. The contents of the MAGic program group display in the 
MAGic submenu. 

From the Windows 8.1 Start screen, type "utilities MAGic" without the quotes, 
and then select "Utilities - MAGic <version number>" in the Search list. The 
Utilities folder displays.  

Below is a brief description of the MAGic utilities.  
  

Windows 7 Utility Windows 8.1 Utility Description 

Help Help Opens the MAGic help file 

MAGic Not available Launches the MAGic program 

Tools folder Not available 

Windows 7 only. Contains the 
Dongle Viewer, ILM Authorization 
Viewer, Remove Product 
Activation, Uninstall MAGic, and 
MAGic Network Administrator 
utilities 

Dongle Viewer 
(Tools folder) 

Dongle Viewer 
Allows you to view license 
information for the dongle currently 
connected to your computer 
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Windows 7 Utility Windows 8.1 Utility Description 

ILM 
Authorization 
Viewer 
(Tools folder) 

ILM Authorization 
Viewer 

Allows you to view details of your 
ILM software licenses 

Remove 
Product 
Activation 
(Tools folder) 

Remove Product 
Activation 

Allows you to delete your ILM 
licenses for all versions of MAGic 
installed on this computer. Until you 
acquire a new license, you will only 
be able to use MAGic in 40 minute 
mode.  

Uninstall 
MAGic 
(Tools folder) 

Not available 
Use to uninstall MAGic from your 
computer 

MAGic Network 
Administrator 
(Tools folder) 

MAGic Network 
Administrator 

Network administrators use this to 
add, delete, and modify user 
settings of MAGic in a Network 

Explore MAGic 
folder 

Not Available 

Windows 7 only. Contains the 
Explore My Settings, Explore 
Program Files, and Explore Shared 
Settings folders. These provide 
shortcuts to your user settings, 
shared settings, and program files. 

Explore My 
Settings 
(Explore 
MAGic folder) 

Explore My 
Settings 

Opens the folder containing your 
user-specific MAGic settings. When 
you create new schemes or modify 
factory schemes, MAGic saves 
them in this folder. Your custom 
settings are also saved in this 
folder. 
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Windows 7 Utility Windows 8.1 Utility Description 

Explore 
Program Files  
(Explore 
MAGic folder) 

Not available 
Opens the folder where you 
installed MAGic, allowing you to 
access the program files 

Explore Shared 
Settings  
(Explore 
MAGic folder) 

Explore Shared 
Settings 

Opens the folder containing your 
shared MAGic settings. Factory 
schemes and default factory 
settings are saved in this folder. 

 MAGic Context Menu 
The MAGic Context Menu provides you with 
quick access from any program to the most 
commonly used visual and speech options. 
There are also commands that allow you to 
save your MAGic settings.  

To open the MAGic Context Menu, press 
MAGic Key+MOUSE RIGHT BUTTON, or 
press MAGic Key+APPLICATION Key.  

To create a new application settings file for 
the current program, choose Create 
Application Settings (where Application is 
the name of the program).  

To access the MAGic user interface, 
choose MAGic Main Window.   
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Chapter 18 
Using MAGic with Applications 
and Advanced MAGic Features 

Popular Applications with MAGic 

MAGic is compatible with many popular software applications. It allows you to 
create and save specific visual enhancement and speech settings that are 
automatically applied when you run an application. In addition, there are 
application-specific hot keys to help you use features within these programs. To 
learn more, refer to “Popular Applications with MAGic” in the MAGic help file. 

Freedom Scientific Applications with MAGic 

MAGic can be used with Freedom Scientific’s JAWS, OpenBook, or WYNN 
software. For more information, refer to “Freedom Scientific Applications with 
MAGic” in the MAGic help file. 

Scripting MAGic 

MAGic’s Script Manager allows you to create scripts and customize MAGic for 
use with proprietary applications. This feature requires the scripting option. To 
learn more, refer to “Scripting MAGic” in the MAGic help file.  

Network MAGic 

MAGic can be installed, authorized, and setup to run on a Network. For 
detailed information, refer to “Network MAGic” in the MAGic help file. 

Remote Access 

MAGic works with remote access software, like Citrix Program Neighborhood 
and Remote Desktop Connection, to establish a connection from your 
computer (called the “client”) to another computer (called the “server”). Once 
connected, you can run programs and view files just as if you were sitting at the 
server’s keyboard. For information about remote access, refer to “Remote 
Access” in the MAGic help file.  
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Contacting Freedom Scientific 

Corporate Headquarters 

Freedom Scientific, Inc. 
11800 31st Court North 
St. Petersburg, FL 33716-1805 
USA 
www.FreedomScientific.com 

Telephone: (727) 803-8000 

Fax: (727) 803-8001 

Office hours: Monday through Friday 8:30 AM to 5:00 PM Eastern Standard 
Time (USA) 

Technical Support Hours: Monday through Friday 8:30 AM to 7:00 PM 
Eastern Standard Time (USA) 

Sales 

Sales Telephone: (800) 444-4443 

International Sales Telephone (including Canada): (727) 803-8000 

Sales Fax: (727) 803-8001 

Sales e-mail: info@FreedomScientific.com 

To ensure that your request is handled promptly, include your complete 
address and telephone number. 
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Technical Support 

You must be a registered user to access Freedom Scientific support services. 
Freedom Scientific support services are subject to Freedom Scientific terms 
and conditions in place at the time the service is used.  

You can reach Technical Support using the following options: 

Automated Online Help: http://www.FreedomScientific.com/Support.asp  

World Wide Web: http://www.FreedomScientific.com  

Technical Support e-mail: Support@FreedomScientific.com 

Technical Support Telephone: (727) 803-8600  

When you call, be at your computer, have your documentation in hand, and be 
prepared to provide the following information: 

 Product serial number used for registration.  

 Product name and version number.  

 Type of computer hardware you are using.  

 Software version number of Windows.  

 Exact wording of any messages that appear on your screen.  

 What you were doing when the problem occurred.  

 How you tried to solve the problem.  

Technical Support Hours: Monday through Friday 8:30 AM to 7:00 PM 
Eastern Standard Time (USA) 

Error Reporting 

The MAGic error reporting feature allows you to send information over the 
Internet to Freedom Scientific about any MAGic errors. If MAGic unexpectedly 
closes, a memory dump file, containing diagnostic information, is created in the 
MAGic user settings folder. If you also experience any issues where MAGic 
appears to still be running, but you have lost speech, you can press 
INSERT+WINDOWS Key+F4 to manually close MAGic, terminate all related 
processes, and create a memory dump file. 
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After the memory dump file has been created, MAGic automatically restarts 
and displays the Error Reporting dialog box indicating that an error was 
detected and asking if you want to send this information to Freedom Scientific. 

Choose one of the following and then the Send button to transmit the error 
report directly to Freedom Scientific. 

 Ask me if I want to send error reports to Freedom Scientific each 
time: The Error Reporting dialog box displays each time an error is 
detected. This is the default setting.  

 Send all error reports to Freedom Scientific without asking: Future 
error reports are automatically sent to Freedom Scientific without 
displaying a dialog box.  

 Never send error reports to Freedom Scientific: Any future error 
reports are not sent to Freedom Scientific and you are not prompted to 
send an error report.  

MAGic will display a message to indicate that the report was sent successfully. 
If there was a problem sending the report, for instance, you do not have an 
active Internet connection, you are asked if you want to try sending it again. 
Choose Yes or No. Choose Don't Send if you do not wish to send the error 
report to Freedom Scientific. Choosing to send any error reports helps 
Freedom Scientific to continue to improve MAGic. 

The information transmitted to Freedom Scientific is limited to the memory 
dump file as well as generic information allowing Freedom Scientific to 
investigate the source of the issue, such as your product version number, the 
date and time the error occurred, number of times your system has 
experienced an error, and the error code related to the problem. The only 
information related to your specific environment that is transmitted is your 
computer’s MAC address to find trends on a particular system. However, there 
is no way for us to map MAC addresses to any particular individual, and no 
personal identification information is transmitted. 

HD Smoothing Options 

Updates to Windows (8.1 or later) or other applications can cause your 
computer to become unstable. When MAGic detects that Windows has not shut 
down properly (for example, two consecutive reboots within a 10-minute 
period), it automatically disables HD Smoothing and provides the following 
options for you to continue using MAGic.  
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 Restart MAGic using your previously defined HD Smoothing 
settings following the next Windows restart  
(See "Changing HD Smoothing Options" below for more information.) 

 Leave MAGic’s HD Smoothing disabled. You can re-enable MAGic 
HD Smoothing in the future via the HD Smoothing Setting in the 
Startup MAGic Options  

 Continue with HD Smoothing disabled and be reminded again 
during your next system reboot  

Changing HD Smoothing Options 

After determining and correcting the cause of your system's instability, you can 
reset your HD Smoothing preferences as described below. (This only applies to 
Windows 8.1 or later.) 

1. From the Main menu, choose File and then Preferences.  

2. Choose Automatically Start MAGic. The Start MAGic Options dialog 
box opens.  

3. Select an option from the HD Smoothing Options box.  

 HD Smoothing installed, active. HD Smoothing is on. This option 
also ensures compatibility with other installed screen magnifiers. 
(Default option)  

 HD Smoothing installed, inactive. HD Smoothing is on.  

 HD Smoothing not installed. HD Smoothing is off.  

4. Choose OK to save your change, and then exit the Preference dialog 
box.  
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